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Abstract 
This document describes how to configure CIC's real-time performance monitoring system. 
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Interaction Supervisor 

Interaction Supervisor 

Introduction 

Interaction Supervisor is CIC's real-time performance monitoring system. Interaction Supervisor displays 
metrics and sends notifications when user-defined thresholds are reached. It satisfies the demanding 
requirements of executives, supervisors, managers, and IT professionals who need immediate 
operational information and automatic notification when special events occur. Interaction Supervisor 
reveals what's going on in a contact center or business, by monitoring an assortment of entities, 
including: 

• People. Given sufficient access privileges, a supervisor can select a user and see his or her 
interactions and current status. 

• Interactions. A supervisor can highlight a phone call and listen in, initiate a recording, whisper 
into the agent's ear, join the call, take the call, and perform other telephony operations. Similar 
operations are provided for non-telephonic interactions such as queued emails, and text chats. 

• Queues. Interaction Supervisor indicates the performance of workgroups and activity in their 
associated queues, by displaying average wait times, talk times, calls currently in queue, and 
many other metrics. 

• Processes. Managers can inspect workflow objects as they traverse through business process 
flows. Interaction Supervisor can display where a process object is along its execution path, how 
long it has been in transit, where it's currently held up, who is supposed to be working on it, and 
other details. 

• CIC. Interaction Supervisor helps IT personnel monitor the health and performance of CIC 
servers, notifying them when problems occur.  For example, an e-mail notification can be sent to 
system administrators if disk space falls below a customizable threshold. 

• Add-on Product Domains. Interaction Supervisor is not limited to reporting events and activity 
on CIC systems. Views can apply to other product domains, such as Interaction Dialer, 
Interaction Director and Interaction Optimizer, for example. Supervisor's extensible architecture 
allows new functionality to be added when add-on products are installed. Supplemental views 
plug-in to Supervisor, subject to license restrictions and assignment of user rights. 

What's New 

See Change Log for information about enhancements, documentation updates, and new features in 
Interaction Supervisor released in CIC GA and subsequent service updates. 

• A note about client applications: Customer Interaction Center (CIC) supports two interaction 
management client applications. This documentation uses the term "CIC client" to refer to either 
Interaction Connect or Interaction Desktop. 

Views 

Information in Interaction Supervisor is presented by views.  Generally speaking, views in Interaction 
Supervisor display statistics, graphs, queues, and in some cases, reports.  When you add a view, it is 
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configured to display precisely the data you want to see. A comprehensive assortment of views is 
available. Interaction Supervisor organizes views of a similar nature by product or category, to make the 
selection of views easier. 

For example, views in the Agents and Workgroups category pertain to agent, team, and workgroup 
activity. Views in the System Status category indicate the health of CIC subsystems. This documentation 
discusses views by category, to mimic the way Supervisor is used in practice. 

Views are always added to a workspace. Workspaces organize views, including views from different 
application modules. Views within a workspace may be docked relative to other views any way you like. 

Once you learn Supervisor's basic features and controls, you can use similar techniques with all views. 
And since Supervisor is a component of IC Business Manager, it works like other application 
modules.  Views are added by selecting New > View from the File menu. See Manage Views. 

Access to Views is controlled by License Assignment 

The views available in IC Business Manager are controlled by CIC server license. When a user logs in to IC 
Business Manager, it enables all views for which that user has access rights.  Access is governed by the 
license file on the CIC server and by the assignment of security and access rights in Interaction 
Administrator.  The total number of licenses available is enforced by CIC.  Contact your CIC System 
Administrator if a needed view is unavailable after you logon. See Licenses, Security and Access Control 
Rights and access-related information in topics that describe each view category. 

Alerts 

Alerts enhance Interaction Supervisor's ability to display real-time information. Alerts notify the user 
when a statistic enters a user-defined threshold, is within bounds, or is no longer within a range of 
values.  Alerts are displayed in Supervisor using color coded icons and conspicuous text attributes. Alerts 
can optionally send email notifications, play sounds, or invoke a handler.  You can base alerts for calls 
longer than a specific duration, average hold time greater than a given value, and many other metrics. 
 See Manage Alerts. 

Accessing documentation from the Help Menu 

The Help menu in IC Business Manager links to user assistance for other application modules. If the 
information you are looking for is not in this file, use the Help menu to locate other IC Business Manager 
documentation. 
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The workspace is the large area where views appear in the main window. A workspace hosts views, 
including views from different application modules. This helps you organize views for tasks that you 
frequently perform. Views within a workspace can be docked in a variety of ways. 

IC Business Manager provides a default workspace. You can also create custom workspaces to organize a 
selection of different views. 

To add a custom workspace: 

1. Click Workspace… on a Getting Started page, or select New > Workspace. The Create New 
Workspace dialog appears, prompting for a workspace name and other information. 

2. Enter a descriptive name for the workspace, and optionally a description and your preference of 
icon. 
 

 
3. Click OK. The new workspace appears. If "Show Getting Started" on new workspaces was checked, 

the new workspace appears with Getting Started instructions as shown below. Otherwise the new 
workspace is empty. Note also this page lists Built-in Workspaces, which are application modules 
that appear by default in the Workspaces bar. 
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4. Next, add a view to the workspace. See Add any view to a workspace for instructions. 

5. To switch between workspaces, select a workspace from the Workspaces menu, or click a 
workspace icon in the vertically-oriented Workspaces tab. 
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For more information about Workspaces and adding views, select Getting Started from the Help menu 
to open the IC Business Manager User Interface Help. 

Manage Views 

Manage Views 

About Views 

Displays of information in IC Business Manager are called views.  Supervisor views display statistics, 
graphs, queues, the status of alerts, and in some cases, reports using a common set of visual 
controls.  Views track the connection state of the application, and maintain alert watches when 
connections are available. Views update information in real-time, along with the status of any alerts that 
have been set. 

Views are added to a workspace. Workspaces organize views, including views from different application 
modules. Views in a workspace may be docked relative to other views any way you like. Views must be 
configured to select a subset of available data. For example, to view details about an agent, you must 
specify which agent.  These selection criterions are called view parameters. 

Licensing and station rights determine the views available. Contact your CIC System Administrator if a 
needed product or category is unavailable after you log on. Once rights are assigned, views will become 
visible the next time you log on to IC Business Manager. 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product.  Categories may differ from those shown below, since the availability of 
views is subject to licenses, security rights, and access control rights. See Licenses, Security and 
Access Control Rights. 
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Since a comprehensive assortment of views is available, IC Business Manager organizes views by 
category or product, to make the selection of views easier. Select Categories from the Group By 
drop list. 

4. Click in the list on the left to select a view category. A list of views for that category will appear 
in the list on the right. Subject to access restrictions, the view categories are: 

View Category Description 

Agents and Workgroups Views that report the activity of Agents, Workgroups and Workgroup 
Directories. 

You can view or graph the activity of a single agent for a single 
workgroup, or for all workgroups that the agent has membership in. 
You can monitor activity in agent or workgroup interaction queues, 
filtering by interaction type, or monitor statistics for many agents in 
multiple workgroups. 

You can examine details and statistics about a particular workgroup, 
display member agents of a workgroup in a directory, graph workgroup 
statistics, and compare activity across multiple workgroups.  

Dialer Statistics Interaction Dialer views display statistics about Dialer agents, 
outbound campaigns, skills, stages, wrap-up codes and categories, the 
overall status of multiple running campaigns, and the health of Dialer 
servers. 

Interaction Feedback Status Views that display statistics about Interaction Feedback surveys in 
progress. 

Interaction Optimizer Views that compare actual agent activity and presence to schedules. 

Interaction Recorder Provides the ability to display statistics that help determine the state of 
configured Remote Content Servers and Recorder Server. 

System Status Views that monitor the health and performance of CIC server to 
display license statistics, activity in line, station, workgroup, and user 
queues, session managers and session activity, CIC system 
performance, memory usage, and subsystem activity. 

Tracker Provides ability to search for an interaction and examine its details. 
The search features in this view query for interactions that are no 
longer in queue by searching for any combination of: Interaction ID, 
Media Type, Date/Time, Direction, Last User, Last Workgroup, DNIS, 
Remote Number, or Remote Address. 

A particular interaction can then be displayed with details indicating 
everything known about the interaction. Details about an interaction 



Printed Documentation 

7 

include: the segments within the interaction, and an overview of 
workgroups, local parties, and conference parties involved. 

Interaction Director These views display service level, abandon and queue statistics about 
an enterprise group, or routes on a monitored server which are used 
to place inter-server calls between CIC servers. 

5. Select which view to add by clicking an item in the Views list. 

6. Click OK. 
 
If the view requires parameters to be set, dialogs appear at this time to prompt for view 
preferences. Most views prompt for parameter information. For example, an Agent Details view 
prompts to select an agent, and then opens a second dialog to ask whether to select activity for 
that agent in a single workgroup or all workgroups. Only with these parameters can the view 
show statistics for the selected agent and workgroup. 

Optionally press F1 for help with parameter selection dialogs. 

1.   

7. When you finish selecting parameters, the view will appear in the workspace. 
 
Views are automatically disabled if the connection with CIC server goes down for any reason. A 
'spinner' cursor is shown in all Supervisor views, indicating that no data is being received. Views 
are automatically enabled once the connection is restored. 

  

Agents and Workgroups category 

Agents and Workgroups category 

Summary 

Views in the Agents and Workgroups category manage agents, teams, and workgroups. If this category 
does not appear when you add a view, contact your CIC System Administrator. See Licenses, Security 
and Access Control Rights. 

Icon View Details Appearance 
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Agent Details 

Summarizes the activity of a 
single agent, for a single 
workgroup, or for all workgroups 
that the agent has membership 
in. 

This view displays Agent 
Statistics for the current period, 
previous period, current shift 
and previous shift.  

 

Agent Graph 

Shows statistics of several agents 
in one or more workgroups 
presented in a graph. 

This view displays Agent 
Statistics for the current period, 
previous period, current shift 
and previous shift. 

 

 

Agent or Workgroup Queue 

Shows current activity in an 
agent's or a workgroup's 
interaction queue. 

The view can be filtered by 
interaction type, to show calls, 
callbacks, chats, emails, generic 
queue objects, and workflow 
items, or all interaction types.  

   

 

Agent Overview 

Statistics of several agents in one 
or more workgroups. 

Statistics for each agent can be 
expanded to show activity in 
workgroup queues. 
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Workgroup Details 

Shows details about a selected 
workgroup. This view includes 
the directory, the statistics and 
the queue (if applicable). 

  

 

 

Workgroup Directory 

Shows member agents of a 
workgroup in a directory. 

 

 

Workgroup Graph 

Rolled-up statistics on selected 
workgroups presented in a 
graph. 

 

 

Workgroup Overview 

Compares activity of multiple 
workgroups.  This view rolls up 
statistics for selected 
workgroups, displaying 
workgroups selected by the user 
as rows, and selected workgroup 
statistics as columns. 
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Workgroup Statistics 

Statistics for a selected 
workgroup. This view does not 
show the workgroup queue or 
the directory. 

  

 

  

Agent Details view 

Summary 

The Agent Details view summarizes the activity of a single agent, for a single workgroup, or for all 
workgroups that the agent has membership in. This view displays Agent Statistics for the current period, 
previous period, current shift and previous shift, in a single expander control. 

 
Statistics pertain to time in a workgroup or a user interaction, and not overall time in the system. The 
time an interaction was in IVR for example, is not counted. Once the view is created, you can select a 
different agent, or other workgroups that the selected agent is participating in. 

Add this view 

1. If necessary, start IC Business Manager and log on. 
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2. In IC Business Manager, select a workspace from the Workspaces menu, or create a new 
workspace to host the view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. In the Categories list, select Agents and Workgroups. 

6. Select Agent Details in the list of views on the right. 

7. Click OK. The Select Agent page of the Agent Details Wizard appears. 

8. Select the name of an agent. You may need to type a name in the Filter box. When more than 
20 agents exist in the system, only the first 20 are shown, and an indicator ( ) informs that 
more agent names are available. 
 

 
 
In that case, typing an agent's name in the Filter box locates the agent. When fewer than 20 
agents exist in the system, the filter box is not displayed. Only agents that are members of at 
least one workgroup appear in this list.  
 
Once you select an agent, his or her name appears in the Agent box under Selected Parameters. 
This helps verify the current selection. Note that Workgroup appears in that section as read-only 
text. Workgroups are selected on the next wizard page. 

9. Click Next to Proceed. The Select Workgroup page of the Agent Details Wizard appears. 

10. The Select Workgroup page prompts whether to select statistics for a single workgroup, or for 
the agent's activity in all workgroups. Click to select a workgroup by name, or select [All] for all 
workgroups the agent is a member of. Optionally use the Filter box to locate specific 
workgroups by typing all or part of a workgroup name. 
 
Once you make a selection, the workgroup name (or [All]) appears in the Workgroup box under 
Selected Parameters. This helps verify your selection. 

11. Click Finish. The view appears, showing statistics for the selected agent and workgroup. 

Change statistics in this view 

1. Right-click anywhere in the view to open a shortcut menu. 
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2. Select Add/Remove Statistics… from the menu. The Interval and Queue Statistic Selection 
dialog appears. This dialog selects which time intervals and statistics will appear in the view. 

3. Options in the Interval frame manage time periods reported in the view. The list on the left 
contains items that are not currently included in the view. The list on the right contains items to 
include in the view. 

• Select periods in the list on the left. Then click Add to move them to the other list. Add All 
selects all items for inclusion. 

• Use Move Up and Move Down buttons to optionally change the display order of columns in the 
view. 

• To exclude periods from the view, select items in the list on the right. Then click Remove. The 
Remove All button excludes all time periods from the view, but at least one must be included. 

4. Options in the Queue Statistics frame manage statistics reported in the view. The list on the left 
contains items that are not currently included in the view. The list on the right contains items to 
include in the view. 

• Select statistics in the list on the left. Then click Add to move them to the other list. Add All 
selects all items for inclusion. 

• Use Move Up and Move Down buttons to optionally change the display order of rows in the 
view. 

• To exclude statistics from the view, select items in the list on the right. Then click Remove. The 
Remove All button excludes all statistics from the view, but at least one must be included. 

5. Click OK when you are finished. 

Shortcut Menu Commands 

Right-click any statistic in the view to display shortcut menu commands. The menu options are: 

Edit Alerts… 

Opens dialog for adding or changing the parameters of alerts. This menu option is enabled when the 
shortcut menu is opened by right-clicking on a statistic. 

Add/Remove statistics… 

Opens the Interval and Queue Statistic Selection dialog is presented, so that the user can pick and 
choose statistics to display in the view. 

Remove > column 

Removes a column from the view. 

Remove > entire row 

Removes a row from the view. 

Display Help for a statistic 
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1. Right-click the statistic to display the shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Set Alerts 

See Manage Alerts. 

Summary 
The Agent Graph view shows statistics of several agents in one or more workgroups presented in a 
graph. This view charts Agent Statistics for your choice of intervals (current period, previous period, 
current shift and previous shift). 

 
Statistics pertain to time in a workgroup interaction, and not overall time in the system. The time an 
interaction was in IVR for example, is not counted. Once the view is created, you can select a different 
workgroup that the selected agents participate in. 

Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list. 

5. Click the Agents and Workgroups view category. 

6. Select Agent Graph from the list of views. Click OK.   
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7. Select a workgroup. Click Next. The Agent Selection dialog appears. (In this context, the dialog 
title is Agent Graph.) 

8. Choose agents to graph by selecting names in the Available Items list on the left. Then press 
Add. 
 
Add All selects all agents for inclusion. You can change the display order of agents in the view 
using Move Up and Move Down buttons. To exclude agents from the view, select items in the 
list on the right. Then click Remove. The Remove All button excludes all agents from the view, 
but at least one has to be included. 

9. Click Next. The Interval and Queue Statistic Selection dialog prompts for time intervals to select, 
and which statistics to chart. 

10. In the Interval list, select time intervals to select data for. Then click Add. 
 
Options in the Interval frame manage time periods to select data for. The list on the left 
contains items that are not currently included in the view. The list on the right contains items 
selected to include in the view. Select items in the list on the left. Then click Add to move them 
to the other list, to include them in the view. Add All selects all items for inclusion. You can 
change the display order of columns in the view using Move Up and Move Down buttons. To 
exclude periods from the view, select items in the list on the right. Then click Remove. The 
Remove All button excludes all time periods from the view, but at least one has to be included. 

11. Select statistics that you want to chart. Then click Add. 
 
Options in the Queue Statistics frame manage statistics to report in the view. The list on the left 
contains items that are not currently included in the view. The list on the right contains items 
selected to include in the view. Select items in the list on the left. Then click Add to move them 
to the other list, to include them in the view. Add All selects all items for inclusion. You can 
change the display order of rows in the view using Move Up and Move Down buttons. To 
exclude statistics from the view, select items in the list on the right. Then click Remove. The 
Remove All button excludes all statistics from the view, but at least one has to be included. 

12. Click Finish. The Agent Graph view appears. 

Change statistics in this view 

1. Right-click in the view to open its shortcut menu. 

2. Select Add/Remove Statistics… 

3. Use the Interval and Queue Statistic Selection dialog to modify which Agent Statistics are 
graphed. It prompts for time intervals to select, and which statistics to chart. 

Add or remove Agents from this view 

1. Right-click in the view to open its shortcut menu. 

2. Select Add/Remove Agents… 

3. Use the Agent Selection dialog to add or remove agents from the view. 
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Customize the Graph 

See Chart Control. 

Set Alerts 

See Manage Alerts. 

Display Help for a statistic 

1. Right-click a statistic in the Legend below the graph to display a shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Agent or Workgroup Queue view 

Summary 

The Agent or Workgroup Queue view displays current activity in a workgroup or user queue. The view 
can be filtered by interaction type, to show calls, callbacks, chats, emails, generic queue objects, and IPA 
work items, or all interaction types.  

Add this view 

1. If necessary, start IC Business Manager and log on. 

2. In IC Business Manager, select a workspace from the Workspaces menu, or create a new 
workspace to host the view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. In the Categories list, select Agents and Workgroups. 

6. Select Agent or Workgroup Queue in the list of views on the right. Click OK. This view does not 
require parameters to be set. 

Customize this view to display Workgroup or User Queue data 

Select from the drop lists in left to right order: 

1. Use the Queue Type drop list to select Workgroup Queue or User Queue. 

2. Select a specific queue in the middle drop list. It contains user or workgroup queue names based 
on the Queue Type selection made. 

To narrow down the number of items displayed, type part of a queue name in queue drop lists. 
This filters the list of queue names to match that string, making it much easier to find the queue 
you are looking for. 

3. Select the type of queue interaction to display (calls, chats, etc.) from the Interaction Type list, 
or select All Types. 
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To add or remove columns from this view 

1. Right-click any column heading to display the shortcut menu. See Queue Columns for a 
description of each column that can appear in this view. 

2. Select a column to include. If you select a checked column name, it will be removed from the 
view.  

3. To select columns and also set their display order in the view, select More… from the shortcut 
menu. This opens the Queue Columns Selection dialog. 

Perform Call Actions on queue objects 

If you right click a row in the queue control, you can select call action commands from the shortcut 
menu: 

Pick Up Answers the current interaction, or takes the interaction off hold. 

Disconnect Disconnects the selected interactions. You can select multiple calls to disconnect at 
once. 

Join Adds the Supervisor user to a call on any user or station queue that the manager has 
permission to monitor. Both the agent and the customer can hear the manager's side of 
the conversation. When the Join feature is used, Interaction Supervisor creates a 
conference call between the agent, the connected party, and the Supervisor user. 

Listen Listens in on a call. For example, you can listen to a caller leaving a voice mail message, 
to a conversation between two parties, or to a conference call. The parties being 
listened to may not be aware that someone is listening to the call. 

Genesys disclaims any responsibility for end-user or licensee to comply with federal or 
state law restrictions regarding Record or Listen capabilities of CIC software. The 
licensee hereby warrants and represents that the end-user or licensee will use the 
product in compliance with any federal or state law. 

Transfer Transfers the interaction to another user. 

Coach Adds yourself to an agent's call on any user or station queue you have permission to 
monitor. This enables you to provide advice to the agent without the customer knowing 
that you are assisting on the call. The agent can hear your side of the conversation, but 
the customer cannot. 

This feature is especially helpful to supervisors who are training new agents, monitoring 
employee customer service performance, or simply providing assistance with a 
customer call. 

If the agent presses the Mute button while you are coaching the agent, the customer no 
longer hears the agent but the agent can continue to converse with you. The Mute 
button does not affect the audio between the agent and the coach. 
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You must have permission to use the Coach feature and you must have permission to 
monitor queues. If you have questions about your rights and permissions, see your 
Interaction Center administrator. 

The Coach option is disabled if the call is not in a state in which this action can be 
performed. 

Record Records the currently selected call. This recording is saved as a .wav file. Selecting 
Record the first time starts the recording session for a call. Selecting Record again stops 
the recording session for a call. 

If you select Record more than once to stop or continue recording a call, each part of 
the recorded conversation is stored in separate .wav files, and sent to you in e-mail 
message attachments after you end the call. 

The Record option is unavailable if the call is not in a state in which this action can be 
performed or if you do not have rights to record calls. Contact your CIC administrator if 
you need security rights to use this feature. 

Genesys disclaims any responsibility for end-user or licensee to comply with federal or 
state law restrictions regarding Record or Listen capabilities of CIC software. The 
licensee hereby warrants and represents that the end-user or licensee will use the 
product in compliance with any federal or state law. 

Pause Pauses recording. Select Pause again to resume recording. 

Snip Creates a recording snippet. To have snip capabilities, your administrator must 
configure your user account with the appropriate rights and licenses in Interaction 
Administrator. For more information, see the Interaction Recorder and Interaction 
Quality Manager Technical Reference in the PureConnect Documentation Library and 
the Interaction Administrator Help. 

Private Prevents other users from recording or listening to a conversation. Use of the Private 
feature may be subject to your company's policies and should only be used in 
accordance with those policies. CIC handler customization can be used to track the use 
of the Private feature to ensure compliance with such policies. 

Properties Opens the Directory Properties dialog to display information about the selected user.  

Copy value of Copies the value of the selected row at the intersection of the selected column, to the 
clipboard. 

Copy 
Interaction 

Copies interaction details to the clipboard. 

  

Agent Overview view 
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Summary 

The Agent Overview summarizes Agent Statistics of several agents in one or more workgroups. Statistics 
can be expanded to show activity in each workgroup the agent participates in. 

 

Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the Agents and Workgroups view category. 

6. Select Agent Overview from the list of views. Click OK. Select one workgroup, or select [All] to 
include all workgroups. 

7. Click Next. Use the Agent Selection dialog to select agents to include in the view. 

8. Click Next. Use the Interval and Queue Statistic Selection dialog to select time intervals and 
statistics to include in the view. 

9. Click Finish. 

Add or remove Agents from view 

1. Right-click in the view to display its shortcut menu. 

2. Choose Add/Remove agents… 

3. Use the Agent Selection dialog to select agents to include in the view. Click OK. 

Add or remove Statistics from view 

1. Right-click in the view to display its shortcut menu. 

2. Choose Add/Remove statistics… 

3. Use the Interval and Queue Statistic Selection dialog to select which time intervals and statistics 
appear in the view. Click OK. 
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Remove a single Agent 

1. Right-click the row corresponding to the agent.  

2. Choose Remove > Remove agent row from the shortcut menu. 

Remove a single Statistic 

1. Right-click the column corresponding to the statistic. 

2. Choose Remove > Remove statistic from the shortcut menu. 

Display Help for a statistic 

1. Right-click the statistic to display the shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Set Alerts 

See Manage Alerts. 

Workgroup Details view 

Workgroup Details view 

Summary 

A Workgroup Details view displays details about a selected workgroup. It displays the status of 
individual workgroup members, including the length of time in status and their logged in state. It shows 
workgroup statistics, members of the workgroup directory, and if applicable, interactions in the 
workgroup queue. 
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The ability to filter skills is not always visible in this view. Skill filtering is unavailable if: 

• You are connected to an older server that does not support skill filtering. 

• No Statistic Parameter Group has been assigned to the workgroup. 

• No Skill Categories have been assigned to the Statistic Parameter Group with which the 
workgroup is associated. 

• When any of these factors apply, the skills filter section is not visible to maintain backwards 
compatibility. 

Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the Agents and Workgroups view category. 

6. Select Workgroup Details from the list of views. Click OK. Select one workgroup, if necessary 
after typing in the text box to filter by name. 

7. Click Finish. 

Change the layout of this view 
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The Layout drop list (top right) changes the orientation of controls in the view. The layout options are 
Classic View, Interactions queue at the top, Interactions queue at the bottom, and 3 column view. 

 

Classic view 

The default "Classic View" positions expanders for 
statistical categories above a list of workgroup 
members. Note that there are two tabs: the Queue 
tab shows objects in the interactions queue, (if the 
workgroup has a queue) with call action controls so 
that the user can select a queue object, and then 
listen, coach the agent, record the conversation, join 
a conference, or perform basic telephony 
operations.  The Members tab lists members in a 
queue control. 

  

Interactions queue at the top 

When "Interactions queue at the top" is selected, the 
list of interactions appears above workgroup statistics 
and member lists. 

  

 

Interactions queue at the bottom 

When "Interactions queue at the bottom" is selected, 
the list of interactions appears below workgroup 
statistics and member lists. 

 

3 column view 

The 3 column view maximizes vertical space by 
arranging lists horizontally adjacent to one another. 
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Shortcut commands in this view 

The table below shows shortcut commands available when you right-click each list. 

List Shortcut Command Description 

Workgroup Statistics Edit alerts… See Manage Alerts. 

Remove > Remove entire 
statistic group 

Removes an entire category of statistics from the 
view at once. 

Remove > Remove statistic Removes a single statistic. 

Add/Remove Statistics See Change statistics in the view. 

Help Displays description of the statistic in the Statistic 
Help dialog. 

Workgroup Members Edit alerts… See Manage Alerts. 

Manage Workgroup 
activations 

Opens the Manage Workgroup Activations dialog, 
used to activate or deactivate workgroup agents. 

Manage User activations Opens the Manage User activations dialog, used to 
activate a single agent on multiple workgroups. 

Logout [user] If your CIC administrator has granted you the right, 
you can log off another user. For more 
information, see Force User Logouts. 

Formatting Options Opens the Workgroup Directory Options dialog, 
used to format rows for a list of members in a 
workgroup directory. 

Properties Opens properties of the selected user in the 
Directory Properties dialog. 

Change Status for If your CIC administrator has granted you the right, 
you can set another user's status. Opens the 
Change User Status dialog. 

Workgroup Interactions Pick Up Answers the current interaction, or takes the 
interaction off hold. 
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Disconnect Disconnects the selected interactions. You can 
select multiple calls to disconnect at once. 

Transfer Transfers the interaction to another user. 

Join Adds the Supervisor user to a call on any user or 
station queue that the manager has permission to 
monitor. Both the agent and the customer can 
hear the manager's side of the conversation. 
When the Join feature is used, Interaction 
Supervisor creates a conference call between the 
agent, the connected party, and the Supervisor 
user. 

Listen Listens in on a call. For example, you can listen to a 
caller leaving a voice mail message, to a 
conversation between two parties, or to a 
conference call. The parties being listened to may 
not be aware that someone is listening to the call. 

Genesys disclaims any responsibility for end-user 
or licensee to comply with federal or state law 
restrictions regarding Record or Listen capabilities 
of CIC software. The licensee hereby warrants and 
represents that the end-user or licensee will use 
the product in compliance with any federal or 
state law. 

Coach Adds yourself to an agent's call on any user or 
station queue you have permission to monitor. 
This enables you to provide advice to the agent 
without the customer knowing that you are 
assisting on the call. The agent can hear your side 
of the conversation, but the customer cannot. 

This feature is especially helpful to supervisors 
who are training new agents, monitoring 
employee customer service performance, or 
simply providing assistance with a customer call. 

If the agent presses the Mute button while you are 
coaching the agent, the customer no longer hears 
the agent but the agent can continue to converse 
with you. The Mute button does not affect the 
audio between the agent and the coach. 

You must have permission to use the Coach 
feature and you must have permission to monitor 
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queues. If you have questions about your rights 
and permissions, see your Interaction Center 
administrator. 

The Coach option is disabled if the call is not in a 
state in which this action can be performed. 

Record Records the currently selected call. This recording 
is saved as a .wav file. Selecting Record the first 
time starts the recording session for a call. 
Selecting Record again stops the recording session 
for a call. 

If you select Record more than once to stop or 
continue recording a call, each part of the 
recorded conversation is stored in separate .wav 
files, and sent to you in e-mail message 
attachments after you end the call. 

The Record option is unavailable if the call is not in 
a state in which this action can be performed or if 
you do not have rights to record calls. Contact 
your CIC administrator if you need security rights 
to use this feature. 

Genesys disclaims any responsibility for end-user 
or licensee to comply with federal or state law 
restrictions regarding Record or Listen capabilities 
of CIC software. The licensee hereby warrants and 
represents that the end-user or licensee will use 
the product in compliance with any federal or 
state law. 

Pause Pauses recording. Select Pause again to resume 
recording. 

Private Prevents other users from recording or listening to 
a conversation. Use of the Private feature may be 
subject to your company's policies and should only 
be used in accordance with those policies. CIC 
handler customization can be used to track the use 
of the Private feature to ensure compliance with 
such policies. 

Properties Opens properties of the selected user in the 
Directory Properties dialog. 

Copy value of Copies the value of the selected row at the 
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intersection of the selected column, to the 
clipboard. 

Copy Interaction Copies details to the clipboard. Example: 

Name: "From:Cblade2" 

Duration: "00:01:57" 

State: "ACD - Assigned: user2673" 

Queue: "WG14" 

Line: "DataVlan" 

User: "Thompson, Kenith" 

Station: "Station32673" 

Agent Keywords Displays list of keywords in the Agent Score queue 
column. See Interaction Analyzer Columns in 
Queue Controls. 

Customer Keywords Displays list of keywords in the Customer Score 
queue column. See Interaction Analyzer Columns 
in Queue Controls. 

Change statistics in this view 

1. Right-click in the view to display the shortcut menu. 

2. Choose Add/Remove statistics… 

3. Use the Workgroup Statistics dialog to select which time intervals and statistics appear in the 
view. Click OK. 

Select cumulative vs. Partial Sum histogram for Service Level or Abandon Rate 
statistics 

 
Click Options on the right side of the expander to select histogram type. 

Think of cumulative distribution as an accumulative bucket for the workgroup, interaction type, and 
time interval including current period, current shift, and so on. An accumulative bucket means that each 
bucket includes the count for all of the preceding buckets. In a partial sum distribution, each bucket 
count is exclusive of any other bucket. 
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• Cumulative alters the reporting interval to summarize interactions in the first n seconds. For 
example: 
 
0-10 seconds  - Interactions abandoned/serviced in the first 10 seconds. 
0-20 seconds  - Interactions abandoned/serviced in the first 20 seconds. 
0-30 seconds  - Interactions abandoned/serviced in the first 30 seconds. 
0-40 seconds  - Interactions abandoned/serviced in the first 40 seconds. 
Etc. 

• Partial Sum summarizes interactions abandoned or serviced in particular intervals. For example: 
 
0-10 seconds   - Interactions abandoned/serviced in the first 10 seconds. 
10-20 seconds - Interactions abandoned/serviced between 10 and 20 seconds. 
20-30 seconds - Interactions abandoned/serviced between 20 and 30 seconds. 
30-40 seconds - Interactions abandoned/serviced between 30 and 40 seconds. 
Etc. 

Display Help for a statistic 

1. Right-click the statistic to display the shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Set Alerts 

See Manage Alerts. 

Manage Workgroup Activations 
The Manage Workgroup Activations dialog activates or deactivates workgroup agents. 

To activate or deactivate agents in a workgroup: 

Right click any user name in the Members list of a Workgroup Details view. Then select Manage 
Workgroup Activations from the shortcut menu that appears. This opens the Manage Workgroup 
Activations dialog: 
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Manage Workgroup Activations dialog. 

2. Select a workgroup from the drop list at the top of the dialog. This populates lists of active and 
inactive agents. 

3. To activate agents, select names in the Available agents list. You can Ctrl-click to select multiple 
entries. Then click Add.  To deactivate an agent, select a name in the Selected Agents list. Then click 
Remove. 

4. Click Apply to apply changes, leaving the dialog open. Or click OK to apply changes and dismiss the 
dialog. If you click Close, the dialog is closed without applying changes. 

Manage User Activations 
Use the Manage User Activations dialog to activate a single agent on multiple workgroups. 

 The "Master Administrator" role was previously required in order for a Supervisor user to manage 
user activations.  Starting with CCIC SU3, users who have the "Activate Others" and "Activate Self" 
permissions can manage user activations. In Interaction Administrator, these permissions are 
located at Access Control > Workgroup Queue > Advanced Access Details. 

To change a user's workgroup activation: 

1. Right click any user name in the Members list of a Workgroup Details view. Then select Manage 
User Activations from the shortcut menu that appears. This opens the Manage User Activations 
dialog: 
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Manage User Activations dialog. 

2. Optionally filter the list of workgroups by typing all or part of a workgroup name in the Available 
Workgroups box. This displays a list of matching workgroups. 
 
To activate the user's participation in a workgroup, select workgroup(s) in the Available workgroups 
list. You can Ctrl-click to select multiple entries. Then Click Add. You can optionally click Add All to 
activate the user on all available workgroups. 
 
To deactivate a user's workgroup participation, select workgroups(s) in the Selected workgroups 
list. Then click Remove or Remove All (to cancel participation in all workgroups). 

3. Click Apply to apply changes, leaving the dialog open. Or click OK to apply changes and dismiss the 
dialog. If you click Close, the dialog is closed without applying changes. 

Force User Logouts 
Note: This feature is available in PureConnect 2017 R3 and later versions. 

From the Workgroup Details view or the Workgroup Directory view, you can log off another user from 
all CIC applications except for Interaction Administrator, Interaction Recorder Screen Capture Client, and 
Interaction Recorder Policy Editor. For example, if a user left for the day and forgot to log off, a 
supervisor can log off the user and release the licenses the user was consuming.  

The logoff occurs even if the user is on an interaction. If the user is on a call in Interaction Connect, the 
user is logged off Interaction Connect but the call remains connected so that the user can complete the 
call. 

The CIC application displays the following message to notify the user: 
Your session has been logged out by the supervisor (Name). 
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Using User Configuration in Interaction Administrator, your CIC administrator can set the Force User 
Logout security right to grant you the ability to log off another user. 

Log off another user 

1. Right-click a user name in the Members list in the Workgroup Directory view or the Workgroup 
Details view. 

2. Select Logout [user] from the shortcut menu. 

  

Related Topics 

Workgroup Details view 

Workgroup Directory view 

  

Workgroup Directory view 

Summary 

A Workgroup Directory view displays the status of individual workgroup members, including the length 
of time in status and their logged in state. You can filter for specific values by typing in text boxes above 
each column. 

 

Add this view 

1. If necessary, start IC Business Manager and log on. 

2. In IC Business Manager, select a workspace from the Workspaces menu, or create a new 
workspace to host the view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. In the Categories list, select Agents and Workgroups. 
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6. Select Workgroup Directory in the list of views on the right.  Click OK. 

7. Select a workgroup. You may need to type a name in the Filter box. When more than 20 
workgroups exist in the system, only the first 20 are shown, and an indicator ( ) informs that 
more are available. If you select more than 20 workgroups, an indicator  ( ) informs that you 
need to remove some to continue. Click Finish. 

Columns in this view 

You can modify the selection of columns displayed in the view, by right-clicking a column heading to 
open its shortcut menu.  

Standard columns The standard columns are Name, First Name, Last Name, Company, Department, 
Extension, Skills, Business Phone, Home Phone, and Mobile. 

Status columns Status-related columns in the Status Columns submenu are: Status, Status Notes, 
Until, Forward Number, On Phone, Logged In, Time in Status, Status Summary or 
Activated. 

Other columns The Other Columns submenu adds columns for properties of a member entry, 
such as Business Address, Business City, Assistant, Skills, and so on.  See also: 
Directory Properties dialog. 

Edit alerts… 

See Manage Alerts. 

Manage Workgroup activations 

Opens the Manage Workgroup Activations dialog, used to activate or deactivate workgroup agents. 

Manage Workgroup memberships 

Opens the Manage Workgroup Membership dialog, used to add or remove workgroup agents. 

Manage User activations 

Opens the Manage User activations dialog, used to activate a single agent on multiple workgroups. 

Directory Formatting Options 

Opens the Workgroup Directory Options dialog, used to format rows for a list of members in a 
workgroup directory. 

Logout [user] 

If your CC administrator has granted you the right, you can log off another user. For more information, 
see Force User Logouts. 

Properties 
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Opens properties of the selected user in the Directory Properties dialog. 

Change Status for [user] 

If your CIC administrator has granted you the right, you can set another user's status. Selecting this 
command opens the Change User Status dialog. 

Display skill set 

Displays the entire list of skills for the user, with proficiency and the desire to use metrics. If a user has 
the same skill in two different workgroups with different proficiency and desire to use, they will both 
appear in the user skills dialog box. 

Note: To ensure that you see the most recent skill data for an agent, do either of the following 
things before you attempt to view the skill set for an agent: 
 
*In a paged directory, change to a different page or enter a filter.   
 
*In an unpaged directory, recreate the view or select a different workgroup from the Workgroup 
list. 
 
Then return to the page, workgroup, or filter settings that you originally wanted. When you select 
the agent the next time, the most recently updated skill information will appear. 

Set Alerts 

See Manage Alerts. 

Related Topics 

Workgroup Directory control 

Workgroup Graph view 

Summary 

A Workgroup Graph view displays rolled-up statistics on selected workgroups presented in a graph. 
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Add this view 

1. If necessary, start IC Business Manager and log on. 

2. In IC Business Manager, select a workspace from the Workspaces menu, or create a new 
workspace to host the view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. In the Categories list, select Agents and Workgroups. 

6. Select Workgroup Directory in the list of views on the right.  Click OK. 

7. Use the Workgroups Selection dialog to select one or more workgroups. You may need to type a 
name in the Filter box. When more than 20 workgroups exist in the system, only the first 20 are 
shown, and an indicator ( ) informs that more are available.  If you select more than 20 
workgroups, an indicator ( ) informs that you need to remove some to continue. Click Next. 

8. Use the Workgroup Statistics Selection dialog to select workgroup statistics to include in the 
view. Workgroup statistics summarize ACD interactions, such as the number of agents logged in, 
and other particulars that are common to the workgroup as a whole. 

9. Select queue statistics and intervals using the Interval and Queue Statistic Selection dialog. Click 
Finish. 

Customize the Graph 

See Chart Control. 
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Change statistics in this view 

1. Right-click in the view to open its shortcut menu. 

2. Select Add/Remove Statistics… 

3. Use the Workgroup Statistics and Queue Statistics Selection dialog to modify statistic selections. 
Click OK. 

Add or remove Workgroups from this view 

1. Right-click in the view to open its shortcut menu. 

2. Select Add/Remove workgroups… 

3. Use the Workgroups Selection dialog to add or remove groups from the view. 

Set Alerts 

See Manage Alerts. 

Display Help for a statistic 

1. Right-click a statistic in the Legend below the graph to display a shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Workgroup Overview view 

Summary 

A Workgroup Overview compares activity of multiple workgroups.  This view rolls up statistics for 
selected workgroups, displaying workgroups selected by the user as rows, and selected workgroup 
statistics as columns. Clicking on a column header sorts by that column.  Columns can be re-ordered, 
except for the first column. The column order that you select will remain the same, even if you add or remove workgroups to this 
view. 
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Add this view 

1. If necessary, start IC Business Manager and log on. 

2. In IC Business Manager, select a workspace from the Workspaces menu, or create a new 
workspace to host the view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. In the Categories list, select Agents and Workgroups. 

6. Select Workgroup Overview in the list of views on the right. Click OK. 

7. Use the Workgroups Selection dialog to select workgroups to report in the view. You may need 
to type a workgroup name in the Filter box. When more than 20 workgroups exist in the system, 
only the first 20 are shown, and an indicator ( ) informs that more are available. If you select 
more than 20 workgroups, an indicator ( ) informs that you need to remove some to continue. 
Click Next. 

8. Use the Workgroup Statistics Selection dialog to specify which workgroup statistics appear in 
the view. 

9. Use the Interval and Queue Statistic Selection dialog to select time intervals and queue 
statistics. 

10. Click Finish. 



Printed Documentation 

35 

Change statistics displayed in this view 

1. Right-click in the view to display its shortcut menu. 

2. Choose Add/Remove statistics… 

3. Use the Workgroup Statistics and Queue Statistics dialog to change the selection of statistics. 
Click OK. 

Change workgroups displayed in this view 

1. Right-click in the view to display its shortcut menu. 

2. Choose Add/Remove workgroups… 

3. Use the Workgroups Selection dialog to select other workgroups to report in the view. 

Remove a workgroup 

Right-click on the workgroup to display its shortcut menu. Choose Remove > Remove workgroup row. 

Remove a statistic (column) 

Right-click on a column to display its shortcut menu. Choose Remove > Remove statistic. 

Display Help for a statistic 

1. Right-click a statistic in the Legend below the graph to display a shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Set Alerts 

See Manage Alerts. 

Workgroup Statistics view 

Summary 

A Workgroup Statistics view displays workgroup statistics for a selected workgroup. If the workgroup 
has a queue, the view also displays queue statistics, service level and abandon rate distributions. This 
view does not show the queue or members of the directory. If you need to see those, use the 
Workgroup Details view instead. 
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The workgroup selection control changes view parameters by switching workgroups. If a server has 20 
workgroups or less, this functions as a drop down selection list, otherwise it is a type-ahead lookup 
control. Workgroups in the selection list can have 2 different icons, to indicate whether the workgroup 
has a queue or not. 

Selecting a different workgroup stops all statistic watches for the previously selected workgroup, and 
starts watches for the new workgroup.  If the selected workgroup has no queue, expanders for Queue 
Statistics, Service Level and Abandon Rate do not appear. This view always contains an expander for 
workgroup statistics. 

Add this view 

1. If necessary, start IC Business Manager and log on. 

2. In IC Business Manager, select a workspace from the Workspaces menu, or create a new 
workspace to host the view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. In the Categories list, select Agents and Workgroups. 

6. Select Workgroup Statistics in the list of views on the right. Click OK. 

7. Use the Workgroup Statistics dialog to select one workgroup to report in the view. You may 
need to type a workgroup name in the Filter box. When more than 20 workgroups exist in the 
system, only the first 20 are shown, and an indicator ( ) informs that more are available. If you 
select more than 20 workgroups, an indicator ( ) informs that you need to remove some to 
continue. Click Finish. 
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Examine a different workgroup 

Select another workgroup from the Workgroup drop list. 

Change statistics displayed in this view 

1. Right-click in the view to display its shortcut menu. 

2. Choose Add/Remove statistics… 

3. Use the Workgroup Statistics dialog to select which time intervals and statistics appear in the 
view. Click OK. 

Select cumulative vs. Partial Sum histogram for Service Level or Abandon Rate 
statistics 

 
Click Options on the right side of the expander to select histogram type. 

Think of cumulative distribution as an accumulative bucket for the workgroup, interaction type and time 
interval (current period, current shift, etc.). An accumulative bucket means that each bucket includes 
the count for all of the preceding buckets. In a partial sum distribution, each bucket count is exclusive of 
any other bucket. 

• Cumulative  alters the reporting interval to summarize interactions in the first n seconds. For 
example: 
 
0-10 seconds  - Interactions abandoned/serviced in the first 10 seconds. 
0-20 seconds  - Interactions abandoned/serviced in the first 20 seconds. 
0-30 seconds  - Interactions abandoned/serviced in the first 30 seconds. 
0-40 seconds  - Interactions abandoned/serviced in the first 40 seconds. 
Etc. 

• Partial sum summarizes interactions abandoned or serviced in particular intervals. For example: 
 
0-10 seconds   - Interactions abandoned/serviced in the first 10 seconds. 
10-20 seconds - Interactions abandoned/serviced between 10 and 20 seconds. 
20-30 seconds - Interactions abandoned/serviced between 20 and 30 seconds. 
30-40 seconds - Interactions abandoned/serviced between 30 and 40 seconds. 
Etc. 

Remove all statistics in a statistic group from the view. 

1. Right-click in the view to display its shortcut menu. 

2. Select Remove > Remove entire statistic group. 

Remove a statistic from the view. 
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1. Right-click in the view to display its shortcut menu. 

2. Select Remove > Remove statistic. 

Display Help for a statistic 

1. Right-click the statistic to display the shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Skills Filtering 

The ability to filter skills is not always visible in this view. Skill filtering is unavailable if: 

• You are connected to an older server that does not support skill filtering. 

• No Statistic Parameter Group has been assigned to the workgroup. 

• No Skill Categories have been assigned to the the Statistic Parameter Group with which the 
workgroup is associated. 

When any of these factors apply, the skills filter section is not visible to maintain backwards 
compatibility. 

Set Alerts 

See Manage Alerts. 

Interaction Feedback Status category 

Interaction Feedback Status category 

Summary 

Interaction Feedback is an IC Business Manager module that creates automated, post-call customer 
satisfaction surveys that ask your customers discerning questions about your company's products and 
services. 

Icon View Details Appearance 

 

The Interaction Feedback 
Statistics view displays real-time 
statistics for surveys that 
customers are in the process of 
taking. 

Real-time monitoring helps you 
understand what your company 
is doing well and what 
immediate actions might need to 
be taken to meet customer 
expectations. 
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If this view category does not appear when you add a view, contact your CIC System Administrator. See 
Licenses, Security and Access Control Rights. 

For Interaction Feedback statistics, "today" is relative to component start time, not 
server time 

When viewing the Feedback statistics page, all statistics pertain to "today", and statistic times are 
relative to the local date for the CIC server where the Feedback sub-system is installed. All "last hour" 
statistics are relative to the last 60 minutes in time and updated continually. For example, if a survey is 
completed at 2:30 PM, it will register between 2:30 PM and 3:29 PM.  Likewise, if a survey is completed 
at 11:45 PM on Monday, the event will count in "last hour" statistics between Monday 11:45 PM and 
Tuesday 12:44 AM. 

Related Statistics 

Feedback Statistics 

Interaction Feedback Statistics view 

Summary 

The Interaction Feedback Statistics view displays real-time statistics for surveys that customers are in 
the process of taking. Real-time monitoring helps you understand what your company is doing well and 
what immediate actions might need to be taken to meet customer expectations. 

 
Feedback Statistics are displayed for the last hour (relative to the present time) or for the current day 
since midnight. Daily statistics reset at midnight. 

Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 
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3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the Interaction Feedback view category. 

6. Select Interaction Feedback Statistics from the list of views. Click OK.  The Interaction Feedback 
Wizard appears. 

7. Select a Survey group name. 

8. Click Next. 

9. Select the name of the Survey whose statistics you want to view. 

10. Click Finish. 

Change statistics in this view 

Interaction Feedback statistics inform about a named Interaction Feedback survey or survey group.  

1. Right-click a statistic in the view to open its shortcut menu. 

2. Select Add/Remove Statistics… from the menu. The Interaction Feedback Statistics dialog 
appears. Use this dialog to manage which statistics will appear in the view. 
 
To add statistics to the view, select statistics in the list on the left. Then click Add to move them 
to the list on the right. Add All selects all items for inclusion. 
 
Use Move Up and Move Down buttons to optionally change the display order of columns in the 
view. 
 
To exclude statistics from the view, select items in the list on the right. Then click Remove. The 
Remove All button excludes all time periods from the view, but at least one must be included. 

3. Click OK when finished. 

Display Help for a statistic 

1. Right-click the statistic to display a shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Change Chart options 
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1. Right-click the chart control to display a shortcut menu. 
 

 
2. Select a command from the Legend menu. 

 
Show Legend toggles display of the legend on or off. 
Show Values toggles display of statistics values in the legend. 
Legend Left displays the legend to the left of the pie chart. 
Legend Right displays the legend to the right of the pie chart. 

  

Set Alerts 

Using Supervisor alerting mechanism, you can receive immediate notifications when surveys fail to meet 
a minimum acceptable score. See Manage Alerts. 

Interaction Feedback Wizard 
The Interaction Feedback Wizard appears when an Interaction Feedback Statistics view is added. The 
first page of the wizard prompts to select a survey group. The second page prompts to select the name 
of a survey. 
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A limited number of entries is shown by default. If you entry you wish to select is not shown, type all or 
part of a survey group or survey name in Filter text box at the top of the dialog. This displays only those 
records that contain a matching search string. 

To complete this dialog: 

1. Select a Survey group name. 

2. Click Next. 

3. Select the name of the Survey whose statistics you want to view. 

4. Click Finish. 

Related Topics 

Interaction Feedback Statistics view 

  

Interaction Feedback Statistics dialog 
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The Interaction Feedback Statistics dialog appears when users of an Interaction Feedback Statistics 
view right-click a statistic to display the shortcut menu, and then select Add/Remove statistics. This 
dialog modifies the selection of statistics displayed in the view. 

• The list on the left displays statistics that are not currently included in the view. Click Add or Add 
All to move them to the list on the right, which displays statistics selected for inclusion in the 
view. 

• To exclude a statistic from the view, select it in the list on the right. Then click Remove or 
Remove All. 

• The Move Up and Move Down buttons manage the display order of statistics in the view. 

When you are finished, click OK to dismiss the dialog. 

Related Topics 

Interaction Feedback Statistics view 

Interaction Optimizer category 

Interaction Optimizer category 

Summary 

Interaction Optimizer is a workforce management module in IC Business Manager which manages shift 
schedules that account for multiple interaction types, agent skill sets and the typical peaks and valleys in 
customer volume.  Interaction Optimizer provides intelligent forecasting, scheduling and real-time 
adherence information. 



Interaction Optimizer category 

44 

Icon View Details Appearance 

 

The Real Time Adherence view 
displays schedule adherence 
information for agents currently 
scheduled by Interaction 
Optimizer. 

It monitors agents’ adherence to 
schedule at all times, providing 
instant feedback, to help call 
centers maintain proactive 
control over agent schedules. 

 

To use the Real Time Adherence view, a combination of license and ACL rights must be assigned to you. 
No security rights are required to use this view. If this view category does not appear when you add a 
view, contact your CIC Administrator. License and ACL requirements are summarized below. 

Required Licenses 

Interaction Optimizer's view category icon is visible only when the user has been assigned the Optimizer 
Supervisor Plug-in license in Interaction Administrator. Your CIC Administrator manages these license 
assignments for you.  The Display Optimizer Real-Time Adherence Statistics license should also be 
assigned to agents to allow Supervisor to monitor their adherence. See Licenses for the procedure used 
to assign licenses to users. 

Required ACL Right 

Your CIC Administrator must enable the selection of Scheduling Units in order for you to add the Real 
Time Adherence view. In Interaction Administrator, ACL rights are assigned from the Security tab of a 
configuration record, after clicking the Access Control button. 

Under Application rights, for the "Optimizer Scheduling Units" group, check the View column. This 
grants view only access to Interaction Optimizer Scheduling Units. 

I3_ATTR_RIGHT_VIEW_SCHEDULING_UNIT_LIST 

If access to a scheduling unit is removed from a supervisor user when that person is looking at a Real 
Time Adherence view, a message will appear to advise that access rights were modified. 

 
When this message is dismissed, the view will close. This message is also displayed if IC Business 
Manager is opened with an Optimizer view with scheduling unit access removed. 
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See also Licenses, Security and Access Control Rights. 

  

Related Statistics 

Agents Real-Time Adherence Details 

Real-time Adherence view 

Real-time Adherence view 

Summary 

The Real-time Adherence (RTA) view monitors agents’ adherence to schedule at all times. It provides 
instant feedback and helps call centers maintain proactive control over agent schedules. 

 
This view identifies users who are in or out of adherence based on a variety of factors.  It allows a call 
center manager to track current agent activity and presence, by comparing actual agent activity with the 
published schedule.  

The display combines overview and agent details in one view. The top section of the view (RTA 
Overview) indicates how many users are in or out of adherence with the current schedule. This 
information is also presented in a chart control.  The bottom section of the view (Agent Details) provides 
details about each individual agent's adherence to schedule.  

Drop lists make it easy to choose a different Scheduling Unit or Workgroup. Selecting a different 
Adherence status or Exception type affects Agent Details only. 

RTA statistics inform about agents who are currently scheduled. RTA statistics report scheduling unit, 
workgroup, status, scheduled activity, actual activity (based on status), adherence status, exception 
type, and adherence time for an agent. 
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Note: If a workgroup is added to or removed from a scheduling unit in Interaction Optimizer, the 
change will be reflected immediately in this view. 

  

Add this view 

1. If necessary, start IC Business Manager and log on. 

2. In IC Business Manager, select a workspace from the Workspaces menu, or create a new 
workspace to host the view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. In the Categories list, select Interaction Optimizer. 

6. Select Real Time Adherence in the list of views on the right. 

7. Click OK. The Optimizer Scheduling Unit page of the Real-time Adherence wizard appears. 

8. Select the name of a scheduling unit. If many are defined, you can type all or part of the name in 
the Filter box. When more than 20 schedules exist in the system, only the first 20 are shown, 
and an indicator ( ) informs that more agent names are available. Once you click to select a 
unit, its name appears in the Scheduling Unit box. This helps verify your selection. 

9. Click Next to Proceed. The Workgroup selection page appears. 

10. Click to select a workgroup by name. Optionally use the Filter box to locate specific workgroups 
by typing all or part of a workgroup name. Once you make a selection, the workgroup name 
appears in the Workgroup box. This helps verify your selection. 
 
Note that Adherence Status is set to Out of Adherence by default, and that Exception Type is 
<**All**> by default. These are the most frequently used selections. To accept them, click Finish 
now to display the view. Otherwise click Next. The Adherence Status page appears. 

11. Select a status from the list of available statuses. Then click Next. The Exception Type page 
appears, listing all possible exception conditions. Select a condition, or <**All**> to select all 
conditions. Click Finish. 

Change statistics in this view 

1. Right-click any statistic to open a shortcut menu. 

2. Choose Select Statistics… from the menu. The Interaction Optimizer Statistic Selection dialog 
appears. Use this dialog to select which statistics appear in the view. 

3. The list on the left contains items that are not currently included in the view. The list on the 
right contains items selected for inclusion in the view. 
 
Select statistics in the list on the left. Then click Add to move them to the other list. Add All 
selects all items for inclusion. 
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Use Move Up and Move Down buttons to optionally change the display order of columns in the 
view. 
 
To exclude statistics from the view, select items in the list on the right. Then click Remove. The 
Remove All button excludes all statistics from the view, but at least one must be included. 

4. Click OK when finished. 

Customize the Chart 

The chart can be customized by: 

• Right-clicking the chart control and selecting a new chart type (Pie, Column, or Bar). 
 

 
• Right-clicking the chart control and selecting a new position for the legend relative to the chart. 

Show Legend toggles the legend itself on or off. Show values toggles display of current values 
next to each statistic in the legend. 
 

 

Remove category 

To remove a category column from the Agent Details section of the view, right click a column and select 
Remove Category from the shortcut menu. 

Add category 

To add a category column to the Agent Details section of the view, right click a column and select Add 
Category from the shortcut menu. This opens the Interaction Optimizer Statistic Selection dialog, so that 
you can choose categories to appear in the view. 

Display Help for a statistic 

1. Right-click the statistic to display the shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Set Alerts 
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See Manage Alerts. 

Real-time Adherence Wizard 
The Real-time Adherence wizard appears a Real-time Adherence view is added. Pages in this wizard 
prompt for Interaction Optimizer Scheduling Unit, Workgroup, Adherence Status, and Exception Type. 

Optimizer Scheduling Unit page 

 
Use this wizard page to select an Interaction Optimizer Scheduling Unit. A scheduling unit is a collection 
of workgroups that are scheduled together.  

1. Select the name of a scheduling unit. If many are defined, you can type all or part of the name in 
the Filter box. 

2. When more than 20 schedules exist in the system, only the first 20 are shown, and an indicator 
( ) informs that more agent names are available. Once you click to select a unit, its name 
appears in the Scheduling Unit box. This helps verify your selection. 

3. Click Next. 

Workgroup selection page 
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Use this wizard page to select a Workgroup. 

1. Select the name of a workgroup. If many are defined, you can type all or part of the name in the 
Filter box. 

2. When more than 20 schedules exist in the system, only the first 20 are shown, and an indicator 
( ) informs that more agent names are available. Once you click to select a unit, its name 
appears in the Workgroup box. This helps verify your selection. 

3. Click Next. 

Adherence Status page 
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Use this page to select whether to display agents who are in or out of adherence. 

1. Select either In Adherence (with schedules) or Out of Adherence. 

2. Click Next. 

Exception Type page 
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Use this page to select exception type to use as selection criteria. Possible values are Unknown, Early, 
Late, Unscheduled, Logged Out, or <**All**>.  This requires a bit of explanation. An exception occurs 
whenever an agent's actual activity does not match their scheduled activity.  An agent can have an 
exception in 1 of 2 ways: 

• Case 1: When the scheduled activity changes but the agent's actual activity doesn't change. 

• Case 2: When the agent's status and actual activity changes but the scheduled activity doesn't 
change. 

In theory, it is possible for both an agent's scheduled and actual activity to change at the same time; but 
in practice, that will rarely happen. 

Optimizer statistics track the "before" and "after" actual activity.  For case 1, the actual activity before 
and after the scheduled activity change would be the same.  For case 2, the "before" actual activity 
would be the actual activity before the status/activity change and the "after" actual activity would be 
the actual activity after the status/activity change. 

The "before" and "after" actual activities are relevant to the exception type.  When an exception occurs, 
the before and after actual activities are examined and compared to not only the scheduled activity but 
also the previous and next scheduled activities: 

• If the before actual activity is the same as the previous scheduled activity, the exception is 
Late.  The thought is that the agent is still doing what they were last scheduled to do and are 
late in changing to the new scheduled activity. 
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• If the after actual activity is the same as the next scheduled activity, the exception is Early.  The 
thought is that the agent started doing what they are next scheduled to do before they are 
scheduled to do it. 

• It is possible for both conditions to be true.  In that case, the exception would be Late. 

• If the before actual activity doesn't match the previous scheduled activity and the after actual 
activity doesn't match the next scheduled activity, then the exception is Unscheduled. 

• If there is no exception (the scheduled activity and actual activity match), then the exception 
type is Unknown. 

Related Topics 

Real-time Adherence view 

Interaction Optimizer Statistics Selection dialog 

 

Use this dialog to change the selection of statistics displayed in the Real Time Adherence view. 

1. Right-click any statistic to open a shortcut menu. 

2. Choose Select Statistics… to display this dialog. 

3. The list on the left contains items that are not currently included in the view. The list on the 
right contains items selected for inclusion in the view. 
 
Select statistics in the list on the left. Then click Add to move them to the other list. Add All 
selects all items for inclusion. 
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Use Move Up and Move Down buttons to optionally change the display order of columns in the 
view. 
 
To exclude statistics from the view, select items in the list on the right. Then click Remove. The 
Remove All button excludes all statistics from the view, but at least one must be included. 

4. Click OK when finished. 

Interaction Recorder category 

Interaction Recorder category 

If this category does not appear when you add a view, contact your CIC System Administrator. See 
Licenses, Security and Access Control. 

Icon View 
Details 

Appearance 

 

Content 
Servers 
view 
 displays 
statistics 
that help 
determine 
the state 
of 
configured 
Remote 
Content 
Servers 
and 
Recorder 
Server. 

This view 
displays 
content 
servers 
statistics. 

 

  

  

Content Servers view 
This view displays content servers statistics that help determine the state of configured Remote Content 
Servers and Recorder Server. 
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Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the Interaction Recorder view category. 

6. Select Content Servers from the list of views. Click OK. This view does not require parameters to 
be set. 

Change statistics in this view 

1. Right-click in the view to open its shortcut menu. 

2. Select Add/Remove Statistics… 

3. Use the Content Server statistics dialog to change columns displayed in the view. 

 

4. Click OK.  
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Display Help for a statistic 

1. Right-click the statistic to display the shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Set Alerts 

See manage alerts. 

  

System Status category 

System Status category 

Summary 

System Status views monitor the health and performance of CIC servers. If this category does not 
appear when you add a view, contact your CIC System Administrator. See Licenses, Security and Access 
Control Rights for details. 

Icon View Details Appearance 

 

Call Activity 

The Call Activity view shows all 
activity in line or station queues. 

 

 

License statistics 

Shows how many licenses an CIC 
system has, and how many of 
those have been consumed. 
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Queues 

Shows line, station, workgroup 
and user queues. 

 

 

Session Managers 

Shows session managers and 
sessions. 

 

 

System Graph 

Shows system statistics in a 
chart. 

 

 

System Statistics 

Shows system statistics. 

 

  

Call Activity view 
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Summary 

The Call Activity view displays activity in all line or station queues that the user has ACL rights to see. 
Disconnected interactions are immediately removed. Each row in this view displays a configurable set of 
queue columns. 

 

License Requirement 

The "System Status Supervisor Plug-in" license is required, since the Call Activity view is part of the 
System Statistics module.  If that license is revoked or never assigned, all views in the System Status 
category are unavailable.   

Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the System Status view category. 

6. Select Call Activity from the list of views. Click OK. This view does not require parameters to be 
set. 

7. Select Line Queues or Station Queues from the Queue Type box. 

Display Line or Station activity 
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Select Line Queues or Station Queues from the Queue Type box. For either case, the view displays all 
lines or stations activity for which the user has ACL rights. 

Call Action Control 

Buttons in Call Action Control toolbar perform telephony actions on selections in the currently 
displayed queue. If an action cannot be performed, its button appears shaded. See Call Action Control 
for details. 

Sort columns 

To change the sort order, click on a column heading to sort by that column.  The last two previously 
sorted columns are used as sub sorts.  Sorting is available on all displayed queue columns.  Clicking on 
the header will select the queue column to sort and additional click on the same queue column header 
will toggle between ascending and descending order.  Once the user selects a sort order, the 
interactions are sorted once every second in the requested order.  It is therefore possible that an 
interaction appears in the wrong order for a maximum of 1 second before being sorted back in its 
proper place. This one second delay is built into all queues displayed by supervisor to handle thousands 
of interactions displayed. 

Resize column width 

To resize a column, drag the edge of a column heading left or right to narrow or widen the column. 

Change columns displayed 

To change the selection of queue columns displayed, right-click any column heading. This opens a 
shortcut menu that lists frequently-used columns. Checkboxes indicate whether a column is currently 
displayed in the view. 
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At this point, you may optionally select a column to include or 
exclude from the view. However, not all columns are listed in the 
shortcut menu. 

To select from all available columns. Click More…  The Queue 
Columns Selection dialog appears. 

Use the dialog to select statistics to display, and their order of 
appearance in the Queues view. 

Check or uncheck boxes to include or exclude items from the view. 
You can also press Show or Hide buttons to include or exclude 
items. 

Optionally use the Move Up and Move Down buttons to modify the 
display order of queue columns. The higher a statistic is in the 
Columns list, the more leftmost that column will be in the view. 

When you are finished, Click OK to apply your new column 
selections. 

Set Alerts 

See Manage Alerts. 

License statistics view 

Summary 

The License statistics view shows how many licenses an CIC system has, and how many of those have 
been consumed. This allows the supervisor user to see how many licenses are currently in use and be 
alerted before a shortage of available licenses occurs. 
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Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the System Status view category. 

6. Select License Statistics from the list of views. Click OK. This view does not require parameters 
to be set. 

7. Select Assigned or Concurrent from the License Type box. 

Columns in this view 

See Licenses for a list of CIC license and utilization statistics. 

Change statistics in this view 

1. Right-click in the view to open its shortcut menu. 

2. Select Add/Remove Statistics… 

3. Use the License Statistics dialog to change columns displayed in the view. 
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The License Statistics dialog. 

4. Click OK.  

 To remove a single column from the view: right-click a column, then select Remove Statistic from 
the shortcut menu. 

Display Help for a statistic 

1. Right-click the statistic to display the shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Set Alerts 

See Manage Alerts. 

Queues view 

Summary 

A queue is collection of interactions related to a user, station or workgroup. The Queues view allows a 
supervisor or manager to examine activity in line, station, user and workgroup queues.  Interactions can 
be picked up, disconnected, placed on hold, joined, listened to, coached, recorded, or tagged as 
private.  From this view, Agents can be given assistance with interactions in the different queues. 
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The main sections of this view are the Queue Selection Bar, Information display section with its list of 
objects belonging to the selected queue type, and Call Action Control. 

Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the System Status view category. 

6. Select Queues from the list of views. Click OK. 

Queue Selection Bar 

The Queue Selection Bar at the top of the view selects the type of queue and type of queue object to 
display. 

Queue Type drop list 

Use the Queue Type drop list to select interactions associated with a line, station, user, or workgroup 
queue. Interactions from that queue will appear in the Information display section of the view, along 
with interaction counts for each queue. The figure below shows examples of each queue type. 
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If line, station, user, or workgroup queues are added, removed, or renamed while you are using 
Interaction Supervisor to view them, the Queues view must be closed and reopened to display the 
modifications. 

Interaction Type drop list 

The Interaction Type drop list filters the list of interactions to display a single type of queue objects, or 
objects of all interaction types. 

All Types Display queue objects of all types in the Information display section. 

Call Display only telephone calls currently in the selected queue. 

Callback Display only callback interactions that are currently in the selected queue. Callback 
interactions occur when agents call a customer in accordance with a callback 
request. 

Chat Display only chat interactions that are currently in the selected queue. Chat 
interactions allow users to interact by sending and receiving text, files, or URLs. 

Email Display only email interactions that are currently in the selected queue. 

Instant 
Question 

Display only instant question interactions that are currently in the selected queue. 
Instant Questions are an Interaction Web Tools interaction type that lets a Web site 
visitor open a single round-trip question and answer session with an agent. 

Generic Display only generic interaction objects that are currently in the selected queue. 

Web Display only web interactions that are currently in the selected queue. 

Workflow Item Display only workflow items that are currently in the selected queue. 

Information display section 
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The Information Display section of the view has three panes: 

1. The list control in the left pane displays the objects corresponding to the Queue Type combo box 
selection. For example, if you select Station Queues from the Queue Type drop list, a list of station 
queues will appear.  

2. The right pane lists interactions currently in that queue. 

3. Once you select an interaction, you can press Interaction buttons in the bottom pane to pick up, 
join, listen to, record, and perform other actions that you have been assigned rights to perform. 

Call Action Control 

Buttons in Call Action Control toolbar perform telephony actions on selections in the currently 
displayed queue. If an action cannot be performed, its button appears shaded. See Call Action Control 
for details. 

Sort columns 

To change the sort order, click on a column heading to sort by that column.  The last two previously 
sorted columns are used as sub sorts. 

Resize column width 

To resize a column, drag the edge of a column heading left or right to narrow or widen the column. 

Change the columns displayed 

To modify columns in the Queues view, right-click any column heading. This opens a shortcut menu that 
lists frequently-used columns. Checkboxes indicate whether a column is currently displayed in the view. 
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At this point, you may optionally select a column to include or 
exclude from the view. However, not all columns are listed in the 
shortcut menu. 

To select from all available columns. Click More…  The Queue 
Columns Selection dialog appears. 

Use the dialog to select statistics to display, and their order of 
appearance in the Queues view. 

Check or uncheck boxes to include or exclude items from the view. 
You can also press Show or Hide buttons to include or exclude items. 

Optionally use the Move Up and Move Down buttons to modify the 
display order of queue columns. The higher a statistic is in the 
Columns list, the more leftmost that column will be in the view. 

When you are finished, Click OK to apply your new column selections. 

Set Alerts 

See Manage Alerts. 

Session Managers view 

Summary 

The Session Managers view displays statistics collected by CIC session managers.  Each session 
manager is a server-side subsystem that handles CIC work for a client application.  Client apps do not 
use CIC components directly.  Instead they connect via a Thin Bridge to a session manager that offloads 
the actual CIC work.   Session managers cache data and provide other optimizations for thin clients. 
Generally speaking, session managers maintain the state and operation of CIC client applications.  
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Application products such as Interaction Client connect to the Interaction Center by way of server-side 
session managers. As the name implies, a session manager keeps track of all client-side sessions and is 
responsible for authentication, encryption, and other services. In particular, Session Manager allows for 
extremely low bandwidth utilization between client applications and the CIC server. 

 

For example, the CIC clients and Session Manager work together in a variety of ways to keep network 
usage low. For example, the first time a user runs a CIC client; it downloads all the directory entries 
(people, phone numbers, etc.) configured for that user and creates an encrypted local cache. Thereafter, 
only updates are downloaded. Similarly, Session Manager transmits real time presence information to 
the CIC client so it can display the current status of users in the directory pages. The Session Manager 
architecture allows users to run CIC client even over extremely slow dialup connections. 
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Ordinarily, a single instance of Session Manager runs on the main Interaction Center Platform server 
(e.g. the one running CIC). Such a configuration is generally suitable for up to one thousand or so 
concurrent connections of the CIC clients. In larger environments, Session Manager can be placed on its 
own server for extreme scalability and reliability. 

Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the System Status view category. 

6. Select Session Managers from the list of views. Click OK. This view does not require parameters 
to be set. 

Details of this view 

Since the Session Managers view displays status statistics collected by Session Managers, totals are 
provided for each Session Manager instance. Counts are maintained for each application connected to a 
session manager.  The names of products (client applications) vary depending upon the method used to 
connect and other factors. 

 

The view displays servers, session manager IDs, and products hierarchically. 
To use this view, expand the server, session manager, and product you want 
to examine. Products expand to display a list of current users. This makes it 
possible to see who is using the CIC clients or IC Business Manager, for 
example, at any point in time. 

 

To display user sessions under a product, click the down arrow on the right 
side of the session count control. A pop-up window will appear to display the 
current sessions. 

 
The Session count window is displayed until you click outside of it or change the focus to another 
window. To sort columns, click on column headers. An up or down arrow in the header indicates the 
ascending or descending order of the sort. 

Session Count 
Column Description 
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Session ID Unique session ID. 

User ID CIC user account. 

User name Windows login name. 

Icelib version Version of the user IceLib library. 

User extension Phone number extension of the user. 

Login time Time the user was logged in, express as yyyymmddhhmmss. 

Client ID CIC client ID used. 

Station ID CIC station ID. 

Phone number Identifies type of CIC phone number registered to the station ID. 

Session Count context menu 

Right-clicking a row in the session count displays a context menu. Menu options include: 

Copy line to clipboard 

Copies the current row to the clipboard. 

Copy every line to clipboard 

Copies all rows to the clipboard. 

Second sort column 

Permits the user to select a secondary sort column and a secondary sort direction. 
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Set Alerts 

See Manage Alerts. 

System Graph view 

Summary 

System Graph views present the relation between different system statistics selected by the user for 
comparison. When a System Graph view is added, the System Statistics Selection dialog is presented, so 
that the user can pick and choose statistics from any of the available statistical categories. 

 
Users are not required to select compatible statistics. For instance, a user can compare values displayed 
in gigabytes to values displayed as time and percentage. For this reason, graph views are most useful for 
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comparing similar statistics of the same data type, or for watching real-time values of different data 
types. 

Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the System Status view category. 

6. Select System Graph from the list of views. Click OK. The System Statistics Selection dialog 
appears. 

7. Choose statistics from any of the available statistical categories by: 

a. Select a category in the leftmost list. 

b. Select items in the middle list. Then click Add.  If you are not sure which statistics to 
select, briefly rest the mouse pointer over a statistic to display its description. 

c. Repeat steps a-c to add statistics from a different category. 

8. 8.   When you are finished, click OK to apply selections to the view. 

Change statistics in this view 

1. Right-click in the view to open its shortcut menu. 

2. Select Add/Remove Statistics… 

3. Use the System Statistics Selection dialog to modify which statistics are graphed. 

Customize the Graph 

See Chart Control. 

Set Alerts 

See Manage Alerts. 

Display Help for a statistic 

1. Right-click a statistic in the Legend below the graph to display a shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

System Statistics view 

Summary 
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The System Statistics view reports activity in CIC subsystems and queues. System administrators use this 
view to monitor the health of an CIC server. Call Center administrators us it to monitor high-level 
accumulators of call center activity—calls, recordings, emails, and other interactions ranging from 
speech recognition to Fax transmissions. 

 
This view uses expander controls to group statistics by category. To view statistics, click the label of an 
expander control. Clicking a second time collapses the region to conserve screen space. The statistical 
categories displayed in this view are summarized in the table below. 

Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the System Status view category. 

6. Select System Statistics from the list of views. Click OK. This view does not require any 
parameters. 

Statistical Categories in this view 

Expanders grouped various metrics using the statistical categories in the table below. 

Statistical Category Type of information in Statistical Category 

Client Services Resources Number of resources that Client Services has available.  
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Email Electronic mail routing activity in CIC. 

Fax Faxing operations in the CIC system. 

Interaction Statistics Current number of interactions by object type on the CIC system, and the 
currently longest interaction. 

IC Memory Usage Amount of memory that CIC subsystems are consuming. 

IC Performance Current health of the system in performance terms. 

PMQ Summary of activity in persistent message queues. 

Recording Activity in the voice recording sub-system. 

Speech Recognition Activity in the speech recognition subsystem. 

IC System Status General status of CIC, in terms of number of executing handlers, threads, 
errors, available text-to-speech sessions, and switchover events. 

Tracker Server Activity in the Tracker subsystem over the last 10 minute period. 

Transaction Server Activity in the Transaction Server subsystem over the last 10 minute 
period. 

Change statistics in this view 

1. Right-click in the view to open its shortcut menu. 

2. Select Add/Remove Statistics… 

3. Use the System Statistics Selection dialog to modify which statistics are graphed. 

Display Help for a statistic 

1. Right-click the statistic to display the shortcut menu. 

2. Select Help. The description of the statistic appears in the Statistic Help dialog. 

Set Alerts 

See Manage Alerts. 

Interaction Tracker category 

 Interaction Tracker category 

Summary 
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Interaction Tracker is an installed feature in Interaction Desktop, used to add, search and identify 
information about a customer. Information includes the customer’s organization, department, and 
location.  When a call comes arrives in the CIC client, a Reverse White Pages (RWP) lookup is 
automatically performed against the incoming Caller ID. If one or more matches are found, the call is 
then resolved to one unique Interaction Tracker contact. 

The Interaction Details view provides the ability to search for an interaction and examine its details in IC 
Business Manager. This view makes it possible to see everything that happened during the lifetime of an 
interaction, without having to run a report. Users can drill-down into an interaction to examine its data, 
to view details about a specific call segment, or to examine all parties involved. 

Icon View Details Appearance 

 

Interaction Details 

Provides ability to search for an 
interaction and examine its 
details. 

Query for interactions that are 
no longer in queue. Then drill 
down to display everything 
known about the interaction. 

 

Search features in this view query for interactions that are no longer in queue by: Interaction ID, Media 
Type, Date/Time, Direction, Last User, Last Workgroup, DNIS, Remote Number, or Remote Address. 
Once you have a query result, you can view details about an interaction, the segments within the 
interaction, and a brief overview of workgroups, local parties, and conference parties involved. 

Required Access Right 

The Tracker category icon is visible only when the user has been assigned the View Interaction Details 
security right in Interaction Administrator. Your CIC Administrator manages these rights to you. 

1. In Interaction Administrator, select the Users container. 

2. Open configuration entry for a user. 

3. Select the Security tab. 

4. Click the Security Rights button. 

5. Select User from the Category drop list. 

6. Scroll down to the User Rights section. 

7. Check the Has Right box for View Interaction Details. 

8. Click Close to dismiss the Security Rights dialog. 
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9. Click OK to dismiss the User Configuration dialog. 

Data that the user can view 

The Interaction Details view queries the site that the IC Business Manager user is logged in to. That is 
also the site where the user's permission to view the Interaction is configured. Users can view all 
interactions relating to that site, so long as they are logged into IC Business Manager and have the View 
Interaction Details security right. 

If the user is allowed to log on across multiple sites in a multisite environment, and the View Interaction 
Details right is assigned on all sites, the user can view an interaction on each site he is logged in. 

  

Interaction Details view 

Summary 

This topic explains how to use the Interaction Details view to search for an interaction and examine its 
details. You can search by Interaction ID, which is a number that uniquely identifies an object of any 
media type, such as a telephone call, fax, callback, chat, etc. 

You can also locate records using Search Criteria. Simple search criteria find matches for a specific time 
zone, media type, and date/time range. For example, you can pull up a list of callbacks placed in the 
Indiana East time zone that occurred yesterday between 4:30 and 5:00 PM. 

Clicking the Advanced expander control reveals additional search parameters. You can look for 
durations longer than or shorter than a specified range, last workgroup the object was on, last user 
interaction, call direction, and even the address of the remote user. These options are discussed later in 
this topic. 

Master page 

The Interaction Details view uses a master/detail format, implemented in two screens: 

When you add this view, its master page appears, offering search options and a grid for displaying 
search results. Tabs at the top of the master page allow searching by criteria or Interaction ID. You can 
control the number of records returned by selecting a maximum number in the Maximum Rows box. 
The grid can display up to 1000 records at one time. Your query may not return that many, however. 
Clicking on a column heading sorts the list of results by that column. To execute a query, specify search 
parameters or an Interaction ID. Then click the Search button. 
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Interaction Details dialog 

To display everything known about a particular interaction, double-click a row in the search results. 

This opens the Interaction Details dialog, which offers a simple way to drill-down and examine data. By 
clicking items in the tree control, you can view specific interaction details, ranging from details of the 
entire interaction, to details about specific segments or parties involved. 

A color-coded timeline at the top of the dialog provides “at a glance” information, such as the media 
type (call, e-mail, fax, etc.), whether the call was recorded or surveyed, and counts for the number of 
times the interaction was in IVR, in queue, held, or transferred. These details can be printed. This makes 
it easy to analyze everything that happened during the lifetime of an interaction, without having to run a 
report. 
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Add this view 

1. Logon to IC Business Manager if you have not done so already. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. Licensing and station rights determine the availability of selections. 

4. Select Categories from the Group By drop list.  

5. Select the Interaction Tracker view category. 

6. Select Interaction Details from the list of views. Click OK. 

Master Page (Query options and search results) 

Let's examine the master page in detail. When you add the view, this screen allows you to query and 
view results. You can Search by Interaction ID or use Search Criteria. Once you have a query result, you 
can drill down into an interaction's data.  

To search by Interaction ID 
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1. Click the By Interaction ID tab. 
 

 

2. Type an Interaction ID in the text box. 

3. Click Search. The search result will appear in the grid. Double-click a row to view details of the 
Interaction. See Details Page below. 

To use Search Criteria 

1. Click the By Search Criteria tab. 
 

 
2. Set any combination of search criteria: 

Search 
Criterion 

Description 

Timezone Selects time zone of interactions to find. The "From" and "To" search fields use time zone 
when selecting records. For example, you might select Mountain Time if a customer in 
Denver called at 5 pm (his time), and you are in a different time zone.  

Media Type Filters to retrieve interactions of a particular media type. The default is "Any", but you can 
limit the search to telephone calls, callbacks, chats, emails, fax, generic interactions, 
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Monitored Object, SMS (Simple Message Service) messages, Social Conversation, 
workflow objects, and interactions where the media type could not be determined 
(Unknown). 

From/To Use From and To time selection controls to query for interactions that occurred between 
specific dates and times of day. To set a date, click the calendar icon. Then choose a day 
of the month. 

 
To set a time, click the clock icon. Then set the time of day by choosing the hour, minute, 
second, and AM/PM designator. 

 

Line Duration 

Longer 
Than/Shorter 
Than 

Duration controls scope the search to an amount of time that the interaction consumed 
from start to finish. For example, you might query for calls longer than 30 minutes, or 
shorter than 1 minute. Duration is set in days, hours, minutes, and seconds. You can type 
values in each segment of the input field, or select a portion and use up and down arrows 
to increment or decrement values. 

Last 
Workgroup 

Selects only interactions that were most recently on a specified workgroup queue. 

Last CIC User Selects only interactions that were most recently processed by a specific user. 

Direction Scopes the search to call direction (Inbound, Outbound, Intercom, Unknown, or Any). 
"Unknown" selects only those interactions whose call direction could not be determined. 

DNIS Scopes the search to the telephone number dialed. Wildcard text can be specified in this 
field using % as the wildcard character. 
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Remote 
Address 

Scopes the search to the address of the remote party in a phone call or chat. This can be 
the telephone number or IP address. Wildcard text can be specified in this field using % as 
the wildcard character. 

3. Optionally limit the number of rows returned by selecting from the Maximum Rows list box. 

4. Click Search. Query results will appear in the grid below search options. 

Details Page 

Once you have a query result, you can drill down into an interaction's data.  To do this, double-click any 
row of data returned by a search. See Interaction Details dialog. 

  

Interaction Details dialog 

Interaction Details dialog 

Summary 

The Interaction Details dialog appears when a search result is double-clicked in an Interaction Details 
view. This dialog summarizes what happened during the lifetime of the interaction. This dialog is 
sometimes called the Interaction Detail Viewer. 

 

User Interface Elements 



Interaction Details dialog 

80 

Header 

The header at the top of the page displays general details such as direction, the date and time when the 
interaction occurred, and the name of the remote party.  Icons in the head provide “at a glance” 
information, such as the media type (call, e-mail, fax, etc.), whether the call was recorded or surveyed, 
and counts for the number of times the interaction was in IVR, in queue, held, or transferred. 

The Media Type indicator displays a graphic for each media type: 

 

Call interaction 
 

Email interaction 
 

Blind Transfer 

 

Callback 
interaction 

 

Instant Question 
interaction 

 

Web interaction 

 

Chat interaction 
 

Generic interaction, SMS 
interaction, or Fax 
interaction  

Workflow 
interaction 

    
Social 
Conversation         

The Recording indicator includes a drop-down list control that enables you to playback stored 
recordings of this interaction in the Recorded Media Viewer. Recordings include the following media 
types: phone calls, e-mail messages, chats, and screen recordings. For more information about 
interaction recordings and playback, see the Interaction Recorder Client help in the PureConnect 
Documentation Library. 

 

Tree control 

The tree control makes it possible to drill-down and examine data. When you select nodes in the tree 
control, the dialog displays different details, ranging from details of the entire interaction, to details 
about specific segments or parties involved. When a node in the tree is selected, the timeline displays 
the duration in seconds that corresponds to the selected segment. 

The top-level Interaction node summarizes the entire interaction. It has three child nodes: 

• The Segments node displays each segment of the Interaction in top-down chronological 
order.  Segments identify each processing passage of the interaction. 

• The Local Parties node lists names of local parties who participated in the interaction, sorted 
alphabetically. 

• The Workgroups node identifies each workgroup that the Interaction passed through, where 
applicable. 

Print button 
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Generates hardcopy of interaction details.   

 

I3_ATTR_RIGHT_VIEW_HISTORICAL_REPORTS 

Close button 

Dismisses the Interaction Details dialog. 

Interaction node 

The table below summarizes data items displayed when the Interaction node is selected. 

Data Item Description 

Interaction ID The number assigned by CIC that uniquely identifies this Interaction. 

Type The interaction type: call, callback, chat, email, fax, generic interaction, Instant 
Question, SMS message, web collaboration, workflow object, or unknown 
interaction type. 

Duration The total duration of the interaction. 

Time The date and time of the interaction. 

Disposition The general outcome of the interaction. See How interactions are dispositioned 
using segment detail data. 

Direction The call direction: Inbound, Outbound, Intercom, or Unknown if call direction 
could not be determined. 
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Remote Address The address of the remote party in a phone call or chat. This is a telephone 
number or IP address. 

DNIS Telephone number dialed. 

Recorded Yes or No, to indicate whether this interaction was recorded. 

Surveyed Yes or No, to indicate whether an Interaction Feedback survey was conducted. 

Remote Party Name of the remote party, if it can be determined. 

Local Parties Name(s) of local participants in the interaction. 

Call Log Expander Displays entries written to the call log during the lifetime of the interaction. 

Advanced This expander displays details from Interaction Tracker, intended for system 
integrators and developers who use the IceLib API. This raw data should be 
ignored by Supervisor users. For more information about this view of the entire 
Interaction Summary table, refer to Interaction Summary table in Appendix E of 
the CIC Data Dictionary. For your convenience, portions of this appendix were 
reproduced in this document. See InteractionSummary table. 

Segments node 

The Segments node displays each segment of the Interaction in top-down chronological 
order.  Segments identify each processing passage of the interaction. The possible segments are: 

Segment Name Description 

System Used whenever the interaction is in system state, this segment indicates that the 
interaction is interacting with CIC (for example, interacting with IVR). In some cases 
this is a transient event of the interaction as well. This segment represents the 
duration of the event. 

Queue Used whenever the interaction is added to the Workgroup queue, this segment 
represents the duration that the interaction waited in the workgroup queue. 

Alert Used whenever the interaction is alerting a CIC user or CIC station. This represents 
the duration—how long the interaction is alerting the CIC user or CIC station. 

Hold Used whenever the interaction state changes to Hold. This represents the duration 
of the interaction in a Hold state. 

Connect Used when there is a two connected participants in the interaction. This represents 
how long the interaction is in Connected state.  The participants can be CIC users, 
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CIC stations or remote persons. 

ACW Used when After Call Work (ACW) is done by the Agent who handled an ACD-
routed interaction. This represents the duration—how long the agent is in follow up 
state after the ACD interaction. This pertains to the very first follow up work 
handled by the ACD Agent. If the agent follows up multiple times after the ACD 
interaction, the other follow up intervals are not included. Also note that this is not 
an interaction state. It merely ties the initial Follow Up work completed by the 
agent for his last ACD interaction 

Messaging Used whenever the interaction is in Messaging/Voicemail state.  This represents the 
duration (how long the interaction is in messaging state). Messaging can happen 
before or after the interaction is connected the CIC user or CIC station. 

IVR This represents how long the interaction is in an IVR application. By default this 
measurement is not captured. Handler customization is required to capture IVR 
duration. The CIC administrator or a handler developer must modify the IVR 
application to indicate when the interaction is entering the IVR. 

Dialing Represents how long the telephone call is in dialing/proceeding state. This segment 
is only applicable to external/outbound telephone calls. 

External Transfer Represents how long two remote parties communicated using CIC system. This 
happens when an inbound interaction is transferred to the remote person. 

Conference Represents how long a participant (CIC user or external User) participated in a 
conference. This is only applicable for telephone calls. 

Consult Not currently used, but may be added in a future release, to indicate a consulting 
telephone call between the two entities in the system. One entity will be Agent and 
another one is an Agent or remote person (non-IC user). 

Suspend Not currently used. 

Unknown Used when the system fails to group any segment of the interaction. 

When the Segments node is selected, it displays the total number of segments associated with the 
interaction, and duration information. When an individual segment is selected, the following 
information is displayed: 

Data Item Description 

Segment Name Name of the segment. 

Server Time The time of the interaction in the time zone of the server you’re connected to in IC 
Business Manager. 
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Duration Duration of the segment in HH:MM:SS format. 

Local Parties List of all local parties involved in this segment. 

Workgroup Workgroup involved in this segment. 

End Code A code that indicates how this segment ended, leading to an understanding of how 
it transitioned to the next segment type. 

Wrap-up Wrap-up code (if any) set by the agent, shown on Connect segments only. 

Advanced    This expander displays details from Interaction Tracker, intended for system 
integrators and developers who use the IceLib API. This raw data should be ignored 
by Supervisor users. For more information about this view of the entire Interaction 
Summary table, refer to the CIC Data Dictionary / InteractionSummary table. 

Local Parties node 

The "Local Parties" node lists names of local parties who participated in the interaction, sorted 
alphabetically. When the node for a participant is selected, information about that participant is 
displayed: 

Data Item Description 

Participant Name Name of the local party. 

Total Duration Total amount of time this participant was involved in the interaction. 

Segment Count Number of segments this participant was involved in. 

Segments Names of segments this party participated in. 

Workgroups node 

The "Workgroups" node identifies each workgroup that the Interaction passed through, where 
applicable. When the Workgroups node is selected, it displays the count of workgroups associated with 
the interaction, and their names. 

When an individual workgroup is selected, information about that workgroup is displayed: 

Data Item Description 

Name The name of the workgroup selected in the tree control. 

Total Duration Total amount of time this interaction involved this workgroup queue. 
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Segment Count Number of segments associated with this workgroup. 

Segments Names of segments associated with this workgroup for the interaction. 

Related Topics 

Interaction Details view 

Single Party Interaction Example 
The Interaction Details dialog groups major segments of data acquired while the interaction was 
processed in CIC. It displays information about single party, two-party, multi-part interactions, and 
transfers. 

For example, an abandoned Single Party interaction looks like this: 

 
In this single-party example, the interaction was abandoned at the IVR or Workgroup Queue before it 
connected to the Agent or an IVR interaction. This interaction corresponds to one record per Interaction 
ID in the Interaction Details view. 

Two Party Interaction Example 
Two Party interactions involve two Interaction IDs, and two separate detail records. Two party 
interactions can be intercom, inbound or outbound.  Consider an intercom call for example. The CIC user 
who initiates the record will have direction set as outbound. The CIC User who answered or received the 
interaction will have interaction as outbound. The following image shows the example Intercom 
interaction: 
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Multi-Part Interaction Example 
Multi-part interactions involve more than two participants. The most common scenario is a conference 
call. In a multiparty interaction, each conference participant is represented by a single summary and 
detail record. 

For example, a conference with three participants might be created as follows: 

1. An external party calls the CIC system. 

2. An agent answers the call. 

3. The agent consults another agent, creating the conference. In this scenario, three records can be 
displayed by about the conference.  

Here is the master record for such a conference: 

 
Detail records for each party are opened by clicking on rows in the master summary. The first participant 
is shown below.  
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First Party: 
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Second Party: 
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Third Party: 

 

  

Transferred Interaction Example 
The system also stores interaction details for Call Transfers. Local and remote transfers can be examined 
in the Interaction Details dialog. 

Local Transfer 

A Local Transfer indicates when the interaction is transferred within CIC. This is also applicable when 
more than one CIC servers is involved, for example, when agents are connected between different CIC 
servers. A local transfer is represented below. Notice that the Transfer icon has a count (callout 1) and 
also that there is an End Code (callout 2) for the segment which initiated the transfer. In this case the 
connect segment is transferred. The TransferCount includes only the Local Transfer happening in the 
system. 

See Data Collection Relationship to learn how data collection in Interaction Detail Viewer co-relates with 
legacy summary data collection. 
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Remote Transfer 

When an interaction is remotely transferred outside the CIC system, a similar transfer icon will appear, 
but the End Code will be Remote Transfer, and a segment named External Transfer represents the 
external transfer segment. 

 

  

How interactions are dispositioned using segment detail data 
The system derives an Interaction disposition from segment detail data. The default, minimum 
dispositions are most accurate with two party interactions. For example, less data is available to 
evaluate when an interaction becomes part of conference. When an interaction is transferred to IVR, 
the disposition is not meaningful. 

DB Value 
Logged Scenario 

1 
Interaction never connected to a user or station. If the interaction is never connected to 
the user or station, it receives a disposition value of 1 in the database. Tracker receives the 
connect segment only the interaction state goes to connected. 
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The special cases excluded are: 

a.   If it is waited in the queue or delay segment and remotely disconnected it is 
dispositioned as 'Remote Disconnect when Waiting in Queue'. 

b.   If it waited in the queue or delay segment and disconnected by user/system or internal 
disconnect then it is dispositioned as 'Local Disconnect when waiting in Queue' 

c.    If it alerted the user/station and remotely disconnected it is dispositioned as 'Remote 
Disconnect when alerting user/station'. 

d.   If it alerted the user/station and disconnected by user/system it is dispositioned as 
'Local Disconnect when alerting user/station'. 

2 
Remote Disconnect when waiting in Workgroup Queue.  This is irrespective of interaction 
is connected or not, so long as the last segment is delay segment/waiting in the Workgroup 
queue and it is remotely disconnected. 

3 
Local Disconnect when waiting in Workgroup Queue. This is irrespective of interaction is 
connected or not. As long as the last segment is delay segment/waiting in the Workgroup 
queue and it is remotely disconnected, we disposition as this. 

4 
Remote Disconnect when alerting user/station. This is irrespective of interaction is 
connected or not, so long as the last segment is alert segment and it is remotely 
disconnected. 

5 
Local Disconnect when alerting user/station. This is irrespective of interaction is connected 
or not, so long as the last segment is alert segment and it is locally disconnected by user or 
system. 

6 

Connected – Remote Disconnected. This disposition is assigned if final connect segment is 
disconnected by the remote party. The connect segments considered for this dispositions 
are connect, held, suspend and consult. ("Consult" is the consult call's segment type, not 
the connect that was logged as consult segment type). 

7 

Connected- Local Disconnected. If final connect/Held segment is disconnected by the local 
user, it is dispositioned as this. The connect segments considered for this dispositions are 
connect, held, suspend and consult. ("Consult" is the consult call's segment type, not the 
connect logged as consult segment type). 

8 
Unknown. This disposition is assigned if the interaction did not match any one of the above 
disposition conditions. If the interaction terminated in a conference, the disposition is also 
logged as Unknown. 

Related Topics 

Interaction Details dialog 

Data Collection Relationship 
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The diagram below explains how data collection in Interaction Detail Viewer correlates with legacy 
summary data collection. 

 

Notes 

The IWrkgrpQueueStats table has the summary of interactions. In the example above, we are assuming 
only one interaction is received, answered and completed with follow up work within the interval in 
question. 

When there are multiple interactions, then the stats related to them are summarized according to their 
workgroup, media type, and report group. To co-relate them, it would be necessary to find 
corresponding Interaction Detail Viewer segments. The purpose of the above diagram is not to compare 
the Interaction detail viewer segment with IWrkGroup Queue statistics. Instead, it is to explain how the 
statistic collection is mapped between the two data collection modules. 

Interaction Detail Viewer gives the snap shot of the interaction state changes in the CIC system. It does 
not consider agent activities other than the follow up event that happened as a result of an ACD 
interaction it tracked. 

Also the duration in the Detail Viewer is linear and not overlapped with each other, whereas 
IWrkGrpQueueStats are overlapped with each other. When there are multiple interactions with complex 
interaction scenarios such as transfers and conferences involved, breaking the summary statistics into 
detail segments is not intuitive. 

Related Topics 

Interaction Details dialog 

Transferred Interaction Example 

InteractionSummary Table 
The following information is from the "InteractionSummary Table" in "Appendix E: Interaction Tables" of 
the PureConnect Data Dictionary Technical Reference. It is included here for convenience. For the most 
current information, see the PureConnect Data Dictionary Technical Reference in the PureConnect 
Documentation Library. 
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This table summarizes key attributes of the interaction. In general, only one row for an interaction will 
be logged here. If the interaction is persisted and recreated with the same InteractionIDKey, the system 
increments sequence numbers in two rows.  This is the table which replaces the legacy Calldetail table. 
It has all the columns used in the Calldetail table plus some new columns to track additional attributes. 
Here is the mapping between Interaction Summary and Calldetail view. 

Column Name  Type Null Default Description  CallDetail_viw  

InteractionIDKey Char(18)  No   Interaction Key  CallId  

SiteID  Integer  No -1 SiteID of the 
Interaction where it 
disconnected. 

SiteID  

SeqNo TinyInt No 0 SeqNo is only used 
when the 
interaction is 
persisted and 
recreated with the 
same 
InteractionIDKey. 

Not Included  

InteractionID  bigint  No   CallID/Interaction 
ID of the 
interaction. This is 
displayed in the CIC 
client. 

Not Included 

StartDateTimeUTC  DateTime2(3) 
Timestamp(3) 

No   StartDateTime 
(UTC) for the 
Interaction ID  

Not Included  

StartDTOffset  Integer  No   Offset to Server 
local time [in 
seconds] for the 
UTC StartDateTime  

Not Included  

Direction  tinyint No   Interaction 
Direction (1-
inbound, 2-
Outbound, 3-
Intercom 0-

CallDirection  
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Unknown)  

ConnectionType  tinyint  No   Unknown(0), 
External(1), 
Intercom(2),  

CallType  

MediaType tinyint No   Unknown(255), 
calls(0), chat(1), 
SMS(2), 
GenericObject(4), 
Email(5), 
Callback(6), 
InstantQuestion(7), 
WebCollabration(8), 
Fax(21), 
WorkItem(22) 

InteractionType  

RemoteID  nVarchar(50) NULL   Remote ID  RemoteNumber 

DNIS_LocalID  nVarchar(50)  NULL   Number dialed  DNIS  

tDialing  Integer  NULL   How long 
interaction is in 
dialing state  

tDialing  

tIVRWait  Integer  NULL   Total IVR Time for 
the interaction  

tIVRWait  

tQueueWait  Integer  NULL   Total time the 
interactions waited 
in one or more 
Queues  

tQueueWait  

tAlert  Integer  NULL   Total time the 
interaction alerted 
a different 
user/station 

tAlert  

tConnected   Numeric(19)  NULL   Total connected 
time for an 
Interaction. If the 
same interaction is 

CAST(ROUND(I.tConnected/1000., 
0) as INTEGER) as 
CallDurationSeconds 
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handled by multiple 
agents, this is the 
sum of all talk time. 

Captures the 
duration of how 
long the interaction 
is in the connected 
state with two 
participants. The 
participants can be 
a remote person, 
local CIC User, or 
standalone station. 

tHeld  Numeric(19)  NULL   Total held time for 
the interaction. If 
the interaction 
transition to held 
state is by multiple 
agents, this value 
includes all held 
durations. 

Captures the 
duration of how 
long the interaction 
is in a held state. 

CAST(ROUND(I.tHeld/1000., 0) as 
INTEGER) as HoldDurationSeconds 

tSuspend Numeric(19) NULL   Not currently 
supported, for use 
in a future CIC 
release. 

tSuspend 

tConference  Numeric(19)  NULL   Total time the 
interaction actively 
participated in a 
conference  

tConference 

tExternal  Numeric(19)  NULL   Total time the 
interaction was 
connected after an 
external transfer   

tExternal 

tACW  Integer  NULL   Total wrap up time tACW 
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for the interaction  

tSecuredIVR Numeric(19) NULL   Total duration of 
the secured session 
for the particular 
interaction id. For 
example, if the 
interaction went to 
multiple sessions of 
secured session, 
this column will 
accumulate all the 
individual sessions 
and log the total 
duration. 

Not Included 

nIVR  Small Int  NULL   Number of times 
the interaction 
entered any IVR, as 
determined by call 
attribute set by 
Interaction 
Attendant or a 
handler. 

nIVR 

nQueueWait   Small Int  NULL   Number of times 
the interaction 
waited in any ACD 
queue, even the 
same queue 
multiple times. 

nQueueWait 

nTalk  Small Int  NULL   Number of times 
this interaction was 
actively connected 
to any agent, even 
the same agent 
multiple times. 

nTalk 

nConference  Small Int  NULL   Number of times 
this interaction was 
actively connected 
to any conference, 
even the same 

nConference 
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conference multiple 
times.  

nHeld Small Int NULL   Number of times 
the interaction was 
in held state after 
connected 

nHeld 

nTransfer Small Int NULL   Number of times 
the interaction was 
transferred  

nTransfer 

nExternal  Small Int  NULL   Number of times 
the interaction was 
transferred 
externally  

nExternal 

nSecuredIVR Small Int NULL   Number of times 
the call went to 
secured session 
during its entire life. 

Not Included 

Disposition  Small Int  No 0 The values that get 
logged are 0 to 7. 
For details, see the 
"Interaction Detail 
View in IC Business 
Manager" section 
of the Interaction 
Tracker Help. 

Not Included 

DispositionCode  Small Int  NULL   This is how the 
Telephony Services 
(TS) server 
dispositioned the 
interaction. 

DispositionCode 

WrapUpCode  nVarchar(200)  NULL   Not used in the 
current CIC release. 
Exists for legacy 
reasons. 

WrapUpCode 
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AccountCode nVarchar(50) NULL   Account code tied 
to the Interaction 

AccountCode 

IsRecorded  Bit  NOT 
NULL 

  0 or 1. It is set if the 
interaction is 
recorded. It is set if 
at least one leg of 
this interaction is 
recorded. 

For example, this 
value is set if an 
interaction is 
recorded then 
transferred blind to 
the second agent 
and not recorded 
for the second leg 
of the interaction. 

Not Included 

IsSurveyed  Bit  NOT 
NULL 

  0 or 1. If the 
interaction is 
surveyed, it is set  

Not Included 

MediaServerID  nVarchar(200)  NULL   The Media Server 
that handles the 
interaction audio. 

Not Included 

IndivID  Char(22)  NULL   The remote Party 
IndivID if resolved 
by Tracker. This 
value is NULL if not 
resolved  

Not Included 

OrgID  Char(22)  NULL   Remote Party's 
OrgID if it is 
resolved by Tracker. 
This value is NULL if 
not resolved. 

Not Included 

LineID nvarchar(50) NULL   The line interaction 
received  

LineID 
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LastStationID nvarchar(50) NULL   The last connected 
station to the 
interaction 

StationID 

LastLocalUserID nvarchar(50) NULL   Local User ID 
associated with the 
last connected 
interaction  

LocalUserID 

LastAssignedWorkgroupID nvarchar(100) NULL   The last routed 
workgroup for that 
interaction 

AssignedWorkGroup 

LastLocalNumber varchar(200) NULL   Local number 
associated with the 
last connected user, 
for an email it is 
mailbox ID, for chat 
it is the user's 
display name or 
arbitrary name 
given by the chat 
initiator. 

LocalNumber 

LastLocalName nvarchar(50) NULL   LocalName 
associated with the 
last connected user 

LocalName 

RemoteICUserID nvarchar(50) NULL   The respondent's 
CIC User ID, will be 
populated only for 
Intercom 
interaction 

Not Included 

RemoteNumberCountry  smallint NULL   The country code 
associated with the 
remote number 

RemoteNumberCountry 

RemoteNumberLoComp1  varchar(10) NULL   Lower component 
of the remote 
number 

RemoteNumberLoComp1 
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RemoteNumberLoComp2  varchar(10) NULL   Lower component 
of the remote 
number 

RemoteNumberLoComp2 

RemoteNumberFmt  varchar(50) NULL   Remote number 
format 

RemoteNumberFmt 

RemoteNumberCallId  varchar(50) NULL   CallID of the remote 
number 

RemoteNumberCallId 

RemoteName  nvarchar(50) NULL   Remote Name RemoteName 

InitiatedDateTime  datetime2(3) 
TIMESTAMP(3) 

NOT 
NULL 

  Interaction Initiated 
date  and time with 
millisecond 
granularity 

InitiatedDate 

ConnectedDateTime  datetime2(3) 
TIMESTAMP(3) 

NOT 
NULL 

1970-
01-01 

Interaction 
connected date and 
time with 
millisecond 
granularity 

ConnectedDate 

TerminatedDateTime  datetime2(3) 
TIMESTAMP(3) 

NOT 
NULL 

1970-
01-01 

Interaction 
Terminated date 
and time with 
millisecond 
granularity 

TerminatedDate 

LineDuration  Numeric(19) NULL   Duration of the line 
in milliseconds 

CAST(ROUND(I.LineDuration/1000., 
0) as INTEGER) as 
LineDurationSeconds 

CallEventLog  nvarchar(2000  NOT 
NULL 

  Call Event log CallEventLog 

PurposeCode  int NULL 0 Purpose code set 
for the interaction 

PurposeCode 

CallNote nvarchar(1024) NULL   Text description  Not Included 
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related to call 

FirstAssignedAcdSkillSet  nvarchar(100) NULL   First ACD Skillset 
value assigned to an 
interaction 

 Not Included 

  

INDEXES 

Primary Key : InteractionIDKey , SiteID, SeqNo 

Clustered Index : InitiatedDateTime, SiteID 

Additional Indexes : StartDateTimeUTC and LastLocalUserID 

  

Copying Tracker information to the Clipboard 
There are three ways to copy Tracker information from an Interaction Details view to the clipboard, for 
pasting into other applications: 

1. From the search results screen, when a single row is selected, three copy options appear when you 
right-click to reveal the context menu: Copy Interaction Id, Copy Row, and Copy Row(s) as CSV. 
 

 

Copy Interaction ID 

Copies the ID of the selected interaction to the clipboard.  For example: 

1111000000 
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Copy Row 

Copies data from each column to the clipboard. For example: 

Interaction ID: 1111000000 
Time: 1/6/2014 11:38:25 AM 
Direction: Inbound 
Media Type: Call 
Remote Address: +13179571051 
Remote Party: Lapsley, Jeff 
Last CIC User: claysu5bft2_user 
DNIS: sip:3@claysu5bft2:5060 
Last Workgroup: Marketing 
Connected Duration: 00:00:03 
Line Duration: 00:00:49 

Copy Row(s) as CSV 

Copies data from each column to the clipboard as a series of comma separated values. The first 
paragraph contains column heading names. The second paragraph contains the value of each column. 
For example: 

Interaction ID, Time, Direction, Media Type, Remote Address, Remote Party, Last CIC User, DNIS, Last 
Workgroup, Connected Duration, Line Duration 
1111000000, 1/6/2014 11:38:25 AM, Inbound, Call, +13179571051, Lapsley, Jeff, claysu5bft2_user, 
sip:3@claysu5bft2:5060, Marketing, 00:00:03, 00:00:492.   From the search results screen, when 
multiple rows are selected, one option: "Copy Row(s) as CSV" 

2. From the search results screen when multiple rows are selected, the context menu option is "Copy 
Row(s) as CSV"  
 

 
 
This places on the clipboard a line of comma separated column headings, followed by column data 
for each row that was selected. For example: 

Interaction ID, Time, Direction, Media Type, Remote Address, Remote Party, Last CIC User, DNIS, 
Last Workgroup, Connected Duration, Line Duration 

1111000000, 1/6/2014 11:38:25 AM, Inbound, Call, +13179571051, Lapsley, Jeff, 
claysu5bft2_user, sip:3@claysu5bft2:5060, Marketing, 00:00:03, 00:00:49 

1111000002, 1/6/2014 11:40:38 AM, Inbound, Call, +13179571051, Lapsley, Jeff, 
claysu5bft2_user, sip:101@claysu5bft2:5060, , 00:00:22, 00:01:01 
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3. If you double-click a row in the search result to open the Interaction Details window, all sections 
and fields in the summary panel (right hand side) can be copied. For any given item, two options: 
"Copy [name of field]" and "Copy Section" 
 

 

Copy [name of field] 

Copies the value of the field that was right-clicked. For example if you right-click Interaction ID and 
select Copy 'Interaction ID' the value copied to the clipboard is 1111000000. 

Copy Section 

Copies all fields in the section to the clipboard. For example: 

Interaction ID: 1111000000 

Type: Call 

Duration: 00:00:49 

Time: 1/6/2014 11:38 AM 

Disposition: Unknown 

Interaction Dialer category 

Interaction Dialer category 

Summary 

Interaction Dialer is a client/server extension that adds automated dialing and campaign management 
features to CIC servers.  Interaction Dialer conducts campaigns by contacting a list of people according 
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to a prescribed list of rules. Interaction Dialer places outbound telephone calls for campaigns, plays .wav 
files to answering machines, sends faxes to fax machines, and routes calls answered by a live person to 
an Interaction Attendant profile or directly to Dialer agents. 

Interaction Dialer views display statistics about Dialer agents, outbound campaigns, skills, stages, wrap-
up codes and categories, the overall status of multiple running campaigns, and the health of Dialer 
servers. If the Dialer Statistics category does not appear when you add a view, contact your CIC System 
Administrator. See Licenses, Security and Access Control Rights for details. 

Icon View Details Appearance 

 

Dialer Campaign Details 

Shows detailed statistics about a 
campaign. 

 

 

Dialer Health view 

Shows the health and status of 
campaigns and Interaction Dialer 
in general. 

 

 

Dialer Overview 

Shows statistics and an overview 
of the Dialer campaigns and their 
agents. 
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Agent Overview 

Statistical information for Dialer 
Agents broken down by Dialer 
campaigns. 

This view is available in Dialer 
4.0 Service Update 1 and later. 

 

 

Skill Overview 

Statistics broken down by skill 
per each Dialer campaign. 

This view is available in Dialer 
4.0 Service Update 1 and later. 

 

Dialer Statistics 

Dialer agent statistics summarize the activity of a specific Dialer agent. 

Dialer campaign statistics provide totals that pertain to a campaign or site. 

Dialer overall statistics summarize Dialer's performance as a whole. 

Dialer phone number detail statistics summarize the details of a specific phone number. 

Dialer skill statistics summarize the details of a specific skill. 

Dialer stage statistics summarize the activity for a specific Dialer stage. 

Dialer wrap up statistics summarize the dispositions of Dialer calls. 

Add a Dialer view in IC Business Manager 
1. Start IC Business Manager and log on. 

2. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

3. Select New > View from the File menu. The Create New View dialog appears, listing views by 
category or product. 

4. Select Categories from the Group By drop list.  Then click Dialer Statistics. A list of Dialer views 
appears in the list on the right. 
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Tip—if Product is selected in the Group By list, click Interaction Dialer to display views 
you can add. 

5. Select a view to add by clicking an item in the Views list. The Dialer views are: 

View Name Description 

Dialer Campaign Details view Displays detailed statistics about a campaign. 

Dialer Health view Displays the health and status of campaigns and Interaction Dialer 
in general. 

Dialer Overview Displays statistics and an overview of the Dialer campaigns and 
their agents. 

6. Click OK. 

7. If the view requires parameters to be set, other dialogs appear at this time to prompt for view 
settings. 

As on Dialer 4 GA, no Dialer views require additional parameters to be set. However, additional 
views may become available after service updates are applied. Future Dialer views may require 
parameters to be selected. Optionally press F1 for help with parameter selection dialogs. 

8. When you finish selecting parameters, the view will appear in the workspace. 
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Views are automatically disabled if the connection with CIC server goes down for any reason. A 
'spinner' cursor is shown in all Supervisor views, indicating that no data is being received. Views 
are automatically enabled once the connection is restored. 

The Interaction Supervisor Help for IC Business Manager explains how to work with views and 
alerts. To open this help system in IC Business Manager, select Interaction Supervisor from the 
Help menu. 

Dialer Campaign Details view 

Dialer Campaign Details view 

 
This view displays operational statistics about any single campaign, a configurable graph of campaign 
details, and live information about agents by period, shift, recycle and campaign. 

Campaign Performance Statistics 

Statistics at the top of the view are updated in real-time to indicate the overall performance of the 
campaign.  See Dialer Campaign statistics for information about these statistics. Site and Campaign drop 
lists work together to allow selection of a single campaign to report on. A set of campaign execution 
controls make it easy to change the state of a campaign. For example, you can Start, Stop, or pause a 
campaign from this view, without having to open a campaign configuration in Interaction Dialer 
Manager. 

Campaign Details Graph 

The graph displays Dialer stage statistics once you select a statistic (total time, total calls, percent calls, 
average time, or percent time) and interval (period, shift, recycle, or campaign). 

Agent Statistics 
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The bottom right section part of the view displays Dialer agent statistics for all agents.  You cannot 
display statistics for a single agent, since the view is scoped to summarize the overall status of the 
campaign and site. 

Campaign Execution Controls 

Campaigns have execution states that are selectable in Interaction Dialer Manager and from within 
Supervisor views in IC Business Manager. 

Command Campaign Execution State 

 
Turn Campaign 
On 

No calls are placed for a campaign until that campaign is turned on. Outbound calling 
begins once agents change to available status. When a campaign is turned on, he 
contact list will be processed from the top. 

 
Turn Campaign 
On for scheduled 
calls only 

A campaign can be on for scheduled calls only. In this execution state, Dialer places 
only calls that were rescheduled by agents. Priority dials are still made, but no regular 
calls are placed. This mode ignores the campaign schedule, if one is assigned. Auto-
scheduled calls are not placed in this mode.  

 

Pause/Un-Pause 

A running campaign can be paused. This suspends outbound dialing for the 
campaign.  The campaign will continue to run until agents complete active calls. No 
new calls will be placed. The record cache is preserved so that the system can resume 
processing the contact list. 

A campaign can be un-paused by clicking the Pause button a second time. This will 
resume outbound dialing from the point the campaign was paused. Agents will not 
need to log on again when the campaign resumes. 

 
Turn Campaign 
Off 

A campaign can be off. This stops outbound dialing once the cache is empty. This 
execution mode ignores the campaign schedule. If you stop a campaign instead of 
pausing it, agents must log in when the campaign is turned back on. Outbound calling 
will resume once agents change to available status. 

  

 
Recycle 
Campaign 

A campaign can be recycled. Recycle refers to the process of restarting the call 
selection process at the beginning of the contact list.  This happens automatically after 
all records are processed, or manually in response to a campaign reset command.  A 
recycle period is the time that Interaction Dialer needs to process all records in a 
contact list. 

 

Reset Campaign 

A campaign can be reset. The contact list will be processed from the top to reach 
parties that were not contacted in a previous pass.  If major settings have been 
changed (DSN, Sorting or Filters, etc.), the campaign is reset and restarted with the 
new configuration.  This command also sets the count of recycles back to zero. 
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Managing the execution state of campaigns from IC Business Manager 

When a call center supervisor is monitoring Dialer views in IC Business Manager, the supervisor can 
control campaign execution in three ways: 

• By using campaign execution controls on the Dialer Campaign Details view: 

 
• By using shortcut menu commands in IC Business Manager's Dialer Overview view: 

 
• By selecting Dialer Campaign Actions from the Actions menu: 

 
Selecting Dialer Campaign Actions opens the Dialer Campaign Actions dialog. It offers the same 
execution controls that appear on the Campaigns page in Interaction Dialer Manager. 

 Note: the Actions menu only appears if the view is added to the default workspace in IC Business 
Manager. 
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Interval Definitions 
In several of the Dialer views in IC Business Manager, you can select an Interval, which specifies the 
length of time for the collection of statistics. An interval can be measured as Period, Shift, Recycle, or 
Campaign. 

Period 

Any user-defined interval delimited by specific start and stop times. 

Shift 

An interval defined in Interaction Administrator to represent a standard work day. 

Recycle † 

An interval defined by the amount of time that has elapsed between when the Contact List was last 
recycled and the present. 

Campaign 

An interval defined by the amount of time that has elapsed between when the active campaign began 
running and the present. 

† While Recycle can be designated as an Interval, it actually refers to the process of restarting the call 
selection process at the beginning of the contact list.  This can happen automatically after all records are 
processed, or manually in response to a Reset Campaign command. A Recycle period is the time that 
Interaction Dialer needs to process all records in a contact list. 

Dialer Health view 

Dialer Health view 



Printed Documentation 

111 

 
The Dialer Health view displays the health and status of campaigns and Interaction Dialer in general. Use 
this view to troubleshoot issues.  It presents two panes of information: 

• The top pane displays Dialer Status Messages—diagnostic information about the current 
condition of campaigns and workflows.  This pane dynamically updates itself to display new 
messages and to remove messages that no longer apply.  

• The bottom pane chronicles Dialer History Messages. It lists event and status messages that 
were logged by the Central Campaign Server, Outbound Dialer Servers, and by internal 
processes such as DialerTran.  The user must refresh to retrieve the most recent messages 
posted to the history pane.  

• The top and bottom panes are not related. The top pane displays diagnostic information about 
current conditions. The bottom pane is a historical log of past events.  You can sort a column 
alphabetically in either pane by clicking on the column heading.  

Dialer Status Messages pane 

Messages in the Dialer Status (top) pane are derived from heuristics that indicate adverse situations. 
The columns displayed are: 

Severity column 

The column indicates the seriousness of the event condition (Warning, Information, etc.) 

Time column 

Timestamp that indicates when an event occurred. 

Process Name 

Name of the server process that sent the status message. 
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Machine Name 

Name of the ODS server. 

Campaign 

Campaign associated with the event, if known. 

Message 

Brief description of the event that occurred.  To display the entire text, double-click the event to open 
the Message Details dialog.  

 
Messages are added to this list when: 

• Max Calls per Agent has been hit. 

• Global Maximum calls have been hit. 

• Line group with little or no lines. 

• Running campaigns in predictive mode with < 5 agents. 

• The Line group specified does not exist. 

• Current abandon rate has been exceeded (10% over for target, absolute threshold for strict). 

• Dialer isn't dialing because it is waiting for something: (waiting on dialerTranU / recycle / get 
contacts, etc.) 

• The Pace is manually adjusted. 

See Messages that can appear in a Dialer Health view for additional information. 

Dialer History Messages pane 

The bottom pane (Dialer History) lists event and status messages that were logged by the Central 
Campaign Server, Outbound Dialer Servers, and by internal processes such as DialerTran.  Since Dialer 
consolidates messages in its own message history, it is convenient to examine this repository for Dialer-
related entries.  When the view is scoped to view multiple workflows, the messages for each workflow 
are grouped together (in other words, messages for workflow A and workflow B are not 
intermixed).  When the dialog is scoped to monitor a single workflow, only messages from that workflow 
appear in the list. 
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Type column 

This column identifies the type of message.  Error indicates a significant problem, such as loss of data or 
loss of functionality.  Warning indicates an event that is not necessarily significant, but may indicate a 
possible future problem. For example, when disk space is low, a Warning will be logged.  An Information 
event describes the successful operation of an application or subsystem. 

Time column 

The date and time when the message was logged. 

Site column 

Name of the Outbound Dialer that this message pertains to. 

Campaign column 

Name of the campaign that this message pertains to. 

Agent column 

Name of the call center that this message pertains to, if applicable. 

Message column 

Text of the message entry. 

Messages that can appear in a Dialer Health view 
  

Status Messages History Messages 

The calculated calls per connect value for a 
campaign is greater than the configured maximum 
calls per agent. 

Configured line group is invalid or contains no lines. 

Campaign has fewer than six active agents, 
potentially decreasing agent utilization and 
increasing abandon rate. 

Current abandonment rate exceeds the configured 
target rate. 

Contact cache has been depleted. 

Configured Zone Set is blocked all callable contacts. 

Dialing is being restricted because the configured 
line capacity has been reached. 

History updates (campaign stats, agent stats, call 

Campaign could not be found in the dialer cache. 

Failure to register Dialer site with central campaign 
server. 

A memory allocation failed while trying to create a 
new object. 

Agent automatically logged out because the 
connection between the agent's scripter application 
and Dialer was lost. 

Configured line group is not active on the server. 

Call ID attribute not present among contact 
attributes. 

Campaign ID not found among contact attributes. 

An unknown exception occurred. 
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history) are accumulating in queue. 

Contact list updates are accumulating in queue. 

Current abandonment rate exceeds the configured 
strict abandonment rate. 

Dialer Transaction Server is not responding. 

No callable contacts left. 

History updates (campaign stats, agent stats, call 
history) are accumulating in queue. 

Contact list updates are accumulating in queue. 

The database provider in use is not recommended 
for use with Dialer. 

Default database is not specified or UDL file is not 
compatible with Dialer. 

Default database is not specified or the UDL file is 
invalid. 

Campaign is paused because TS API calls are failing, 
likely due to TS Server not running. 

DNC scrubbing failed. 

Policy set contains one or more behaviors 
referencing contact columns not used by the 
campaign. 

Agent has none of the required skills for the 
campaign, so no calls will be placed for the agent. 

Automatic time zone mapping is unavailable 
because the time zone source data could not be 
initialized. 

Automatic time zone mapping source data file is 
not accessible because no CCS dial plan is available 
for phone number standardization. 

Automatic time zone mapping source data file is 
not accessible because the map data set file is 
missing. 

Automatic time zone mapping is unavailable for all 
campaigns because no automatic time zone 
mappings are present. 

Automatic time zone mapping is unavailable 
because no time zone map data sets are configured 
for automatic time zone mapping. 

A Win32 exception occurred. 

Dialer Transaction Server failed to start. 

Dialer Transaction Server is restarting because of 
too many hung threads. 

A COM exception occurred. 

An exception occurred. 

A Notifier request failed. 

Insert or update operation was aborted because 
there was no data to process. 

Data passed in as a date value could not be parsed. 

Warnings were generated while processing a 
database update. 

The ACD workgroup is not active on the server. 

An error occurred while validating a database table. 

A policy set could not be loaded by the campaign 
server. 

A query for the number of remaining contacts 
failed. 

A policy reported an error. 

A connection to the database could not be 
established. 

A SQL operation failed to complete. 

A behavior failed to run properly. 

An event interface object was not found in the 
global interface table. 

An error occurred while attempting to evaluate a 
rule item 

The campaign server was unable to read/write the 
xml configuration file. 

The campaign server management interface pointer 
could not be obtained 

An operation failed because the requested object 
identifier was not found 

The campaign server's request for statistical data 
failed 

The campaign server was unable to commit table 
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An agent has been placed on break because a TS 
API call failed. 

A campaign is reserving a high percentage of active 
agents for non-Dialer calls. 

A campaign is recycling its contact list. 

An agent logged into a campaign with a persistent 
connection, but no persistent connection wav file is 
configured. 

Dialing is being restricted by the configured 
maximum call rate setting. 

A problem occurred while attempting to load the 
configuration XML file. 

  

properties to the configuration file. 

The campaign server has reached the maximum 
number of threads allowed, typically because all 
processing threads are hung. 

Unable to retrieve the number of contacts left in 
the current recycle. 

An error was reported by a rule action. 

An error occurred while trying to load a property. 

An error occurred while looking up the active 
station for an agent. 

Campaign initialization failed while processing 
related properties. 

A database table could not be initialized or 
validated. 

An error status message was deactivated. 

A contact list updated was in an incorrect format. 

A campaign was paused because it exceeded the 
maximum number of errors. 

A campaign was paused because it could not load 
the contact columns. 

An error occurred while attempting to enable 
workgroup period stats. 

A requested action was ignored because the 
associated agent is not logged into the campaign. 

A requested action was ignored because the 
associated agent is not active in the campaign. 

A campaign has been manually paused. 

An interaction could not be found in the dialer 
cache. 

The scheduled date passed in from the script was 
invalid. 

A call was placed and routed to an agent, but not 
completed. 

The campaign will not be started because it is not 
configured as active. 

A contact does not have a callable phone number. 
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No lines available in the line group. 

All campaigns are paused until CPU utilization drops 
below the configured point. 

An agent could not be found in the dialer cache. 

A campaign has stopped because it has completed 
the maximum number of recycles. 

A campaign has entered forced power dialing mode 
because its abandon rate exceeded the maximum 
rate. 

Predictions made for a campaign are paused 
because the number of inbound calls is greater than 
the configured maximum for the workgroup. 

A policy reported a warning. 

A rule action reported a warning. 

A reset or recycle operation for a campaign was 
ignored because the campaign has already 
completed. 

An agent attempted to disposition an interaction 
that he/she does not own. 

A campaign's pace was manually adjusted. 

An agent changed to an available status prior to call 
disposition. 

A warning status message was deactivated. 

A campaign has started. 

Dialer Transaction Server has started. 

A campaign has been manually un-paused. 

All campaign dialing has resumed because CPU 
utilization dropped below the configured maximum. 

A campaign has stopped. 

A contact list has recycled. 

A campaign has exited forced power mode due to 
the abandon rate dropping below the configured 
maximum. 

A campaign has resumed making predictions due to 
the number of inbound calls dropping below the 
configured maximum for the workgroup. 
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A campaign has been manually restarted. 

A policy reported an informational message. 

A rule action reported an informational message. 

One or more database tables were created for a 
campaign. 

A campaign was restarted by a rule. 

A campaign was restarted by a user. 

A campaign was recycled by a rule. 

A campaign was recycled by a user. 

A campaign has stopped because it reached the 
maximum recycle count due to zone blocking. 

An informational status message was deactivated. 

  

Dialer Overview 
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The Dialer overview displays important 
campaign statistics at the top of the screen. 

You can control campaign execution directly 
from this pane in the Dialer Overview. 

Select a row in the top pane for a campaign. 
Then right-click to display a context menu. 

See Campaign Execution Control for more 
information. 

The graph pane displays Dialer stage 
statistics for a time interval (period, shift, 
cycle, campaign) and agent(s) selected. 

The pane in the lower right displays Dialer 
agent statistics, such as the call stage each 
agent is currently in. 

Use it compares the performance of multiple 
agents across sites and campaigns in a 
workflow.  It can display the current activity 
of agents, such as each agent's current 
status, current stage, time in status, and 
time in stage.  

The Interaction Supervisor Help for IC 
Business Manager explains how to work 
with views and alerts. To open this help 
system in IC Business Manager, select 
Interaction Supervisor from the Help menu. 

 

  

Agent Overview 
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The Agent Overview compares the performance of multiple agents across sites and campaigns.  This 
view displays the current activity of agents, such as each agent's current status, current stage, time in 
status, and other Dialer Agent Statistics, such as time in stage. As with most views, you can click a 
column header to sort by that column. 

View Options 

Site 

This control allows you to select agents from a single ODS server, or all sites.  The view is automatically 
updated when you make a selection. 

Campaign 

This control changes the currently monitored campaign.  When clicked, it displays a drop list of 
campaigns to choose from.  The view is automatically updated when you make a selection. 

Shortcut Menu Commands 

Shortcut menu items appear if you right-click a data row in the grid. 

Edit alerts… 

Adds or edits an alert.  An alert notifies when a statistic is in or out of a chosen range, based on 
statistical items or values on the CIC Server.  An active alert can change the color of the display, play a 
wave file, display an icon in your system tray, send electronic mail, or invoke a handler.  

Selecting this shortcut command opens the Edit Alerts dialog, which is customized for the type and 
combination of statistics currently selected. 
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Add/Remove statistics… 

Opens a dialog allowing the selection of statistics in the current view to be changed. 
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Skill Overview 

 
The Skills Overview displays skill summary statistics. This view helps supervisors manage skills-based 
dialing in predictive, power, and preview modes. It displays contacts by Skill Set to indicate which agent 
skills are needed.  As with most views, you can click a column header to sort by that column.  

View Options 

Site 
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This control allows you to select agents from a single ODS server, or all sites.  The view is automatically 
updated when you make a selection. 

Campaign 

This control changes the currently monitored campaign.  When clicked, it displays a drop list of 
campaigns to choose from. The view is automatically updated when you make a selection. 

Shortcut Menu Commands 

Shortcut menu items appear if you right-click a data row in the grid. 

Edit alerts… 

Adds or edits an alert.  An alert notifies when a statistic is in or out of a chosen range, based on 
statistical items or values on the CIC Server.  An active alert can change the color of the display, play a 
wave file, display an icon in your system tray, send electronic mail, or invoke a handler.  

Selecting this shortcut command opens the Edit Alerts dialog, which is customized for the type and 
combination of statistics currently selected. 

 

Add/Remove statistics… 

Opens a dialog allowing the selection of statistics in the current view to be changed. 
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Dialer Real-time Agent Management 

 
Call Center Supervisors can use this view to move agents between campaigns in order to optimize the 
use of available agents. Supervisors can select a campaign, see what agents are logged into the 
campaign, see what agents are available and then log Agents into or out of a campaign. This gives 
Supervisors the ability to alter the agent pool participating in a campaign. 

It is important to keep in mind that if a Supervisor wants to be able to log agents in and out of 
campaigns, the agents themselves cannot have the Logon Campaign right. 

 Note: For more information on the Logon Campaign right, see the Security Rights topic in the 
Interaction Administrator help system. 

Campaign 
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Selects the campaign whose agent participation you want to manage. 

Available Agents 

Lists names of agents and the active campaigns they are currently receiving calls for. 

Logged On Agents 

Lists the names of agents participating in the currently selected campaign. 

Log On 

Logs any agents selected in the Available Agents list into the campaign. 

Log Off 

Logs off any agents selected in the Logged On Agents list out the campaign. 

  

Penetration Rate view 

 
The Penetration Rate view provides details about Dialer penetration rates. 

View Options 

Contact List 

This control allows you to select a contact list to view data about. 

Phone Number column 
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Use this control to select a single column in the contact list that contains phone numbers. You may 
optionally select [All Phone Number Columns] to select all columns designated as storing phone 
numbers. 

Uploads 

Allows selection of penetration rate data for records uploaded to the contact list. If you uploaded 
records to the contact list, you can select from this list. 

Penetration Criteria 

Click Select to open the Penetration Criteria dialog. This dialog allows you to filter the selection of 
penetration rate records based on wrap-up codes, calling modes, and campaign, or report any attempt 
to dial contact records. When you finish making selections, click OK to dismiss the dialog. 

 

Start Date 

Sets a date and time used to select penetration rate records. The drop list down arrow displays a 
calendar. The up and down buttons increment or decrement the day, month, day of month, year, hour, 
minute, or second selected. 

Frequency 

Scopes the frequency of data to hourly, weekly, daily, or monthly intervals. 

Calculation Mode 
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Selects the method used to calculate penetration. Selections include Call List Penetration, Phone 
Number Penetration, Call List Saturation, and Phone Number Saturation. 

Calculation Mode Use Case Formula 

Call List Penetration Ensure all records in a given list 
have been attempted at least 
once. 

Count of Unique Attempts / 
Count of Call List Records 

Maximum Value = 100% 

Phone Number Penetration Ensure at least 1 dialing attempt 
for every phone number on 
every record. 

Count of Unique Phone 
Attempts / count of Phone 
Numbers 

Maximum Value = 100% 

Call List Saturation Show average penetration level 
of records. 500% would indicate 
that each account had been 
attempted 5 times on average. 

Count of Total Call Attempts / 
Count of Call List Records 

  

Maximum Value = None. 

Phone Number Saturation Show average penetration level 
of phone numbers. 500% would 
indicate that each phone 
number had been attempted 5 
times on average. 

Count of Total Call Attempts / 
Count of Phone Numbers 

  

Maximum Value = None. 

Penetration Rate (result) 

Displays penetration data returned by the query. Columns include Time, Penetration count, Total 
Records, and Percentage. 

Related Topics 

Penetration Rate Report Data. 

Phone Number Type Overview 

 
This view displays Phone Number Type summary statistics for the site, campaign and interval selected. 

Site 



Printed Documentation 

127 

Selects the name of the Outbound Dialer server or [All sites]. 

Campaign 

Selects the name of a Campaign. 

Interval 

Selects a statistic collection interval. 

Phone Number Type 

A customer-defined phone number type (home, cell, work, etc.). 

Contacts 

The total number of contacts that have been made to this phone number type. 

Attempts 

The total number of times this phone number type has been attempted. 

Stage Overview 

 
This view displays overview statistics for Stages for a specific Dialer campaign, site and agent. See Dialer 
stage statistics. 

Site 

Selects the name of the Outbound Dialer server or [All sites]. 

Campaign 

Selects the name of a Campaign. 

Interval 

 Selects a statistic collection interval. 

Agent 

Selects a single agent or [All Agents] 

Wrap-up Category Chart View 
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This view shows wrap-up category statistics in a chart. Wrap-up categories classify the result of a contact 
attempt. Unlike wrap-up codes, which are user-defined, the same standard wrap-up category codes are 
mapped to all campaigns. 

Site 

Selects the name of the Outbound Dialer server or [All sites]. 

Campaign 

Selects the name of a Campaign. 

Statistic 

Selects a Dialer wrap-up statistic. 

Interval 

Selects a statistic collection interval. 

Wrap-up Code Chart View 

 
This view shows wrap-up code statistics in a chart. Wrap-up codes are strings that indicate the 
completion status of a call step. Wrap-up codes are the disposition options that agents see in a script. 

Site 

Selects the name of the Outbound Dialer server or [All sites]. 

Campaign 

Selects the name of a Campaign. 

Statistic 

Selects a Dialer wrap-up statistic. 

Interval 
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Selects a statistic collection interval. 

Wrap-up Category 

Wrap-up Category Chart View 

How Call Analysis detections affect Abandon Rate 
This topic provides supplemental information about Call Analysis Detections as they affect calculation of 
the Abandon Rate statistics.  The method used to calculate Abandon Rate can directly affect agent idle 
time and the speed of outbound dialing.  The Detections option calculates abandon rate in a way that 
plans for less-than-perfect Call Analysis.  The best way to understand this option is to consider a real-
world scenario. 

Suppose that 250 numbers are dialed, and that 150 of those calls are auto-dispositioned.  The remaining 
100 calls are classified as live people by Call Analysis.   Dialer routes those 100 calls to agents, but 3 of 
those 100 calls are abandoned because there are no available agents to take the call.  Of those 3 
abandoned calls, 2 were actually live people and 1 was really an answering machine. 

The other 97 calls are dispositioned by agents.  Of the 97 dispositioned by agents, 78 calls were actually 
live people and 19 are not live people and are marked as such by agents (17 answering machines, 2 
SITs).  Agents almost always correctly identify a live person versus an answering machine, so their "call 
analysis" is very accurate. 

Using the standard mapping of what is a contact and what is not (as configured in Interaction 
Administrator), the number of contacts is 81 (78 plus the 3 abandoned calls,  since System HangUp is a 
WrapUp Category).  In this case the abandoned rate as calculated by Dialer is (3 / 81) * 100 = 3.7%. 

This is not the actual abandon rate, since Call Analysis is not perfect.  If it were perfect, no answering 
machines would go to agents or get abandoned.  So, the actual abandon rate is (actual live people 
abandoned / actual live people detected) or (2 / 78) * 100 = 2.6%. 

Poor call analysis at a Dialer site affects abandon rate, since the number of contacts decreases while the 
possibility of an abandoned call from calls routed stays the same.  This can cause contact rate to 
decrease and abandon rate to increase, leading to slower dialing and more agent idle time. 

To alleviate this situation, use the "Based on Detections" option to make the "best effort" calculation 
possible with current technology.  This approach considers that the system thought that 100 calls were 
live people, and 3 of those system-detected live people were abandoned.  It recognizes that the system 
has no way to know that 1 of those 3 system-detected live people that were abandoned was really an 
answering machine.  Therefore, due to a computer's less-than-perfect ability to detect live people, the 
best calculation of abandon rate in Dialer would be: 

(system-calculated abandons / system-detected live people) * 100 

or 

(3 / 100) * 100 = 3%. 

The Detections calculation returns a value (3%) that is lower than the abandon rate that would normally 
be calculated by Dialer (3.7%), and which is closer to a perfectly calculated abandon rate (2.6%) which 
cannot be determined, due to less-than-perfect ability to detect live people.  

Interaction Director category 
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Interaction Director category 

Interaction Director is a CIC application that allows multi-site contact centers to become a single virtual 
operation. Interaction Director communicates with registered CIC server in real-time, to gather data that 
is relevant to queues, users, workgroups, skills, and so on. Director uses this data to make routing 
decisions. It balances loads by intelligently routing multimedia interactions between CIC servers. 

Icon View Details Appearance 

 

Enterprise Group Details 

Shows service level, abandon 
and queue statistics about an 
Enterprise Group. 

 

 

Interserver Routes 

Shows routes on a monitored 
server used to place inter-server 
calls between CIC servers. 

 

Related Topics 

Select Enterprise Group dialog 

Select Enterprise Group Statistics dialog 

Interserver Routes – Select Server dialog 

Enterprise Group Details view 
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Interaction Director makes intelligent routing decisions that helps balance loads across CIC sites, meet 
service goals, and increase customer satisfaction.  This view displays service level, abandon and queue 
statistics about an Enterprise Group.  Enterprise Groups are logically related queues that conceptually 
represent the target destination of a routed call.  

Each group is a collection of queues from one or more CIC sites where calls could be routed. For 
example, an Enterprise Group named "Corporate Sales EG" might be comprised of a Sales queue on 
server CIC_Chicago and a Sales queue on server CIC_Atlanta. 

Add this view to the workspace 

1. Select an existing workspace from the Workspaces tab, or create a new workspace to host the view. 

2. Select New > View. The Create New View dialog appears, listing views by category or product. 

3. Select Categories from the Group By drop list.  Then click Interaction Director.  

4. Select Enterprise Group Details View. 

5. Click OK. The Select Enterprise Group dialog appears. 

6. Select an Enterprise Group. Click Finish. 

Expanders in this view 

Enterprise 
Group statistics 

Enterprise Group statistics summarize ACD interactions, such as the number of agents 
logged in, and other particulars that are common to the Enterprise Group as a whole. 
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Combined 
Queue Statistics 

Displays Director agent statistics for interval periods. These statistics summarize the 
activity of call center agents, by reporting the count of interactions received, answered, 
completed, and abandoned, along with average wait time and average talk time. 

Service Level 
Parameters 

Display time and histogram intervals for the service level statistic.  The range of service 
level histogram intervals are cumulated downwards by default. You can include or 
exclude histogram ranges. 

Abandoned Rate 
Parameters 

Displays time and histogram intervals for the abandoned rate statistic. The range of 
abandon rate histogram intervals are cumulated downwards by default.  You can 
include or exclude histogram ranges. 

Change statistics in this view 

1. Right-click in the view to display its shortcut menu. 

2. Choose Add/Remove statistics… 

3. Use the Select Enterprise Group Statistics dialog to select statistics to display in the view. Click 
OK. 

Select cumulative vs. Partial Sum histogram for Service Level or Abandon Rate 
statistics 

 

Click Options on the right side of the expander to select histogram type. 

Think of cumulative distribution as an accumulative bucket for the enterprise group, interaction type 
and time interval (current period, current shift, etc.). An accumulative bucket means that each bucket 
includes the count for all of the preceding buckets. In a partial sum distribution, each bucket count is 
exclusive of any other bucket. 

Set Alerts 

See Manage Alerts. 

Interserver Routes view 
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This view shows routes on a monitored server used to place inter-server calls between CIC servers. 

Add this view to the workspace 

1. Select an existing workspace from the Workspaces tab, or create a new workspace to host the 
view. 

2. Select New > View. The Create New View dialog appears, listing views by category or product. 

3. Select Categories from the Group By drop list.  Then click Interaction Director.  

4. Select Interserver Routes view. 

5. Click OK. The Interserver Routes - Select Server dialog appears. 

6. Select a server. Click Finish. 

Change statistics in this view 

1. Right-click in the view to display its shortcut menu. 

2. Choose Add/Remove statistics… 

3. Use the Select Statistics for Interserver Routes dialog to select statistics to display in the view. 
Click OK. 

Set Alerts 

See Manage Alerts. 

  

Visual controls in Supervisor views 

Visual controls in Supervisor views 
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The visual controls commonly used in Interaction Supervisor views are listed in the table below. 

Control Example 

The Expander control opens or closes a region 
within a view to display or hide information. 

 

Statistic Controls display statistics and 
automatically update the view when the value 
of a statistic changes, when alerts are triggered, 
or when the value of the statistic no longer 
triggers an alert. 

 

Queue controls appear in views that display 
information about lines or queues, to provide 
details about interactions. Queue controls may 
also allow supervisory call actions to be 
performed on a selected item.  

 

Where applicable, Call Action Controls allow a 
supervisor to listen, coach the agent, record an 
interaction, join a conference, and perform 
basic telephony operations. 

 

Chart controls are used in graph views to 
render statistics as column, bar, or line graphs. 

 

Workgroup Directory controls display the status 
of individual workgroup members, such as each 
person's name, time in status, logged in state, 
skills, and so on.  

  

Expander control 
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Expander controls expose or collapse regions of a view. Expanders are often used to categorize 
statistics, which are in turn displayed by statistic controls. The title bar of the control acts as a toggle to 
expand or collapse a screen region. 

Statistic Control 

Statistic Control 
The value of each statistic, and any alerts that have been set, is displayed in its own Statistic Control. In 
the case of charts, statistic controls appear in the legend. Icons for alerts appear in statistic controls too, 
if an alert has been triggered. Statistic controls update when the value of a statistic changes, when alerts 
are triggered, and when the value of the statistic no longer triggers an alert. 

 
Statistic controls display alerts using color coded icons and conspicuous text attributes. Alerts can be 
configured to send e-mail notifications, to play sounds, invoke a handler, or to perform all of those 
actions.  

Suppose that a view has two statistics for which alert conditions have been set. Values would appear on 
statistic controls as shown below: 

 
• Suppose that for Interactions Waiting, an alert was set to notify when 5 or more interactions 

are waiting.  This statistic does not have an alert icon, since the number of Interactions waiting is 
currently zero. 
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• Suppose that two alert conditions have been set for Agents logged in on this workgroup. The 
first triggers when the value is less than 3. The second triggers the alert when the value is 
between 0 and 7.  Since both conditions are true, the statistic control displays icons for both. As 
you can see, an active alert is indicated by a color coded severity icon, and custom text 
attributes. Both of these properties are specified when alert are set. 

An alert condition specifies how the alert is triggered (between two values, exceeds a value, etc.). 
The severity of the alert determines the color of the alert icon. You can select actions to take when 
the alert is triggered, ranging from displaying an icon only, to sending email, or invoking a handler. 
See Manage Alerts. 

Procedures 

View alerts set for a statistic 

Display shortcut menu for a statistic control 

View alerts set for a statistic 
To view alerts set for a statistic 

1. Click an alert icon. 

2. 2.   A window will appear showing each alert and its threshold settings. The red bar indicates the 
current value of the statistic. 
 

 

Related Procedures 

Manage Alerts 

Manage All Alerts at once 

Display shortcut menu for a statistic control 
Each statistic control offers quick access to menu of frequently used commands. To display this shortcut 
menu: 
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1. Right-click the statistic control. The shortcut menu appears. 
 

 
2. Select a command from the menu. The commands are: 

Edit alerts… 

Opens the Add/Edit Alert dialog so that you can manage alert conditions for the statistic. See Manage 
Alerts. 

Remove > Remove entire statistic group 

Removes all statistics in that statistic group from the view. 

Remove > Remove statistic 

Removes the selected statistic from the view. 

Add/Remove statistics… 

Opens a dialog that manages which statistics appear in the view, for the type of statistics supported by 
the view. 

Help 

Displays a help definition of the statistic. Click Close to dismiss this dialog when you finish reading the 
help text. You can also display help for a statistic by holding the mouse pointer over the statistic control 
until pop-up text is displayed. The help text is the same, regardless of method used to display it. 

 

Queue Control 

Queue Control 
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About Queue Controls 

Queue controls appear in views that display information about lines or queues.  Queue controls provide 
details about current interactions and may allow supervisory actions to be performed on a selected 
item. 

If there are no current interactions in the queue, "This queue is currently empty" is displayed in the first 
row. 

For descriptions of each column in a queue control, see Queue Columns. Security settings apply to 
Queue controls. Security rights determine which buttons are shown. ACL rights control which buttons in 
the queue control toolbar are enabled. See Licenses, Security and Access Control Rights for details. 

Look up an employee photo and office location 

Your CIC administrator can enable a queue control shortcut menu option that will display an employee's 
photo and office location. If your CIC administrator chose to implement this feature, you do not need 
any additional licensing or user rights to use it. 

To view a person's photo and office location: 

1. Right-click any contact in an Agent Overview, Queues, Workgroup Details, or Workgroup Directory 
view. The photo of the person appears in the context menu: 
 

 
2. Select Office Location from the context menu to display a map or diagram indicating office 

location.  This menu option does not appear unless your administrator configured CIC to support 
this feature. 
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The graphic for Office Location can be anything your administrator draws to indicate a locale. In most 
cases an office floor plan is displayed. 

Sort Columns 

To change the sort order, click on a column heading to sort by that column. 

Resize Column Width 

To resize a column, drag the edge of a column heading left or right to narrow or widen the column. 
Column headers remain visible, even when there are no interactions to display. Customers can still 
adjust columns for personal preferences. 

Rearrange Columns 

To change the order of columns, drag and drop a column heading to a new location. 

Call Action Controls 

Where applicable, a Call Action control below the queue control allows a supervisor to select a queue 
object, and then listen, coach the agent, record the conversation, join a conference, or perform basic 
telephony operations. 

Related Topics 

Interaction Analyzer Columns in Queue Controls 

Interaction Analyzer Columns in Queue Controls 
If the CIC server has feature licenses for Interaction Analyzer and Interaction Recorder present, two 
additional columns appear in Supervisor views that contain Queue Controls (such as a Workgroup 
Details view, for example). These columns tally the number of keywords spotted by Interaction Analyzer, 
as it independently scores agent and customer channels during a conversation recorded by Interaction 
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Recorder. If the mouse pointer is held briefly over a column, column details for that channel appear in a 
popup. 

 
Supervisor differentiates between unanalyzed interactions and analyzed interactions with zero score, for 
Analyzer keyword score aggregate statistics.  No score indicates that the interaction is not being 
analyzed and a score of 0 indicates that the interaction is being analyzed but has not accumulated a 
score at this time. 

• The Agent Score column displays positive and negative totals for the agent channel of the 
conversation. Positive totals indicate that one or more positively scored Keywords were 
detected. Negative totals indicate that the agent spoke undesirable keywords that were 
negatively scored. 

• The Customer Score column displays similar totals, but for the customer channel of the 
conversation. 

These columns display the number of recognized keywords and the combined positive and negative 
score for all words recognized.  They also display an icon representing positive/negative/neutral 
combined score.  The tooltip on each column displays the last positive/negative/keyword spotted during 
the current interaction. The column values are updated as keywords are recognized. 

How Interaction Analyzer Scoring is set up 

1. Interaction Analyzer Keywords Sets are defined in Interaction Administrator to define words 
and phrases that Interaction Analyzer should listen for. At this time, keywords are weighted with 
positive or negative values for each channel—the agent or customer side of the conversation. 
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2. Next, Keyword Sets are assigned to a Workgroup configuration in Interaction Administrator. 

Keyword Sets can be assigned to the customer channel, agent channel, or both. 
 

 
3. When recorded conversations are replayed, Interaction Analyzer keyword hits appear as 

markers below the waveform. Clicking on a marker plays back that portion of the clip, so that 
Administrators can easy review what was said at detected points in the conversation. 
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 For more information about Interaction Analyzer configuration, see the discussion of the Interaction 
Analyzer container in Interaction Administrator Help. 

  

Call Action Control 

 
The Call Action control often appears below a queue control so that the supervisor can select a queue 
object, and then listen, coach the agent, record the conversation, join a conference, or perform basic 
telephony operations. 

Each button in the Call Action Control toolbar performs a telephony action on selections in the currently 
displayed queue. If an action cannot be performed, its button appears shaded. Whether or not a toolbar 
action is available is controlled by the Security and ACL rights configured in Interaction Administrator. 

Pickup Answers the current interaction, or takes the interaction off hold. 

Disconnect    Disconnects the selected interactions. 

Transfer Transfers the interaction to another user. 

Join Adds the Supervisor user to a call on any user or station queue that the manager has 
permission to monitor. Both the agent and the customer can hear the manager's side of 
the conversation. When the Join feature is used, Interaction Supervisor creates a 
conference call between the agent, the connected party, and the Supervisor user. 

Listen Listens in on a call. For example, you can listen to a caller leaving a voice mail message, to 
a conversation between two parties, or to a conference call. The parties being listened to 
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may not be aware that someone is listening to the call. 

Genesys disclaims any responsibility for end-user or licensee to comply with federal or 
state law restrictions regarding Record or Listen capabilities of CIC software. The licensee 
hereby warrants and represents that the end-user or licensee will use the product in 
compliance with any federal or state law. 

Coach Adds yourself to an agent's call on any user or station queue you have permission to 
monitor. This enables you to provide advice to the agent without the customer knowing 
that you are assisting on the call. The agent can hear your side of the conversation, but 
the customer cannot. 

  This feature is especially helpful to supervisors who are training new agents, monitoring 
employee customer service performance, or simply providing assistance with a customer 
call. 

  If the agent presses the Mute button while you are coaching the agent, the customer no 
longer hears the agent but the agent can continue to converse with you. The Mute button 
does not affect the audio between the agent and the coach. 

  You must have permission to use the Coach feature and you must have permission to 
monitor queues. If you have questions about your rights and permissions, see your 
Interaction Center administrator. 

  The Coach button is shaded if the call is not in a state in which this action can be 
performed. 

Record Records the currently selected call. This recording is saved as a .wav file. Clicking Record 
the first time starts the recording session for a call. Clicking Record again stops the 
recording session for a call. 

  You can press the Record button more than once to stop or continue recording your call. 
The CIC client stores each part of the recorded conversation in separate .wav files, and 
sends them to you in e-mail message attachments after you end the call. 

  The Record button appears shaded if the call is not in a state in which this action can be 
performed or if you do not have rights to record calls. Contact your CIC administrator if 
you need security rights to use this feature. 

  Genesys disclaims any responsibility for end-user or licensee to comply with federal or 
state law restrictions regarding Record or Listen capabilities of CIC software. The licensee 
hereby warrants and represents that the end-user or licensee will use the product in 
compliance with any federal or state law. 

Pause Pauses recording. Click Pause again to resume recording. 

Snip Creates a recording snippet. To have snip capabilities, your administrator must configure 
your user account with the appropriate rights and licenses in Interaction Administrator. 
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For more information, see the Interaction Recorder and Interaction Quality Manager 
Technical Reference in the PureConnect Documentation Library and the Interaction 
Administrator Help. 

Private Prevents other users from recording or listening to a conversation. Use of the Private 
feature may be subject to your company's policies and should only be used in accordance 
with those policies. CIC handler customization can be used to track the use of the Private 
feature to ensure compliance with such policies. 

Assistance The assistance request feature allows a CIC client user to request help for an interaction 
from an Interaction Supervisor user monitoring a queue. The Supervisor user can view 
information about each request, such as the problem description.  The Supervisors can 
then accept or ignore the assistance request. See Manage Assistance Requests for more 
information. 

Note: Both Interaction Connect and Interaction Desktop support assistance requests. 

 Note 
 
Workgroup supervisors are configured in Interaction Administrator. Also, supervisors receive 
assistance requests only if they are running Interaction Supervisor. They do not receive assistance 
requests if they are running only a CIC client. 
 
In order for the request assistance process to work properly, at least one supervisor must be 
configured for your workgroup in Interaction Administrator on the Roles/Supervisor tab and at least 
one supervisor for your workgroup must be logged in. 

Chart Control 

Chart Control 

Summary 

Chart controls are used by graph views to render statistics as column, bar, or line graphs. The graph 
portion of the chart presents the relation between different system statistics selected by the user for 
comparison. The optional legend displays statistic values and active alerts. 
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Customize a Chart 

Right-click the chart control to display a shortcut menu of customization commands: 

Edit Alerts… Opens the Edit Alert dialog so that you can change the parameters of alerts. This menu 
option is only enabled when the shortcut menu is opened by right-clicking on a statistic in 
the legend. 

Add/Remove… Opens statistic and parameter selection dialogs used by the view. 

Chart options… Opens the Chart Options dialog, so that you can change the general appearance of the 
graph. The items you can modify include the graph title, legend, and axis range information 
in the graph. 

Show Labels Toggles display of labels in the graph section. 

Graph type 

  

Displays a sub menu with the following options: 

• Column graph: Displays a vertically oriented graph 
• Bar graph: Displays a horizontally oriented graph 
• Line graph (5 minutes): Displays a marquee type line graph which spans 5 minutes 
• Line graph (30 minutes): Displays a marquee type line graph which spans 30 

minutes 
• Line graph (4 hours): Displays a marquee type line graph which spans 4 hours 
• Line graph (8 hours): Displays a marquee type line graph which spans 8 hours 
• Line graph (24 hours): Displays a marquee type line graph which spans 24 hours 

Group By Changes the axis used to display the chart. For example, a System Graph view allows 
grouping by workgroup or statistic. When grouped by statistic, the example chart looks like 



Chart Options dialog 

146 

this: 

 

Legend Opens a submenu for setting options relating to the Legend section of the view: 

• Show legend: Display/hide the legend 
• Show values in legend: Show/hide the values in the legend 
• Bottom: Position the legend on the bottom of the graph 
• Left: Position the legend on the left of the graph 
• Right: Position the legend on the right of graph 

 
For more information about Chart control customization options, see Chart Options dialog. 

Chart Options dialog 

 
The Chart Options dialog customizes the appearance of a chart control. To open this dialog from a graph 
view, select Chart Options… after right-clicking a chart control to display its shortcut menu. 

The Chart Options dialog has three tab pages: 

1. General options set graph type, axis range, time interval for line graphs, background color, and 
the color of both the grid and labels. 

2. Title options manage the title displayed on the graph. The title can be set to a custom value, and 
the font, size and color of the text can be changed. These settings are not persisted if the user 
closes and re-opens a new graph view. 

3. Legend options determine whether or not the legend section appears below the graph. The 
position of the legend relative to the graph can also be changed, with the option to show or hide 
statistic values in the legend. These settings are not persisted if the user closes and re-opens a 
new graph view. 
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 Important—changes to chart settings are displayed immediately in the view, but do not become 
permanent until you close the Chart Options dialog by clicking OK. 

Chart Options Dialog – General page 

Options on the General page sets graph type, time interval for line graphs, background color, and the 
color of both the grid and labels. The customizations you can apply on this page are: 

Change the Graph type Click the Line graph, Column graph, or Bar graph button. 

To make zero values easier to distinguish, bar and column charts have a 3D effect 
applied. 

 

Column graphs display values as a vertical column of color. 
Column graphs are updated every time a value changes on 
the server. 

 

Bar graphs display values as a horizontal column. Bar graphs 
are updated every time a value changes on the server. 

 

Line graphs display the values across time in a marquee type 
rolling display. Line graph are updated regularly depending 
on the total time displayed in the graph. If the user changes a 
line graph to a column or bar graph, the graph continues to 
accumulate and display values. This offers the opportunity to 
return to the line graph later to see its line history. 

Change the time interval for a 
line graph 

Select a period from the Line graph period drop list. This option is available for line 
graphs only. Periods range from 5 minutes to 24 hours. 

  

Change maximum value 
displayed on the Axis 

  

For column and bar graphs, axis range changes the maximum value displayed on 
the axis. These settings are not persisted if the user closes and re-opens a new 
graph view. Select Auto scale to use the default range, or enter and maximum axis 
value. 

Change background color Click Background color control to open a menu of default colors. 
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Select a default color or click More colors… to select custom colors from a 
secondary Colors dialog that allows selection of Standard Windows colors, or any 
combination selected using a slider control. To apply a custom color selection, click 
OK. 

 

Change grid and label color Click the Grid and label color control. Its color selection options work identically to 
the Background color control. 

  

Hide Labels To hide labels in the graph section, uncheck the Show labels check box. 

  

Group by Changes the axis used to display the chart. For example, a System Graph view 
allows grouping by workgroup or statistic. 

Chart Options dialog – Title page 

Title options manage the title displayed on the graph. The title can be set to a custom value, and the 
font, size and color of the text can be changed. These settings are not persisted if the user closes and re-
opens a new graph view. The customizations you can apply on this page are: 

Show or hide graph 
title 

To show or hide the title, check or uncheck the Show Title box. Checking this box 
enables other title options on this page. 
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Change the graph title When Title Type is Default, the chart title is based on its type, and the text is 
Column Graph, Bar Graph, or Line Graph. If you select Custom you can type your 
own title text in the Custom Title box.  

  

Change title font Select a new font from the Font drop list. 

  

Change title size Select a new font size from the Size drop list. 

  

Change title color Click the Color control to open a menu of default colors. 

 
Select a default color or click More colors… to select custom colors from a 
secondary Colors dialog that allows selection of Standard Windows colors, or 
any combination selected using a slider control. To apply a custom color 
selection, click OK. 

Chart Options dialog – Legend page 

The Legend page determines whether or not the legend section appears below the graph. The position 
of the legend relative to the graph can also be changed, with the option to show or hide statistic values 
in the legend. These settings re not persisted if the user closes and re-opens a new graph view. The 
customizations you can apply on this page are: 

Show or hide the 
Legend 

Legends are displayed by default. To hide the entire legend section of the graph, 
check the Show legend box. 

  

Show or hide statistic 
values 

The value of each statistic is shown in the legend by default. To remove values 
from the legend, uncheck the Show values in legend box. 

  

Reposition the Legend 
left, below, or to the 
right of the chart 

Three Placement buttons determine where the legend appears relative to the 
graph. Click the button that is left, below, or right of the chart graphic. 
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Related Views 

Agent Graph view 

System Graph view 

Workgroup Graph view 

Workgroup Directory control 

Workgroup Directory control 

 
Workgroup Directory controls display the status of individual workgroup members, such as each 
person's name, time in status, logged in state, skills, and so on.  

Add or Remove Columns 

You can modify the selection of columns displayed by right-clicking a column heading to open a shortcut 
menu.  

Standard columns The standard columns are Name, First Name, Last Name, Company, Department, 
Extension, Skills, Business Phone, Home Phone, and Mobile. 

Status columns Status-related columns in the Status Columns submenu are: Status, Status Notes, 
Until, Forward Number, On Phone, Logged In, Time in Status, Status Summary or 
Activated. 

Other columns The Other Columns submenu adds columns for properties of a member entry, 
such as Business Address, Business City, Assistant, Skills, and so on.  See also: 
Directory Properties dialog. 

Filter Columns 

To filter for specific values, text in boxes above each column. 

Sort Columns 

To change sort order, click on a column heading to sort by that column. 

Resize Column Width 

To resize a column, drag the edge of a column heading left or right to narrow or widen the column. 
Column headers remain visible, even when there are no interactions to display. Customers can still 
adjust columns for personal preferences. 
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Rearrange Columns 

To change the order of columns, drag and drop a column heading to a new location. 

View Skills 

The Skills column displays skills owned by each user and with workgroup skills. If the Skills column is not 
displayed, right-click a column heading and select Other Columns > Skills from the shortcut menu. The 
Skills column makes it easy to identify persons who have a specific skill. 

The Skills column displays skills associated with each agent. Multiple skills are delimited by commas. 
Skills belonging to the user's workgroups appear first, followed by the skills of the user.  If sorting by 
skills, standard alphabetical order on the entire content of the skill field is used. 

 

A right click context menu item (Display Skill Set) displays 
the entire list of skills, their proficiency and the desire to 
use them. If a user has the same skill in two different 
workgroups with different proficiency and desire to use, 
they will both appear in the user skills dialog box. 

Filter capability is provided. If you type a filter string at the 
top of the column, only the agents with the filtered skill 
will appear.  The filter is case independent.  When the 
directory is paged, the filtering is done by the server, 
otherwise it is done locally. 

Skills display is dynamic in the contact directory list and 
static in the user list skills dialog box.  

Display a User's Skills, Desire to Use, and Proficiency 

To view a person's skills, desire to use and proficiency: 
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1. Right-click a user row in the directory. 

2. Then select Display skill set. Information about the users' skills is displayed in the Skills List 
dialog. 

Skills List dialog 

 
The Skills List dialog displays skills associated with a workgroup user, along with the proficiency and 
desire to use each skill. To display this dialog, right click a user row in a Workgroup Directory control. 
Then select Display skill set. 
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If a user has the same skill in 2 different workgroups with different proficiency and desire to use, 
they will both appear in this dialog. 

Skill 

A skill defines an ability that individual agents may or may not have, such as special training or 
certification, expertise with a particular product, or the ability to speak a foreign language. Skills are 
defined in Interaction Administrator, by expanding the People container and then selecting the Skills 
view. See Interaction Administrator Help for more details. 

Proficiency 

Proficiency indicates overall ability to apply the skill, expressed as a number between 1 and 100. Higher 
numbers indicate greater proficiency. 

Desire to use 

Desire to Use is also a number between 0 and 100, that indicates how willing the user or workgroup is to 
use the skill.  For example, all agents may have a high level of proficiency with a particular skill (such as 
technical support) but may have very little desire to use that skill in an ACD environment.  Higher 
numbers indicate greater desire to use a skill. 

Close 

Dismisses the dialog. 

Full Screen and Slide Show Modes 

IC Business Manager provides two View menu commands that work well with Supervisor views: 

View > Full Screen Mode maximizes the application window while hiding menus and toolbars unless the 
mouse pointer is positioned over the area of the screen where menus are normally displayed. To exit 
Full Screen Mode, position the mouse pointer at the top of the window to reveal menus. Then click the 
Full Screen button. 

View > Show Slide Show cycles between views in the current workspace every 8 seconds. This marquee 
mode is useful for monitoring multiple views without docking them adjacent to one another. To exit 
Slide Show mode, position the mouse pointer at the top of the window to reveal menus. Then click the 
Show Slide Show button. 

Using the Listen to Queue feature 

The Listen to Queue feature provides the means to continuously listen to a line, station, user or 
workgroup queue. When you begin listening, Supervisor initiates a queue watch that automatically picks 
up the next longest call in the queue. 

The "Listen to Queue" feature is also called "Queue Monitor". Hence an 'active queue monitor' means "a 
queue that is currently being listened to by this feature". 

To invoke this feature, select Listen to queue from the Tools menu, or choose Listen to queue from 
the context menu associated with a list of queues. 
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You may also invoke this feature by clicking the status bar at the bottom right of a queue view: 
 

 
 
The Listen to Queue dialog appears when invoked using any of these methods. 

The Listen to Queue dialog 

 
Selecting the Listen to Queue command opens a dialog that allows for selection of Queue Type and 
Queue name. By default, no listening takes place until selections are made, and the Start Listening 
button is pressed. 

When this dialog is invoked from the status bar, and the active view is a queue view, that view's queue 
type and name are pre-selected. 

Queue Type 

Selects a collection of interactions related to a line, user, station or workgroup queue. 
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Queue 

Displays names of queues of the selected type. 

Start Listening button 

Initiates a queue watch that automatically picks up the next longest call in the queue. 

• If there are no calls in a queue, the algorithm exits without starting a listen, but new interactions 
in the queue will be picked up automatically. The Listen to queue dialog displays this informative 
text: 

• There are currently no calls on this queue. Listen will start when calls appear on the queue. 

• If the queue contains more than one connected interaction, the oldest interaction that had not 
been listened to is selected. 

• To prevent one supervisor listening to the same interaction more than once, those supervisors 
that listened to an interaction are stored in a custom attribute. 

Once listening begins, the Listen to queue dialog offers additional functionality. It displays which queue 
is being monitored and which call is currently listened to.  You can copy these details to the clipboard, 
display additional information (properties about the interaction), or skip to the next call to listen to. 

 
Here's how the Listen to queue dialog appears when listening to a call. As you can see, it is used to start 
and stop listening to a queue, including the selection of the queue. 

 
When listening in in effect, the status shown in the status bar shows: 
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• The queue being monitored 

• The call being listened to (if any) 

• The state of the monitoring (not monitoring, monitoring, paused because of call on user's 
queue) 

• The status bar can be clicked open the Listen to queue dialog 

Manage Alerts 

Manage Alerts 

Alerts enhance Interaction Supervisor's ability to report real-time information. An alert notifies when a 
statistic enters a user-defined threshold, is within bounds, or is no longer within a range of values.  

Alerts for telephone calls can be based on calls longer than a specific duration, average hold time 
greater than a given value, and many other metrics. Moreover, alerts can be set for any statistic in 
Supervisor. For example, an IT administrator can set an alert that notifies when server disk space falls 
below a minimum threshold. 

 
Alerts can be displayed in Supervisor using color coded icons and text attributes to highlight a metric. 
Alerts can optionally send email notifications, play sounds, or invoke a handler.  

A statistic can have multiple alert conditions, each with its own alert action and notification options.  For 
example, an alert can have a condition that warns when a non-critical threshold is reached, and another 
that sends email notifications when critical conditions exist. 

Alert-Related Procedures Alert-Related Dialogs 

Add an Alert Add/Edit Alert dialog 

Add/Edit Alert Condition dialog 

Add/Edit Alert Action dialog 

Edit Alert Font Color dialog 

Play a sound on Alert dialog 

Send an Email on Alert dialog 

Current Active Alerts dialog 

Manage Alerts dialog 

Edit an Alert 

Delete an Alert 

View Active Alerts command 

Manage all alerts at once 

  

Add an Alert 

Configuring Interaction Supervisor to set an alert provides notification when a particular metric enters, 
is within bounds, or is no longer within a user-defined range of values.  Alerts can be displayed in 
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Supervisor using color coded icons and text attributes to highlight a metric. Alerts can optionally send 
email notifications, play sounds, or invoke a handler.  

To set an alert for any statistic: 

1. Right-click a statistic control in the view. Then select Edit Alerts… from the shortcut menu. The 
Add/Edit Alert dialog appears.  The dialog allows you to choose a statistic and any parameters 
that apply to it. 

 
2. Optionally select a different statistic to base the alert on, by selecting from the Statistic drop 

list. 

3. Fill in statistic parameters as needed. The appearance of the Add/Edit Alert dialog varies, since 
statistics use parameters to quantify what the statistic displays information about. For example, 
a statistic for Longest Talk Time has three parameters: workgroup, agent, and period interval 
(such as current shift). In this case, parameters scope the Longest Talk Time statistic to a 
particular agent, workgroup queue, and time frame. Other statistics require different 
parameters. 
 
Since the dialog prompts for parameters relating to the statistic selected, so you will see 
different parameters listed under Statistic Parameters. These should be self-explanatory. You 
may be prompted to select a workgroup, for example. 

4. Click Add to establish the alert. 

5. The Add/Edit Alert Condition dialog appears. The appearance of this dialog, available alert 
conditions, and criteria you must supply to quantify the condition, is based on the data type of 
the statistic. Therefore options on the dialog vary. 

a. Select an Alert Condition to evaluate the statistic against. The Alert Conditions column 
in the table below lists alert conditions by statistic data type. The Criteria you must 
supply column lists criteria you must supply to configure an alert for each possible 
condition. 
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Type of Statistic Alert Conditions Criteria you must supply 

Boolean statistics The value is 'True', 'Yes', '1' or similar No criteria are required by Boolean alert 
conditions 

The value is 'False', 'No', '0' or similar 

Has a value 

Not set 

Numerical statistics 

(integer, double and percent) 

Trigger alert when value is less than 
the maximum 

Maximum value 

Trigger alert when value is between 
the minimum and the maximum 

Minimum and Maximum values 

Trigger alert when value is larger 
than the minimum 

Minimum value 

Has a value No criteria are required by this alert condition 

Not Set No criteria are required by this alert condition 

Timespan statistics 

(Duration, Time Duration, 
Future Duration, Finite 
Duration) 

The value must be less than the 
maximum 

Maximum time value, expressed in days, 
hours, hours, and minutes (ddd:hh:mm:ss) 

The value must fall between a 
minimum and a maximum 

Minimum time value, expressed in hours, 
minutes and seconds (hh:mm:ss) 

Maximum time value, expressed in days, 
hours, hours, and minutes (ddd:hh:mm:ss) 

The value is larger than the 
minimum 

Minimum time value, expressed in hours, 
minutes and seconds (hh:mm:ss) 

Has a value No criteria are required by this alert condition 

Not Set No criteria are required by this alert condition 

String statistics The value is equal to a string Character string 

The value is not equal to a string Character string 

The value contains a substring Character string 
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The value does not contain a 
substring 

Character string 

The value matches a prefix Character string 

The value does not match a regular 
expression 

Any regular expression. 

Has a value No criteria are required by this alert condition 

Not Set No criteria are required by this alert condition 

b. Specify criteria required by the alert condition (see Criteria column in above table). 
Icons next to input fields indicate acceptable ranges and invalid conditions. 
 

 
 
When clicked, the blue icon displays the acceptable range of criterion. If you supply a 
value that is out of range, a red icon is shown. Click on it to find out what is invalid. The 
dialog's "OK" button is disabled when values are out of range. 

c. Optionally select an Alert severity level. This setting colorizes an icon to match 
predefined severity levels. This icon appears in statistic controls when the alert is 
triggered. No icon is shown by default. The severity levels are: 

Normal Minor Major Warning Critical 

  

  

 

6. Click Add. The Add/Edit Alert Action dialog appears. Use it to define actions the alert will 
execute when the alert condition is triggered. 
 

 
 
The actions you can select are: 

• Show the statistic with a different font and colors. When this action is selected, the Edit Alert 
Font Color dialog prompts for text color, background color, and font weight. The statistic 
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control's value field will change to the selected font color, background color and font weight 
when the alert is triggered. 

• Play a sound on the computer that runs Supervisor.  When this action is selected, the Play a 
sound on Alert dialog prompts for sounds to play when the statistic enters the alert condition, 
when its value changes within the condition, and when the value exits the condition. You can 
select sounds by clicking a folder icon, or preview sounds by clicking a speaker icon. 

• Send an email to one or more recipients. When this action is selected, the Send an Email on 
Alert dialog prompts for the names of email recipients, and whether to send emails when the 
statistic enters the alert condition, or exits the condition, or when its value changes within the 
condition. 

• Execute a custom hander. When this action is selected, the Execute a Custom Handler on Alert 
dialog prompts to initiate a handler when the statistic enters or exits the alert condition.   

• Send a client memo to selected recipients. Use this alert action to send an informational 
message, called a client memo, to CIC client users or workgroups. It opens the Client Memo 
dialog, so that you can configure the message, for example to appear in the CIC client as a 
notification along the bottom edge of the client window, or as a desktop alert (toast pop-up). 
For example, a Supervisor user might configure an alert to send a client memo when there are 
too many calls in queue, or when a queue's wait time is too long. Note that client memos can be 
sent directly without configuring an alert—for details, see Manage Client Memos. 

Note: Both Interaction Connect and Interaction Desktop support client memos.  

7. Configure options for the selected action type. 

8. Click OK to dismiss the Edit Alert Action dialog. If the OK button is not enabled, you have not 
completed all required elements in the current dialog. 

9. Optionally repeat steps 5-8 to add additional alert conditions and actions. This makes it possible 
to create an alert that performs more than one action. Actions are listed in the Alert actions 
pane of the Edit Alerts dialog. 
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• To modify actions, double click any existing alert action to reopen the Edit Alert Action 
dialog with the action pre-selected. The only alert action for which this is not true is the 
Alert severity action. To change that selection, you must use the Alert Severity drop 
down. 

• To edit the selected action, click Edit or double-click a condition in the Alert actions list. 

• To remove an action, select it. Then click Remove. You are asked to confirm this 
operation. 

 

10. Click OK to close the Edit Alert Condition dialog. 

11. Click OK again to dismiss the Edit Alert dialog. In the view, an icon for the alert will appear next 
to the statistic. You can click the icon next to the stat to display a window listing all alert 
conditions and actions you have set. To edit these settings, right-click the statistic and select Edit 
Alerts. 

Edit an Alert 
There are several ways to edit an alert. Editing an alert when you want to change alert parameters, 
actions, or the statistic the alert is based on. Once an alert is opened for editing, the Add/Edit Alert 
dialog will appear. See Add an Alert for procedural instructions. 

Note: If you have the Master Administrator right, then you can edit the alerts for another user. 

Shortcut Method 

Most views provide a shortcut menu. Right-click the statistic whose alert you wish to edit. Then choose 
Edit Alerts… from the shortcut menu. In graph views, you must right click the statistic control that 
appears in the legend for the chart. The Add/Edit Alerts dialog will appear. 

 

Edit Alert from the Current Active Alerts dialog 

Alerts can be edited from the Current Active Alerts dialog, which appears when the View Active Alerts 
command is invoked.  
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Select an alert. Then click Edit the current alert. The Add/Edit Alert dialog will appear. 

Edit Alert from the Manage Alerts dialog 

If you are managing all alerts at once, the Manage Alerts dialog is displayed. If necessary, expand an 
alert set. Select the alert. Then click Edit. 

Delete an Alert 
There are several ways to delete an alert. You can use a shortcut menu, delete an alert when the 
Current Active Alerts dialog is open, or delete an alert when the Manage Alerts dialog is open. 

Note: If you have the Master Administrator right, then you can delete the alerts for another user. 

Shortcut Method 

1. Most views provide a shortcut menu. Right-click the statistic whose alert you wish to edit. In 
graph views, you must right click the statistic control that appears in the legend for the chart. 

2. Choose Edit Alerts… from the shortcut menu. The Add/Edit Alerts dialog appears. 
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3. Select the alert to remove by clicking a row below Static Parameters. The click Remove. You are 
asked to confirm removal of the selected alert condition: 
 

 
 
When all alert conditions are removed using this method, the alert is deleted. 

Delete Alert from the Current Active Alerts dialog 

Alerts can be removed using the Current Active Alerts dialog, which appears when the View Active Alerts 
command is invoked.  

 
1. Select an alert. Then click Edit the current alert. The Add/Edit Alert dialog will appear. 

2. Select the alert to remove by clicking a row below Static Parameters. The click Remove. You are 
asked to confirm removal of the selected alert condition: 
 

 

Once all alert conditions are removed using this method, the alert is deleted. 

Delete Alert from the Manage Alerts dialog 

If you are managing all alerts at once, the Manage Alerts dialog is displayed. 

If necessary, expand an alert set to display the alert. 

1. Right-click the Alert. Then choose Remove Alert from the shortcut menu, or select the Alert and 
then click the Remove button. 
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2. Click Yes to confirm removal of the Alert. 
 

 

View Active Alerts command 
To view alerts you have set that are currently active: 

1. Select View Active Alerts from the Tools menu. The Current Active Alerts dialog appears.  It 
displays the statistic each currently active alert is based on, parameters used to set the alert, 
date and time when the alert was received, and the current value of the statistic when the alert 
triggered. 
 

 
2. To edit an alert from this dialog, select an active alert. Then click Edit the current alert. The 

Add/Edit Alert dialog will appear. See also: Edit an Alert. 

3. When you are finished, click Close to dismiss the dialog. 

Manage all alerts at once 
Interaction Supervisor provides a command that helps users administer all of their alerts in one dialog. 
The user can view alerts they have set up, edit, and remove alerts. Users can optionally see all alerts in 
the system, including alerts set by other users. 

To manage all alerts at once: 

1. Select Manage Alerts from the Tools menu.  The Manage Alerts dialog appears. 
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Alerts are organized by alert set. Text entry boxes at the top of the dialog filter the result set, 
allowing alerts in all categories to be filtered down to only those containing a matching search 
string. 

2. To see all alerts in the system, select the Show all alerts in the system check box. 

Note: This option appears only if you have the Master Administrator right, which is configured 
in Interaction Administrator. For more information about security rights, see the Interaction 
Administrator help. 

3. To manage any alert in the list, expand an alert set and select the alert. Then click Add, Edit, or 
Remove. 

Note: You can edit and delete an alert for another user only if you have the Master 
Administrator right. For more information about security rights, see the Interaction 
Administrator help. 

4. When you are finished, click Close to dismiss the dialog. 

Alert-related dialogs 

Alert-related dialogs 
The following dialogs appear when an alert is added, opened for editing, when active alerts are viewed, 
or when all alerts are managed from one dialog. 

Dialog Usage 

Add/Edit Alert dialog Manages multiple alert conditions for a statistic. 

Add/Edit Alert Condition dialog Sets a single alert condition, icon display, and parameters. 

Add/Add an Alert Action dialog Selects the action performed when the alert condition is 
met 

Edit Alert Font Color dialog Configures text attributes of the alert. 
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Play a sound on Alert dialog Configures audio to play for an alert. 

Send an Email on Alert dialog Configures email notifications sent by an alert. 

Execute a Custom Handler on Alert dialog Configures invocation of custom handler by an alert. 

Current Active Alerts dialog Displays list of active alerts set by the current user. 

Manage Alerts dialog Displays all alerts set by the user and optionally all alerts 
set on the system. 

  

Add/Edit Alert dialog 

 
This dialog allows alert conditions to be added for a statistic. The Add/Edit alerts dialog appears when an 
alert is added or edited. The example above shows a statistic that has two alert conditions set. Clicking 
the row for an alert condition enables the Edit button. 

Statistic group 

Selects the statistic group used to categorize similar types of statistics. 
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Statistic 

Selects a statistic within the selected group to base an alert upon. 

Statistic Parameters 

Statistics have parameters that quantify what the statistics displays information about. For example, a 
statistic for Longest Talk Time has three parameters: workgroup, agent, and period interval (such as 
current shift). This configures the statistic to a particular agent, workgroup queue, and time frame. 

Supervisor prompts for parameters that apply to the type of statistic selected. For this reason, you will 
see different parameter prompts in this section of the dialog. 

Alerts list 

Rows in this list correspond to previously set alert conditions. An alert condition specifies how the alert 
is triggered (between two values, exceeds a value, etc.), the severity of the alert, which determines the 
color of the alert icon, and actions to take when the alert is triggered. 

To edit an alert, click on its row to enable the Edit… button. Pressing that button opens the Add/Edit 
Alert Condition dialog. 

Add button 

Opens the Add/Edit Alert Condition dialog to create a new alert condition. 

Edit button 

Opens the Add/Edit Alert Condition dialog to edit a selected alert condition. 

Remove button 

Removes the selected alert condition. 

OK button 

Saves changes and dismisses the dialog. 

Cancel button 

Closes the dialog without saving changes. 

Add/Edit Alert Condition dialog 
The Add/Edit Alert Condition dialog manages an alert condition when an alert is added or edited. The 
appearance of this dialog, available alert conditions, and criteria you must supply to quantify the 
condition, is based on the data type of the statistic. 

Use this dialog box to: 

• Select a condition to evaluate the statistic against. 

• Prompt for criteria required by the condition, such as a maximum value. 

• Assign a severity level to the alert: Normal, Minor, Major, Warning, or Critical. 
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• Prompt to define actions the alert will execute when it is triggered. 

 

1 Selects an Alert Condition which affects the criteria you are asked to supply. 

2 Sets Severity of the alert to Normal, Minor, Major, Warning, or Critical 

3 Lists Actions this alert will perform when triggered 

4 Adds an Action the alert will perform when triggered. 

5 Edits selected Action. 

6 Deletes selected Action. 

To complete this dialog 

1.   Select an Alert Condition. The table below lists alert conditions by statistic data type, and criteria 
you must supply to configure an alert for each possible condition. 

Type of Statistic Alert Conditions Criteria you must supply 

Boolean statistics The value is 'True', 'Yes', '1' or 
similar 

No criteria are required by Boolean alert 
conditions 

The value is 'False', 'No', '0' or 
similar 

Has a value 
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Not set 

Numerical statistics 

(integer, double and 
percent) 

Trigger alert when value is less 
than the maximum 

Maximum value 

Trigger alert when value is 
between the minimum and 
the maximum 

Minimum and Maximum values 

Trigger alert when value is 
larger than the minimum 

Minimum value 

Has a value No criteria are required by this alert condition 

Not Set No criteria are required by this alert condition 

Timespan statistics 

(Duration, Time 
Duration, Future 
Duration, Finite 
Duration) 

The value must be less than 
the maximum 

Maximum time value, expressed in days, hours, 
hours, and minutes (ddd:hh:mm:ss) 

The value must fall between a 
minimum and a maximum 

Minimum time value, expressed in hours, minutes 
and seconds (hh:mm:ss) 

Maximum time value, expressed in days, hours, 
hours, and minutes (ddd:hh:mm:ss) 

The value is larger than the 
minimum 

Minimum time value, expressed in hours, minutes 
and seconds (hh:mm:ss) 

Has a value No criteria are required by this alert condition 

Not Set No criteria are required by this alert condition 

String statistics The value is equal to a string Character string 

The value is not equal to a 
string 

Character string 

The value contains a substring Character string 

The value does not contain a 
substring 

Character string 

The value matches a prefix Character string 
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The value does not match a 
regular expression 

Any regular expression. 

Has a value No criteria are required by this alert condition 

Not Set No criteria are required by this alert condition 

2.   Specify criteria required by the alert condition (see table). Icons next to input fields indicate 
acceptable ranges and invalid conditions. 

 
When clicked, the blue icon displays the acceptable range of criterion. If you supply a value that is out of 
range, a red icon is shown. Click on it to find out what is invalid. The dialog's "OK" button is disabled 
when values are out of range. 

3.   Select an Alert severity level. This setting colorizes an icon to match predefined severity levels. This 
icon appears in statistic controls when the alert is triggered. No icon is shown by default. The severity 
levels are: 

Normal Minor Major Warning Critical 

  

  

 

Buttons on this dialog 

Add… 

Optionally adds an action for the alert to perform when triggered. This opens the Add/Edit Alert Action 
dialog. 

Edit… 

Opens appropriate dialog for editing the selected alert action (font color, play sound, send email, 
execute custom handler, etc.) 

Remove 

Removes the selected alert action. You are prompted to confirm this operation. 

 

OK 
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Saves changes and closes the dialog. 

Cancel 

Closes the dialog without saving changes. 

Add/Edit Alert Action dialog 

 
This dialog selects the action performed when the alert condition is met. 

Select an alert action from this drop down to proceed 

This drop down selects and alert action, and opens a configuration dialog for that type of action. 

• Shows the statistic with a different font and color. When this action is selected, the Edit Alert 
Font Color dialog prompts for text color, background color, and font weight. The statistic 
control's value field will change to the selected font color, background color and font weight 
when the alert is triggered. 

• Play a sound on the computer that runs Supervisor.  When this action is selected, the Play a 
sound on Alert dialog prompts for sounds to play when the statistic enters the alert condition, 
when its value changes within the condition, and when the value exits the condition. You can 
select sounds by clicking a folder icon, or preview sounds by clicking a speaker icon. 

• Send an email to one or more recipients. When this action is selected, the Send an Email on 
Alert dialog prompts for the names of email recipients, and whether to send emails when the 
statistic enters the alert condition, or exits the condition, or when its value changes within the 
condition. 

• Run a custom hander. When this action is selected, the Execute a Custom Hander on Alert 
dialog prompts to initiate a hander when the statistic enters the alert condition, exits the 
condition, when the alert changes, and optionally when its value changes within the condition 
range. Custom handler parameters can be entered in a text box. Depending on the programmed 
action behavior, the handler will be invoked when the condition is met, the value changes while 
the condition is met, or the condition becomes false. 

• Send a client memo to selected recipients.  Use this alert action to send an informational 
message, called a client memo, to CIC client users or workgroups. It opens the Client Memo 
dialog, so that you can configure the message, for example to appear in the CIC client as a 
notification along the bottom edge of the client window, or as a desktop alert (toast pop-up). 
For example, a Supervisor user might configure an alert to send a client memo when there are 
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too many calls in queue, or when a queue's wait time is too long. Note that client memos can be 
sent directly without configuring an alert—for details, see Manage Client Memos.     

  Note: Both Interaction Connect and Interaction Desktop support client memos.  

OK button 

Closes the configuration dialog for the selected alert action. 

Cancel button 

Closes this dialog without configuring an alert action. 

Edit Alert Font Color dialog 

 
Options on this dialog control the appearance of statistic text when the alert is active. The Sample field 
indicates what the text will look like when the alert is triggered. 

Text Color 

Sets the foreground color to display when the alert is active.   

Background Color 

Sets the background color to display when the alert is active.   

Font Weight 

Sets the font weight to Bold, Default, or Normal, to control the appearance of text when the alert is 
active.  

OK button 

Closes the dialog, saving text attributes. 

Cancel button 
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Closes the dialog without saving text attributes. 

Play a sound on Alert dialog 

 
Use this dialog to play sounds when the value of the statistic enters the range of a condition, changes 
within the condition, or exits the range of a condition. For each option, you can type or select the full 
path to a recording, or listen to the sound file. 

Icon Description 

 Indicates that a playback option is not checked and no validation of the audio file was 
performed. 

 Indicates that the path or filename is invalid. 

 Indicates that the audio file is valid. 

 

Opens a File selection dialog. Use to navigate to an audio file instead of typing its full path 
manually. 

 

Plays the selected audio file. 

Plays a sound when entering the condition 

Check to play a wave audio file when the value of the statistic enters the range defined for the alert.  

Play a sound while alert condition is within range 
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Check to play a sound when the alert is within range of the condition, and its value changes within that 
range. 

Plays sound when exiting the condition 

Check to play audio when the value of the statistic exits the range defined for the alert.  

OK button 

Closes the dialog and puts alert properties into effect. 

Cancel button 

Closes the dialog without setting alert properties. 

Send an Email on Alert dialog 

 
This dialog configures an alert to send Email messages. Messages can be sent when the value of the 
statistic enters or exits the range of the alert condition, or when parameters of the alert are changed by 
someone else. Here's an example e-mail message sent by an alert. 

Event : Range Exited 
Statistic : Time in status 
Statistic Parameters: 

• Workgroup = Development 

• Status = At Lunch 

Value : N/A 
Lower Range : 0s 
Upper Range : 1m 55.0s 
Server: INDYDEVIC2 
Owned By: John Doe 
Alert ID: 27015460-5018-456e-a68d-e7c16426d18f 

Send an email on entering the condition 

Sends an Email when the value of the statistic enters the condition defined for the alert. 
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Send an email on exiting the condition 

Sends an Email when the value of the statistic exits the condition defined for the alert. 

Send an email when the statistic value changes within the condition range 

Sends an Email every time that a value within the range of the alert changes. Use this option carefully, 
since it can potentially generate many messages. 

Email recipients 

Type one or more or more email addresses in this field, separated by semicolons. 

OK button 

Closes the dialog and puts alert properties into effect. 

Cancel button 

Closes the dialog without setting alert properties. 

Execute a Custom Handler on Alert dialog 

 
This dialog configures an alert to execute a handler when the alert condition is entered, exited, when 
statistics change within the range of the condition, or when someone reconfigures the alert itself.  Use 
the StatAlertServer initiator to define the custom handler. For more information about the 
StatAlertServer initiator, see Designer help in the PureConnect Documentation Library. 

Initiate handler on entering the condition 

Initiates a handler when the statistic enters the range specified by the alert condition. "Entering" the 
condition is independent from which direction it approaches the alert range. 

Initiate handler on exiting the condition 

Initiates a handler when the alert condition is no longer met. "Exiting" the condition is independent from 
which direction the statistic leaves the alert range. 
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User data passed to handler 

An optional string passed as a parameter to the handler. 

OK button 

Closes the dialog and puts alert properties into effect. 

Cancel button 

Closes the dialog without setting alert properties. 

Client Memo dialog 
The Client Memo dialog composes a message to send from Interaction Supervisor to CIC client 
users. Messages can be addressed to any combination of workgroups or agents. A Client Memo is not an 
email message. A client memo appears in a CIC client as a notification along the bottom edge of the 
client window, or as a desktop alert (toast pop-up). See Manage Client Memos for more information. 

Note:  Both Interaction Connect and Interaction Desktop support client memos.  

Supervisor users can send client memos in two ways: 

• By creating an alert with a client memo action. The memo is sent when the alert is in range. . 

• Using the Client Memo Management dialog, opened using the Tools > Client Memos command. 
Once the memo is added, it is sent immediately. See Manually create Client Memo. 

• The appearance of the Client Memo dialog varies depending upon the method used to configure 
the message: 
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Appearance when client memo is configured as an 
alert action. 

Appearance when composed from the Client Memo 
Management dialog. 

Controls 

Alert Action drop list (Client Memo Alerts only) 

When client memos are configured as alert actions, the dialog offers a drop list that allows the user to 
select a different action: 

 

Memo Name 

Text field used to name this memo. The description typed here is listed in the Client Memo 
Management dialog to help identify the memo when it is listed with other memos. 
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To… 

Click this button to address the memo to any combination of Users and Workgroups. It opens the Select 
Client Memo Recipients dialog. 

Memo details 

The text typed here will be displayed to recipients in the CIC clients. 

Expires at 

Expiration options appear in the dialog only if the memo is composed from the Client Memo 
Management dialog. When checked, users can set a date and time when the message will automatically 
expire, meaning that it is automatically removed from the CIC clients. 

Send As drop list 

Selects the manner in which the message will be displayed in the CIC clients; either as a desktop alert 
(pop-up) or as a scrolling notification along the bottom edge of the client window.  

• If the memo is sent as a notification, it is displayed at the bottom of the CIC client window. 
Messages move into the notification area by rotating in from the bottom while the current 
message rotates out the top.  To allow time for the user to read the message, there is a pause of 
several seconds between the time the message is fully rotated in and the time it begins cycling 
to the next message. 
 

 
• If the memo is sent as a desktop alert, it appears in the CIC client as a pop-up window 

(sometimes called toast) in the lower right–hand corner of the Windows desktop. Desktop alerts 
remain on screen until the user closes them or the Supervisor removes them. 

 

Sound 

When checked, allows selection of warning, information, or error sounds to play when the memo is 
displayed in the CIC clients. You can optionally click the speaker icon to preview the selected sound.  

Icon 

Selects an icon to display with a desktop alert message.  When this option is checked, you can browse 
the Resources folder on the CIC server for icon files. 

URL 

Check this box when you want the message to send a URL to the recipient.  It enables the URL field so 
that a URL may be typed in. 



Printed Documentation 

179 

OK button 

When composing an alert, this button closes the dialog, returning control to the Add/Edit Alert 
Condition dialog. The message will not be sent until the alert triggers. When composing a memo using 
the Client Memo Management dialog, the message is sent immediately. 

Cancel Button 

Closes the Client Memo dialog, discarding changes. 

Current Active Alerts dialog 

 
The Current Active Alerts dialog displays a list of your active alerts. It displays the statistic each 
currently active alert is based on, parameters used to set the alert, date and time when the alert was 
received, and the current value of the statistic when the alert triggered. 

Open this dialog 

Pull down the Tools menu. Then select View Active Alerts. See also View Active Alerts command. 

Edit an alert 

Select an alert. Then click Edit the current alert. The Add/Edit Alert dialog will appear. 

Dismiss the dialog 

Click Close to dismiss the dialog. 

Manage Alerts dialog 
Use the Manage Alerts dialog to manage all of your alerts at once. To open this dialog, choose Manage 
Alerts from the Tools menu. It lists alerts you have set up, and optionally, all alerts in the system set by 
other users.  You can add a new alert for any statistic, and optionally edit and remove your alerts.  When 
the Manage Alerts dialog opens, alerts are displayed in a collapsed tree fashion instead of an expanded 
tree initially. 

Filter options 

Alerts are organized by alert set. The columns in the list are sortable, but are not configurable.  You 
cannot add or remove columns. To sort a column, click on its column name. 
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To filter the result set, type in text boxes at the top of the dialog. This filters down alerts in all categories 
to only those containing a matching search string. 

Add New Alert 

To add a new alert, click Add. See Add an Alert for procedural help. 

Edit an Alert 

If necessary, expand an alert set. Then select the alert. Click Edit. See Edit an Alert for procedural help. 

Delete an Alert 

1. If necessary, expand an alert set before selecting an alert. Click Remove. 
 

 
2. Click Yes to confirm the operation. The alert is removed. 

Users cannot remove their default alert set. If you select your owner default alert set and click 
Remove, it has no noticeable effect. 

Show all alerts in the system 

Note: Only CIC master administrators can see all alerts in the system. If you are not a master 
administrator, then the Show all alerts in the system check box does not appear. 

To display all alerts in the system, including alerts set by other users: 

1. Check Show all alerts in the system. You are asked to confirm this operation, because it 
introduces performance overhead. 
 

 
 Note: The Show all alerts in the system check box is only available when the user is configured 
as a master administrator in Interaction Administrator. 

2. Click Yes to proceed. Alerts for all users are displayed. Note that the Edit and Remove buttons 
are disabled. You cannot modify or remove alerts set by other users. 
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Dismiss the dialog 

When you are finished, click Close to dismiss the Manage Alerts dialog. 

Manage Assistance Requests 

Manage Assistance Requests 

The Assistance Request feature in Interaction Supervisor and the CIC clients is used by agents to contact 
a Supervisor for help on an interaction. Assistance requests initiate a chat between an ACD agent and 
one or more supervisors with regard to a particular interaction on the agent's queue. 

Note: Both Interaction Connect and Interaction Desktop support assistance requests. 

New requests generate notifications displayed to persons who are currently running Interaction 
Supervisor and who are supervisors of the workgroup that the interaction is on. Each workgroup 
supervisor can choose whether to respond to individual requests. When a supervisor responds to a chat, 
the supervisor can exchange textual messages with the agent, and optionally use call action controls to 
listen, coach, join, record, pause, pickup, or disconnect interactions. 

• There can only be one assistance request for an interaction at any given time. 

• The user may request assistance multiple times for the same interaction as long as any prior 
requests are completed prior to beginning a new request. 

Supervisors receive assistance notifications only if they are running Interaction Supervisor in IC Business 
Manager. They do not receive assistance notifications if they are running only a CIC client. In order for 
the request assistance process to work properly, at least one supervisor must be configured for a 
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workgroup in Interaction Administrator, and at least one supervisor for the workgroup must be logged 
in. 

Assistance requests from an agent's perspective 

In a CIC Client, an agent requests assistance as follows: 

1. The agent selects a call or web chat in the CIC client's My Interactions list, and then clicks the 
Assistance button. Alternately, the agent can right-click the interaction and choose Request 
Assistance from a shortcut menu. The Request Assistance dialog appears. 
 

 
The Assistance button may or may not be available in Interaction Client, depending on security 
rights assigned in Interaction Administrator. To see this button, the Assistance Interaction 
Command right must be selected for the agent's workgroup, role, or user record. To enable this 
button, the Request Assistance from Supervisors right must also be assigned. Even with these 
rights, the Assistance button is enabled only for ACD-routed interactions. The button appears 
shaded if the interaction is not in a state in which the action can be performed. 

2. The agent types a brief explanation of why he needs assistance from a supervisor. 
 

 
3. The agent clicks Send. Afterward the agent can monitor the status of the request in the Request 

Assistance dialog to see if a workgroup supervisor will assist with the interaction. 
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Assistance Requests from a supervisor's perspective 

1. When an agent initiates an assistance request, the workgroup supervisor receives a toast 
notification in Interaction Supervisor. The toast notification closes automatically if another 
supervisor responds to the request. 
 

 
 
At this time, the status bar is also updated to show the current number of assistance requests 
for all workgroup queues this supervisor supervises. 
 

 
 
Supervisors should check the number of assistance requests in the status bar immediately after 
logging in. If there are active requests, the supervisor can select View Assistance Requests from 
the Tools menu to manage requests using the Agent Assistance dialog. Toast notifications are 
not displayed for requests sent while the supervisor was logged out, to prevent a supervisor 
from receiving an undesirable number of toast notifications. There is also a 30 second time out 
on the toast notifications. If a supervisor does not respond within that time frame, the toast 
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notification will be removed and the supervisor will need to use the View Assistance Requests 
option from the Tools menu. 

2. The supervisor responds to the notification by clicking a link: 

• Respond opens the Respond to Assistance Request dialog, to give immediate assistance and 
feedback to the user.  The supervisor can text chat with the agent, and use call action controls to 
listen, coach, join, record, pause, pickup, or disconnect the interaction. 

• Ignore disregards the message and dismisses the assistant request toast. 

• Manage Assistance Requests opens the Agent Assistance dialog, which displays all assistance 
requests for workgroups the supervisor has responsibility for. The supervisor can select a 
request to answer, and assist multiple agents at the same time. 

Respond to Assistance Request dialog 
The Agent Assistance dialog is used when supervisors are assisting an agent. 

 
The top pane displays a list of message between the agent and the supervisor. Supervisors can send text 
messages to the agent by typing into a text box and clicking Send.  Call action controls allow the 
supervisor to listen, coach, join, record, pause, pickup, or disconnect the interaction. 

Listen Listens in on a call. For example, you can listen to a caller leaving a voice mail 
message, to a conversation between two parties, or to a conference call. The parties 
being listened to may not be aware that someone is listening to the call. 

Genesys disclaims any responsibility for end-user or licensee to comply with federal 
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or state law restrictions regarding Record or Listen capabilities of CIC software. The 
licensee hereby warrants and represents that the end-user or licensee will use the 
product in compliance with any federal or state law. 

Coach Adds yourself to an agent's call on any user or station queue you have permission to 
monitor. This enables you to provide advice to the agent without the customer 
knowing that you are assisting on the call. The agent can hear your side of the 
conversation, but the customer cannot. 

This feature is especially helpful to supervisors who are training new agents, 
monitoring employee customer service performance, or simply providing assistance 
with a customer call. 

If the agent presses the Mute button while you are coaching the agent, the customer 
no longer hears the agent but the agent can continue to converse with you. The 
Mute button does not affect the audio between the agent and the coach. 

You must have permission to use the Coach feature and you must have permission to 
monitor queues. If you have questions about your rights and permissions, see your 
Interaction Center administrator. 

The Coach button is shaded if the call is not in a state in which this action can be 
performed. 

Join Adds the supervisor user to a call on any user or station queue that the manager has 
permission to monitor. Both the agent and the customer can hear the manager's side 
of the conversation. When the Join feature is used, Interaction Supervisor creates a 
conference call between the agent, the connected party, and the Supervisor user. 

Record Records the currently selected call. This recording is saved as a .wav file. Clicking 
Record the first time starts the recording session for a call. Clicking Record again 
stops the recording session for a call. 

You can press the Record button more than once to stop or continue recording your 
call. The CIC client stores each part of the recorded conversation in separate .wav 
files, and sends them to you in e-mail message attachments after you end the call. 

The Record button appears shaded if the call is not in a state in which this action can 
be performed or if you do not have rights to record calls. Contact your CIC 
administrator if you need security rights to use this feature. 

Genesys disclaims any responsibility for end-user or licensee to comply with federal 
or state law restrictions regarding Record or Listen capabilities of CIC software. The 
licensee hereby warrants and represents that the end-user or licensee will use the 
product in compliance with any federal or state law. 

Record Records the currently selected call. This recording is saved as a .wav file. Clicking 
Record the first time starts the recording session for a call. Clicking Record again 
stops the recording session for a call. 

You can press the Record button more than once to stop or continue recording your 
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call. The system stores each part of the recorded conversation in separate .wav files, 
and sends them to you in e-mail message attachments after you end the call. 

The Record button appears shaded if the call is not in a state in which this action can 
be performed or if you do not have rights to record calls. Contact your CIC 
administrator if you need security rights to use this feature. 

Genesys disclaims any responsibility for end-user or licensee to comply with federal 
or state law restrictions regarding Record or Listen capabilities of CIC software. The 
licensee hereby warrants and represents that the end-user or licensee will use the 
product in compliance with any federal or state law. 

Pause Pauses recording. Click Pause again to resume recording. 

Pickup Answers the current interaction, or takes the interaction off hold. 

Disconnect Disconnects the selected interaction. 

  

  Note: Both Interaction Connect and Interaction Desktop support client memos.  

Agent Assistance dialog 
The Agent Assistance dialog manages assistance requests in one place. It displays assistance requests 
from agents in workgroups that the supervisor is responsible for, along with the name of the agent, 
interaction details, problem description, and if it is being answered. 

 
This dialog is displayed when a supervisor selects View Assistant Requests from the Tools menu. It also 
appears when a supervisor responds to an assistance request toast notification, by clicking the Manage 
Assistance Requests link. 
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Group By 

When multiple requests are in queue, this drop list organizes items by Workgroup or by 
Responses.  When organized by Workgroup, requests from the same workgroup appear share 
expander. 

 
When grouped by Responses, the expander organizes request by the number of responses. In the 
example below, there are two requests when a supervisor has not responded to. 

 

Ignore button 
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Ignores an assistance request. If another supervisor is available, the request remains open until all 
available Supervisors have ignored or responded. 

Respond button 

Opens the Respond to Assistance Request dialog, allowing the Supervisor to chat with the agent, or 
perform operations on the interaction, such as coaching or recording. 

Help button 

The help button opens this help topic. 

Manage Client Memos 

Manage Client Memos 

A Client Memo is a message sent from Interaction Supervisor to CIC client users. When Client Memos 
are sent, the Supervisor user can control the manner in which a message is displayed in the CIC clients; 
either as a desktop alert (pop-up) or as a scrolling notification along the bottom edge of the client 
window.  

Note: Both Interaction Connect and Interaction Desktop support client memos. 

Client memos are client messaging features that help Supervisor users keep agents and workgroups 
informed. 

For example, a Supervisor user might configure an alert to send a client memo when there are too many 
calls in queue, or when a queue's wait time is too long. Such a message might tell agents: "Hurry up and 
finish your calls. The queue is backing up!" 

• If the memo is sent as a notification, it is displayed at the bottom of the Interaction Client 
window. Messages move into the notification area by rotating in from the bottom while the 
current message rotates out the top.  To allow time for the user to read the message, there is a 
pause of several seconds between the time the message is fully rotated in and the time it begins 
cycling to the next message. 
 

 
• If the memo is sent as a desktop alert, it appears in the CIC client as a pop-up window 

(sometimes called toast) in the lower right–hand corner of the Windows desktop. Desktop alerts 
remain on screen until the user closes them or the Supervisor removes them. 
 

 

How Client Memos are configured and sent 

Supervisor users can send client memos in two ways: 
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• By creating an alert with a client memo action. The memo is sent when the alert is in range. See 
Add an Alert. 

• Using the Client Memo Management dialog, opened using the Tools > Client Memos command. 
Once the memo is added, it is sent immediately. See Manually create and send a Client Memo. 

Procedures 

Manually create and send a Client Memo 

Edit a Client Memo 

Remove a Client Memo not set to expire 

Manually create and send a Client Memo 
Note: Both Interaction Connect and Interaction Desktop support client memos. 

To manually create and send a client memo: 

1. Select View client memos from the Tools menu. The Client Memo Management dialog appears, 
listing all client memos. 

2. Click Add. The Client Memo dialog appears. Use it to compose a message to CIC client users. 

3. Click OK. The message is sent immediately. 

Edit a Client Memo 
To edit a memo listed in the Client Memo Management dialog: 

1. Select Client Memos from the Tools menu. The Client Memo Management dialog appears. This 
menu option is visible only when the default or a custom workspace is active. 

2. Select a client memo. 
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3. Click Edit. The memo is opened for editing in the Client Memo dialog. 
 

 
4. Modify options as needed. Click OK when finished. 

Remove a Client Memo not set to expire 
Once a client memo is manually created, it will either expire or will remain in the list of client memos 
until the supervisor removes it. 

Note: You cannot remove a client memo that is associated with an alert set. 

To remove a client memo: 

1. Select View client memos from the Tools menu. The Client Memo Management dialog appears. 

2. Select an item in the list. 

3. Click Remove. 

4. Click Yes to confirm the operation. 
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Client Memo Management dialog 

 
This management dialog allows Supervisor users to add, edit, or remove any client memo. When 
creating a memo, the supervisor adds recipients to that it will be sent to.  The memo is given a name 
and message to send.  The memo can optionally contain an expiration, URL, icon, and/or play a sound. 

Once added, the memo is sent immediately to each member of the recipient list. It will either expire or 
will remain until the supervisor removes the memo. 

This dialog appears when the Tools > Client Memos command is selected. 

Controls 

The dialog lists client memos that have been created. The columns are: 

Name 

Descriptive name assigned to the memo. 

Message Text 

Body text of the message. 

Expiration 

Indicates the date and time when the memo will automatically expire, or "Never Expires" if automatic 
expiration was not used. 

Owner 

Name of the person who created the memo. 

Add button 
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Manually creates and sends a new client memo. 

Edit button 

Opens the selected memo for editing in the Client Memo dialog. 

Remove 

Removes the selected client memo. 

Close 

Dismisses this dialog. 

Select Client Memo Recipients dialog 

 
This dialog selects recipients who will receive a client memo. 

Users tab 

Displays list of persons who can be added to the Selected Recipients list. 

Workgroup tab 

Displays workgroups that can be added to the Selected Recipients list. 
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Add button 

Adds selected persons or workgroups to the Selected Recipients list. 

Add all button 

Adds all users or workgroups to the Selected Recipients list. 

Remove button 

Removes Selected Recipients so that they will not receive this client memo message. 

Remove all button 

Clears all entries from the Selected Recipients list. 

OK button 

Saves selections and dismisses the dialog. 

Cancel button 

Closes the dialog without saving selections. 

Related Topics 

Manage Client Memos 

Add an Alert 

Add/Edit Alert Action dialog 

Client Memo Dialog 

Client Memo Management dialog 

Manage Notifications 

Application modules in IC Business Manager can display notifications to the user.  To view notifications, 
pull down the Tools menu, and then select Notifications. The Notifications dialog appears.  This feature 
is documented elsewhere. See Understanding Notifications in the IC Business Manager Getting Started 
Help. 

 
The Notifications dialog. 
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Dialogs 

Dialogs 

This reference section describes commonly used wizards and dialogs in Interaction Supervisor. 
Elsewhere in the documentation, procedures link to topics here, to provide reference information about 
elements of the user interface that Supervisor displays in multiple contexts. If you press F1 for help, 
control may be passed to a topic in this section. 

For example, you can set many types of alert conditions in Interaction Supervisor, but the dialog that 
configures an Alert Action is the same for all alert types. Rather than re-describe that dialog in every 
procedure that explains how to set an alert, a single reference topic is provided. When you follow a link 
to a reference topic, you can return to your point of origin by clicking the Back button. 

Please note that modules in IC Business Manager have limited awareness of procedural context when 
help is called. The application framework can associate a help topic with each dialog or control, but it 
does not know the circumstance in which you are using that control, or the data displayed by it. For this 
reason some help topics are generic by necessity. 

Where possible, we have linked reference topics to procedures, to make it easier to locate help for tasks 
associated with GUI elements. 

Controls used in Views 

See Visual controls in Supervisor views. 

See Using the Listen to Queue feature. 

Dialogs used when setting Alerts 

See Alert-Related Dialogs. 

Activation Dialogs 

Manage Workgroup Activations 

Manage User Activations 

Assistance Requests 

Agent Assistance dialog 

Manage Assistance Requests 

Respond to Assistance Request dialog 

Details about an interaction 

Interaction Details dialog 

Interaction Properties dialog 

Parameter Selection Wizards and Dialogs   

Agent Details Wizard 
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Agent Selection dialog 

Change User Status dialog 

Directory Properties dialog 

Interaction Feedback Statistics 

Interaction Feedback Wizard 

Interval and Queue Statistic Selection dialog 

Module Management dialog 

Queue Columns Selection dialog 

Real Time Adherence Wizard 

Statistic Help dialog 

System Statistics Selection dialog 

Transfer dialog 

Workgroup Directory Options dialog 

Workgroup Statistics and Queue Statistics dialog 

Workgroup Statistics dialog 

Workgroup Statistics Selection dialog 

Workgroups Selection dialog 

Interaction Director 

Select Enterprise Group dialog 

Select Enterprise Group Statistics dialog 

Interserver Routes - Select Server dialog 

Select Statistics for Interserver Routes dialog 

Agent Details Wizard 
The Agent Details wizard appears when an Agent Details view is added. This wizard prompts to select an 
agent and workgroup to summarize details for. 

Select Agent page 
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Use the first page of the Agent Details wizard to select the agent whose statistics will appear in the view. 
Only agents that are members of at least one workgroup are shown in this list.  

To complete this page of the wizard: 

1. Select the name of an agent. You may need to type the name in the Filter box. When more than 20 
agents exist in the system, only the first 20 are shown, and an indicator ( ) informs that more 
agent names are available. In that case, typing part of an agent's name in the Filter box locates the 
correct agent. When 20 or less agents exist in the system, the filter is not shown. 

 
Once you select an agent, his or her name appears in the Agent box under Selected Parameters. 
This helps verify the current selection. Note that Workgroup appears in that section. Workgroups 
are selected on the next wizard page. 
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2.   Click Next to Proceed. The Select Workgroup page appears. 

Select Workgroup page 

The second page of the Agent Details wizard prompts whether to select statistics for a single workgroup, 
or for the agent's activity in all workgroups. 

1. Click to select a workgroup by name, or select [All] for all workgroups this agent is a member of. 
Optionally use the Filter box to locate specific workgroups by typing starting characters of the 
name. 

 
2. The workgroup name (or [All]) appears in the Workgroup box under Selected Parameters. This 

helps verify your selection. 

3. Click Finish to Proceed. The Agent Details view appears. 

Agent Selection dialog 
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This dialog selects agents to include as criterion for a view. The list on the left shows available agents. 
The list on the right displays agents selected for inclusion in the view. 

Add button 

Adds available agents to the list of selected agents. 

Add all button 

Adds all available agents to the list of selected agents. 

Remove button 

Removes selected agent names from the list on the right. 

Remove all button 

Clears the list of selected agents. 

Move up button 

Modifies the display order of agents in the view. Higher items in the list the more leftmost in the view. 

Move down button 
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Modifies the display order of agents in the view. Lower position in the list is more rightmost in the view. 

Related Topics 

Agent Overview view 

Agent Graph view 

Change User Status dialog 

 

Summary 

This dialog is used to modify a user's status from the workgroup view, by right clicking on the agents 
name and selecting Change Status for {User Name} from the shortcut menu.  To use this dialog, the 
Supervisor user must have the "Change Status" access control right for the selected user. 

Required Rights 

This feature is subject to access restrictions. In order for a Supervisor user to set another user's status, 
the Supervisor user must have one of the following permission assigned in Interaction Administrator: 

• Modify Workgroup Queue permissions. This allows the user to modify any user status within the 
Workgroup Details View. 

• Modify User Queue permissions. This option restricts access on a per-user queue basis. 

Controls 

Status selector 

Displays a list of user status identifiers. If you select an unavailable status condition, the Until Date and 
Until Time options are enabled, allowing you to control precisely the agent will become available again. 

The Status Filtering feature in CIC 3.0 (and later) allows system administrators to create custom statuses 
for select groups of users.  This means that persons with different roles can have different status 
selections to choose from. 
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For example, a company can provide its business users with one set of statuses, and assign a different 
set to workgroup agents. Statuses are defined and assigned to Workgroups and Roles in Interaction 
Administrator. 

Consequently, the statuses that appear in Interaction Supervisor are scoped to each user. This means 
that different status choices may appear when Supervisor is used to change a user's status, or to set 
"Time in Status" alerts. 

Status Notes 

Text field used to collect supplemental information about the status condition. If a Supervisor user does 
not have the "Status Notes" security right configured in Interaction Administrator, the "Status Notes" 
text box is hidden. 

Forward Number 

Prompts for a telephone number when status is set to Available, Forward. 

Until Date 

Date when user will be returned to Available status. 

Until Time 

Time when user will be returned to Available status. 

Related Topics 

Workgroup Details view 

Workgroup Directory view 

Directory Properties dialog 

 
This dialog displays personal information about directory member. The several tabs of the Properties 
dialog box can contain: 
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• Name, title, department and company 

• Home, business, cell phone, pager and fax numbers 

• Home and business street addresses 

• Home and business e-mail addresses 

• Business web site address 

• Assistant's name and phone number 

• Notes 

Related Topics 

Workgroup Details view (See Formatting Options command) 

Interaction Properties dialog 
The Interaction Properties dialog is often used to add notes to an interaction or to view an interaction's 
log. It is also used to assign account codes and wrap-up codes to interactions. 

When a user drills down into a statistic that has one or more interactions, the Attributes tab displays all 
attributes for which the user has rights. For example, users can drill down into longest interactions 
statistics in a System Status view to examine the interactions responsible for the longest interaction 
statistic.  The drill down feature not only works for the 'Longest' statistics, but for all statistics that have 
one or more interactions as drill down information. 

This dialog is opened from the Agent or Workgroup Queue view by selecting Properties from the context 
menu for an interaction. Subject to access rights and license restrictions, this dialog offers call control 
buttons (pickup, hold, etc.) 

Notes tab 
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Use the Notes tab to add notes to an interaction, or to assign account codes and wrap-up codes to an 
interaction. 

• Account codes organize interactions by customer. You may find this feature useful for customer 
billing purposes, or if you process interactions through Interaction Center for more than one 
company. CIC can generate reports to categorize call details by account codes. 

• Wrap-up codes indicate the nature of an interaction; for example, a billing problem, a new 
order, or a service request. CIC can generate reports that categorize call details by wrap-up 
codes. Your CIC administrator can associate wrap-up codes with any workgroup queue.  You 
must be a member of a workgroup for which wrap-up codes are configured in order to assign a 
wrap-up code. If you have questions about your wrap-up code permissions, contact your CIC 
system administrator. 

Log tab 
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Use the Log tab to view an interaction's log, or to assign account codes and wrap-up codes to an 
interaction. 

Attributes tab 
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When the user has drilled down into a statistic that has associated interactions, the Attributes tab 
displays all attributes for which the user has rights to view. 

  

Interserver Routes - Select Server dialog 
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This dialog selects an CIC to display routes for when an Interserver Routes view is added. 

Filter box 

Selects a subset of server names in the list based on user input of a partial or full server name. 

Server list 

Names of servers in the Enterprise Group.  

Help button 

Opens this help topic. 

Finish button 

Displays view for the server selected. 

Cancel button 

Closes the dialog and cancels the new view. 

Interval and Queue Statistic Selection dialog 
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This dialog selects which time intervals and queue statistics appear in a view. 

Interval frame 

Options in this frame manage time periods to report in the view. The list on the left contains items that 
are not currently included in the view. The list on the right contains items selected to include in the 
view. Select items in the list on the left. Then click Add to move them to the other list, to include them in 
the view. Add All selects all items for inclusion. You can change the display order of columns in the view 
using Move Up and Move Down buttons. To exclude periods from the view, select items in the list on 
the right. Then click Remove. The Remove All button excludes all time periods from the view, but at 
least one has to be included. 

Queue Statistics frame 

Options in this frame manage statistics to report in the view. The list on the left contains items that are 
not currently included in the view. The list on the right contains items selected to include in the view. 
Select items in the list on the left. Then click Add to move them to the other list, to include them in the 
view. Add All selects all items for inclusion. You can change the display order of rows in the view using 
Move Up and Move Down buttons. To exclude statistics from the view, select items in the list on the 
right. Then click Remove. The Remove All button excludes all statistics from the view, but at least one 
has to be included. 

Related Topics 

Agent Details view 

Agent Graph view 

Agent Overview 
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Workgroup Overview view 

  

Module Management dialog 

 
The Module Management dialog appears when Module Management is selected from this Tools menu. 
This dialog lists installed application modules, whether they are enabled, and whether a license has 
been acquired allowing usage. See Licenses, Security and Access Control Rights for more information. 

Module 

Name of application module. 

Status 

Indicates whether or not the module is enabled by Access Control Right. 

License 

Indicates whether or not a license to use the module was acquired. 

Description 

Provides a general indication of module functionality. 

OK button 

Dismisses the dialog. 

Queue Columns Selection dialog 

Queue Columns Selection dialog 
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Use the Queue Columns Selection dialog to select queue columns to display in a view, and to optionally 
set their order of appearance in a view.   

Columns list 

Columns selected for inclusion in the view appear at the top (above a dividing line) with check marks 
next to column name. The list below the dividing line contains columns that can be included in the view 
by checking boxes. When a column is checked, it is moved to the top section, and vice versa. 

To change column order, select a checked item. Then click Move Up or Move Down. The higher an item 
is in the list, the more left most it will appear in the view. 

Move Up button 

Moves a selected column up in the list, so that appears more left most in the view. 

Move Down button 

Moves a selected column down in the list, so that appears more right most in the view. 

Show button 

Moves a selected column to the top list, checking it for inclusion in the view. 
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Hide button 

Moves a selected column to the bottom list, unchecking it for exclusion from the view. 

OK button 

Applies changes made to column selection and order before dismissing the dialog. 

Cancel button 

Dismisses the dialog without applying changes to column selection or display order. 

Queue Columns 

Queue Columns 
Queue Columns are columns that appear in views that display information about lines or queues. The 
table below shows available Queue columns sorted alphabetically: 

Queue Column Description 

Account Code The account code assigned to the interaction based on the Eic_AccountCode attribute, if 
your organization uses account codes. 

ACD Wait 
Reason 

This column gives the reason a call is waiting in queue, which is useful information for 
contact center managers. The following reasons can be given by the system: 

No Available Agent 

No Agent with necessary Utilization (so already too busy) 

No Agent with the correct Media Type 

No Agent with correct ACD Category 

No Agent with required Skills 

No Agent with required Proficiency Level 

No Agent with required Desire to Use 

Agent Score The Agent Score column displays positive and negative totals for the agent channel of 
the conversation. Positive totals indicate that one or more positively scored Keywords 
were detected. Negative totals indicate that the agent spoke undesirable keywords that 
were negatively scored. 

Associated 
Process 

The name of the process with which this interaction is associated. This is a feature of 
Interaction Process Automation. 

Attachments Details of attachments associated with the interaction, where applicable. The 
attachments column shows an icon indicating that an attachment exists on an email 
interaction, or blank if no attachments exist. This information is available in the Details 
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column but is included here to enable sorting, should the user desire that. 

Chat Response 
Time 

This column shows a counter that shows how much time has elapsed since the last time 
the chat had text entered into it by anybody involved in the chat. 

Customer 
Score 

The Customer Score column displays similar totals, but for the customer channel of the 
conversation. 

Details Details about the interaction, if the interaction type provides details.  For example, a call 
interaction might display "To: Genesys". This column displays context-specific 
information based on the interaction type. For calls, it shows the Remote Address 
(phone number). For callbacks, it shows the subject of the callback. For e-mails it shows 
the e-mail subject. For chats, it shows the name of the user who last typed, and the text 
they entered.  

Duration Length of time that the interaction has been in effect, based on Eic_InitiationTime and 
Eic_DeallocationTime attributes. 

Importance The importance column shows an icon indicating whether an email is high or low 
importance, and is blank for "normal" importance. This information is available in the 
Details column but is included here to enable sorting, should the user desire that. 

Interaction Id A system-assigned number that uniquely identifies the interaction object, based on the 
Eic_CallId attribute. 

Line Name of the line that this interaction is on, based on the Eic_LineName attribute.  In 
some views the name is prefixed by an icon that indicates the state of the object (see 
below). 

Lstns Lstns is an abbreviation for "Listens". Displays a speaker icon in this column if Supervisor 
is monitoring the interaction, based on analysis of Eic_Monitors and Eic_MonitorsSupv 
attributes. 

Name Descriptive name of the interaction, based on Eic_CallDirection and Eic_RemoteName 
attributes. 

Number Telephone number of an interaction member based on Eic_RemoteId. 

Process Id Identifer of the process with which this interaction is associated. This is a feature of 
Interaction Process Automation. 

Queue The icon in this column indicates the general state of the queue object, based on the 
Eic_AssignedDistributionQueue attribute.  See Queue States for information about icons 
that appear in this column. 

Recs Recs is an abbreviation for "Recording". Displays a red icon in this column if Supervisor is 
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recording the Interaction.  Note that when screen activity is being recorded, the Recs 
column does not display a red circle to indicate that a recording is in progress, since 
screen activity is not technically an interaction. When an interaction (such as a call) is 
recorded, the icon is displayed. 

Security This column indicates whether a call is secure; specifically, whether or not TLS/SRTP is 
implemented on the line. Interaction Center call security prevents others from listening 
in on a call or even determining which internal parties are involved in a conversation. 
This applies to station-to-station calls, IVR sessions, or for ACD routed calls. It provides 
flexibility and confidentiality for security-sensitive organizations. For background 
information, the help for the CIC clients. 

State This column indicates the state of the interaction. The current condition of an 
interaction in a queue is based on the Eic_State attribute.  See Interaction States for 
information about states that appear by default in the State column.  

Station The station queue where the interaction is currently located based on the 
Eic_StationName attribute. 

Subject The subject of the interaction, if the interaction type provides it. For calls, chats, generic 
objects, and workflows, this is based on the Eic_CallId attribute. For Emails, the 
Eic_Subject attribute is used. For Callback objects, subject is derived from the 
Eic_CallBack attribute. 

Time in 
Workgroup 
Queue 

The amount of time an interaction has been in a workgroup queue.  When the 
interaction is not in a workgroup, the value is an empty string. 

User Name of the user who initiated the interaction, based on the Eic_LocalUserId attribute. 

Work Item 
Category 

This column is available when the user has appropriate licenses and rights to use 
Interaction Process Automation (IPA ) in Interaction Supervisor. It is based on the 
Eic_WorkItemCategory attribute. It applies to a work item in the queue; specifically the 
Work Item Category, which categorizes work items of a particular type. For example, a 
Work Item Category might be "Loan Request".  For more information about IPA, refer to 
the Interaction Process Automation Technical Reference in the PureConnect 
Documentation Library on your CIC server. 

Work Item 
Created On 

Date when work item was initiated. 

Work Item 
Description 

Short description of the work item, based on the Eic_WorkItemDescription attribute. 
This usually indicates what must be done to complete. 

Work Item Due 
Date 

Date when the work item must be completed, based on the Eic_DueDate attribute. 
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Work Item 
Error 

Error condition, if any, associated with work items. 

Wrapup Code The wrap-up code assigned to this interaction, based on the Eic_WrapUpCode attribute. 

Related Topics 

Queue Columns Selection dialog 

Interaction States 

Queue States 

Interaction States 
The current condition of an interaction in a queue is called its interaction state. Interaction State is 
based on the Eic_State attribute. The table below describes each state an interaction may be in during 
the life of the interaction. Your CIC administrator or application developer can modify or customize 
these state strings if desired. States are listed in alphabetical order. 

Interaction State Description 

ACD – Alerting: 
[Agent's Name] 

Seen for inbound calls. CIC places the call into a queue, and sends it to an 
available agent. 

ACD – Assigned: 
[Agent's Name] 

Seen for inbound calls. CIC placed a call into a queue, sent it to an available agent, 
and the agent picked up the call. 

ACD – Wait Agent Seen for inbound calls. CIC placed a call into a queue, but all agents were busy and 
CIC was unable to alert an agent. 

ACD – Wait Agent -> 
Last Attempted: 
[Agent's Name] 

Seen for inbound calls. CIC placed a call into a queue, sent it to an available agent, 
but the agent did not pick up the call and CIC placed it back into the queue. 

Alerting Seen for inbound interactions. A CIC client user is notified that he or she has an 
incoming interaction. 

Connected Seen for both outbound calls and inbound interactions. The interaction is 
connected to a user or a station. If call analysis is not enabled, Connected means 
the same as Proceeding. 

Dialing Seen for outbound calls. CIC dials the outbound proceeding interaction. 

Disconnected Seen for both outbound calls and inbound interactions. The interaction is no 
longer active. 

Disconnected (Local Seen for both outbound and inbound interactions. The interaction was 
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Disconnect) disconnected locally and is no longer active. 

Disconnected 
(Remote Disconnect) 

Seen for both outbound and inbound interactions. The interaction was 
disconnected by the remote party and is no longer active. 

Generic Object 
Waiting 

Seen for inbound interactions. CIC sends a generic object to a user queue, but the 
user is unavailable or not logged in. 

Held Seen for both outbound and inbound interactions. The interaction is on hold. 

Manual Dialing Seen for outbound calls. A telephone handset has been picked up and a dial tone 
is being generated. Calling from the handset will act the same as calling from a CIC 
client when call analysis has not been enabled in the CIC clients. Calling from the 
handset when call analysis has been enabled, will show outgoing calls as 
Connected and will continue to ring until the call is answered. 

Multi-Site Seen on the Lines page for inbound calls. The call is in a multi-site state. 

Offering Seen for inbound interactions. CIC places the interaction in a queue, but the 
interaction is not alerting. CIC determines if the called party is available to take 
the interaction. 

One Number Follow-
Me 

CIC sends an interaction to a user whose status is set to Follow Me, and CIC is 
routing the interaction based on the user's Follow Me settings. 

Operator Escape The user presses zero to reach an operator from any queue. 

Parked The interaction is waiting on a User, Workgroup, or Station queue. 

Pending Disconnect If the system administrator or application developer modifies or customizes a 
Disconnected state strings, this state will appear before the Disconnected state. 
For example, an administrator or developer may modify a handler to direct CIC to 
send a caller to an IVR survey before disconnecting. 

Proceeding Seen for outbound calls. The interaction proceeds through the outside telephone 
network and is waiting to be answered. Proceeding is used if a CIC client user has 
enabled call analysis. Calls Proceeding eventually time out if the call is not 
answered. 

Queue Email 
Alerting: [Agent's 
Name] 

Seen for inbound email interactions. CIC places the email into a queue, and sends 
it to an available agent. 

Queue Email 
Connected: [Agent's 
Name] 

Seen for inbound email interactions. CIC placed an email into a queue, sent it to 
an available agent, and the agent picked up the email. 
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Queue Email Not 
Answered: [Agent's 
Name] 

Seen for inbound email interactions. CIC placed an email into a queue, sent it to 
an available agent, but the agent did not pick up the call and CIC placed it back 
into the queue. 

Queue Timeout Seen for inbound calls. The call waits in a timeout queue and times out. The caller 
is being presented with prompts to determine how he or she wants the CIC client 
to proceed with the call (send to voicemail, try another extension, etc.). 

Remote Transfer CIC sends an interaction to a user whose status is set to Available, Forward, and 
CIC is forwarding the interaction based on the user's call coverage settings. 

Ring No Answer Seen for inbound calls. The call was sent to an agent who did not pick up the call. 
The call timed out, and the caller is being presented with prompts to determine 
how he or she wants the CIC client to proceed with the call (send to voicemail, try 
another extension, etc.). 

System The interaction is interacting with handlers or other components of the CIC 
system. 

Voice Mail The caller is leaving a voicemail message. 

Related Topics 

Queue Columns Selection dialog 

Queue Columns 

Queue States 

Queue States 

Queues have a state condition, which is similar to an interaction's state. Queue state indicates the 
general state of the queue object. In queue controls, icons in the Queue column indicate the state of the 
queue object, based on the Eic_AssignedDistributionQueue attribute.   

  Normal Connected Held Disconnected 

Call 
    

Callback 
    

Chat 
    

Email 
    

Generic Object 
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Instant Question 
    

Related Topics 

Queue Columns 

Interaction States 

Select Enterprise Group dialog 

 
This dialog selects an Interaction Director Enterprise Group to display when an Enterprise Group Details 
view is added. 

Filter box 

Selects a subset of names in the list based on user input of a partial or full Enterprise Group name. 

Enterprise Groups list 
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Names of Enterprise Groups. Enterprise Groups are logically related queues that conceptually represent 
the target destination of a routed call.  

Help button 

Opens this help topic. 

Finish button 

Displays the Enterprise Group Details view for the group selected. 

Cancel button 

Closes the dialog and cancels the new view. 

Select Enterprise Group Statistics dialog 
This dialog has multiple tabs used to select statistics, periods, and histogram intervals for service level 
and abandonment rate. The Add and Remove buttons move a selection from one list to another. Add All 
and Remove All move all items from one list to another. OK applies changes and dismisses the dialog. 
Cancel dismisses the dialog without applying changes. 

Description Tab 

Options on the 
Workgroup Statistics 
tab are used to select 
Enterprise Group 
statistics to include in 
the view. 

Enterprise Group 
statistics summarize 
ACD interactions, such 
as the number of 
agents logged in, and 
other particulars that 
are common to the 
Enterprise Group as a 
whole. 
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Options on the 
Combined Queue 
Statistics tab select 
agent statistics for 
interval periods. 

These statistics 
summarize the activity 
of call center agents, 
by reporting average 
talk time, longest talk 
time, average wait 
time, and other 
particulars that are 
common to a group of 
agents. 

 

Options on the Service 
Level Parameters tab 
select time and 
histogram intervals for 
the service level 
statistic. 

The range of service 
level histogram 
intervals are 
cumulated downwards 
by default. 

You can include or 
exclude any of the 
histogram ranges 
below: 

0-10s 

0-20s 

0-30s 

0-40s 

0-50s 

0-60s 
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Options on the 
Abandoned Rate 
Parameters tab select 
time and histogram 
intervals for the 
abandoned rate 
statistic. 

The range of abandon 
rate histogram 
intervals are 
cumulated downwards 
by default. 

You can include or 
exclude any of the 
histogram ranges 
below: 

0-10s 

0-20s 

0-30s 

0-40s 

0-50s 

0-60s 

 

Related Topics 

Enterprise Group Details view 

Interaction Director category 

Select Statistics for Interserver Routes dialog 
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This dialog selects columns for an Interserver Routes view to display. Available statistics include: 

Statistic Description 

DTMF Wait DTMF Wait interval. 

DTMF Code DTMF digits played to navigate an IVR. 

Calling 
Address 

Calling number of the T1/E1 or ISDN tie line that connects the servers, where applicable. 

Status Status of the monitored server: OK, Destination Down, and so forth. 

From Server Name of originating Director-monitored server. 

To Server Name of destination Director-monitored server. 

Called 
Address 

Called number of the T1/E1 or ISDN tie line that connects the servers, where applicable. 

Successes Total successes. 
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Failures Total failures. 

Unique ID Unique enterprise group identifier. 

Line Group The Line Group that Director should use when it routes calls from this monitored server to 
the server specified in the To Server field. 

ID Method Summarizes signaling sent when a call is routed to the server (Called Address, DTMF, 
Calling Address, and so on). 

Server Unique server identifer. 

Controls on this dialog 
Available Statistics 
list 

The left list contains statistics that can be added to the view. 

Selected Statistics 
list 

The right list shows statistics selected to include in the view. 

Add button Adds selected items to include in the view. 

Add All button Adds all available items to the list of items to include in the view. 

Remove button Removes items from the rightmost list, so that they are not included in the 
view. 

Remove All button Removes all items from the view. 

Move Up button Moves the selected statistic up one row, to change its column order in the 
view. 

Move Down button Moves the selected statistic down one row, to change its column order in the 
view. 

Related Topics 

Interserver Routes view 

Interaction Director category 

Statistic Help dialog 
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This dialog describes a statistic. To display help for a statistic: 

1. Right-click the statistic to display a shortcut menu. 

2. Select Help. The description of the statistic appears. 

3. When you are finished, click Close to dismiss the dialog. 

System Statistics Selection dialog 

 
The System Statistic Selection dialog determines which system statistics appear in a System Graph 
or  System Statistics views. The dialog appears when these views are added or when the Add/Remove 
Statistics command is used to modify the selection of statistics in an existing view. 
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Statistical Categories 

System Statistics are grouped by these statistical categories: 

IC Memory Usage Amount of memory that CIC subsystems are consuming. 

Client Services Resources Number of resources that Client Services has available.  

Email Electronic mail routing activity in CIC. 

Fax Faxing operations in the CIC system. 

Interaction Statistics Current number of interactions by object type on the CIC system, and the 
currently longest interaction. 

Recording Activity in the voice recording sub-system. 

Speech Recognition Activity in the speech recognition subsystem. 

Tracker Server Activity in the Tracker subsystem over the last 10 minute period. 

Transaction Server Activity in the Transaction Server subsystem over the last 10 minute period. 

IC System Status General status of CIC, in terms of number of executing handlers, threads, 
errors, available text-to-speech sessions, and switchover events. 

IC Performance Current health of the system in performance terms. 

Controls on this dialog 

Statistic Category list The leftmost list displays general categories of System Statistics, followed by 
the number of statistics within each category that are selected for inclusion in 
the view. 

Available Statistics list The middle list contains statistics that can be added to the view. 

Selected Statistics list The rightmost list shows statistics for the currently selected category. 

Add button Adds selected items to include in the view. 

Add All button Adds all available items for the category to the list of items to include in the 
view. 

Remove button Removes items from the rightmost list, so that they are not included in the 
view. 
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Remove All button Removes all items in the selected category from the view. 

Move Up button Moves the selected statistic up one row, to change its order in the view. 

Move Down button Moves the selected statistic down one row, to change its order in the view. 

General Procedure 

To determine which statistics appear in a view: 

1. Select a category in the leftmost list. 

2. Select items in the middle list. Then click Add.  If you are not sure which statistics to select, 
briefly rest the mouse pointer over a statistic to display its description. 

3. Optionally modify the display order of selections by clicking the Move Up and Move Down 
buttons. 

4. Repeat steps 1-3 to select statistics from a different category. 

5. When you are finished, click OK to apply selections to the view. 

Transfer dialog 

Transfer dialog 

The Transfer dialog is used to locate and select the recipient of a transferred interaction, using search 
criteria. Once a user is selected, you can easily initiate the transfer by clicking a button. 

 

Caller Name 

You can modify the information in the Caller Name text box to correct the name of the caller or to 
provide additional information such as an account number or a description of the caller's problem. If you 
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then transfer the call to another CIC client user, the newly entered information appears in the recipient's 
My Interactions or other queue list view. 

Use only alphanumeric characters (A-Z, a-z, or 0-9) in the Caller Name text box. Do not use special 
characters such as comma (,), colon (:), at sign (@), ampersand (&), etc. Special characters can cause the 
call transfer to fail or prevent the recipient from picking up the call. Also, do not enter more than 78 
characters in this text box. 

Transfer To 

As you type the recipient's name or number in the Transfer To text box, a drop-down list of choices 
appears. 

• Selecting "Dial 'your entry' as Digits" enables you to convert a text entry into numbers. In the 
example shown, if you type le and select "Dial [your entry] as Digits," the CIC client dials the 
number "53." 

• Selecting the contact name from the drop-down list enables you to dial the associated extension 
or phone number. For example if you select "Aaron Lee," the CIC client dials the number "8888." 

Options drop list 

You control the types of information used to find a match. Use the Options drop-down list to filter the 
contact search. You can choose to search any combination of Users, Workgroups, Standalone Phones, 
Stations, Station Groups, or Attendant Profiles.  

As you type in the Transfer to text box, the selections you made in the Options drop down list determine 
which information is used to find a match.   

After you select the transfer recipient, the Transfer dialog displays the status information for your 
recipient, if he or she is a CIC client user. This can help you decide what kind of call transfer to use. 

 

Override Call Forwarding 
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Interaction Client users can set Call Coverage options that forward their calls to another CIC user. CIC 
client users can also set status details that forward their calls to an alternate phone number. Select the 
Override Call Forwarding check box to ignore these settings and transfer the current call directly to the 
selected number or voicemail box or to park the call on the selected number. 

Related Topics 

Transfer a Work Item 

Transfer a Work Item 
A work item is a form presented to a user to gather information. Work items may appear in user or 
workgroup queues that you are monitoring. You can transfer a work item to another user or workgroup 
queue. Supervisor users can transfer work items that are not on Hold, if necessary to continue a process. 
If a supervisor transfers a work item while an agent has that work item open, then any data changed or 
entered by the agent since the work item was picked up may be lost. 

Licenses and Other Conditions 

You do not need an IPA license to transfer a work item. You can transfer a work item to another user or 
workgroup under certain conditions: 

• You need the right to modify the queue in which the work item appears. Your CIC administrator 
assigns user rights in Interaction Administrator. Contract your CIC administrator if you have a 
question about user rights. 

• You can transfer work items only to other IPA-licensed users or to a workgroup with at least one 
IPA-licensed user. 

• If you transfer a work item to a workgroup, the target workgroup must have an associated 
queue. 

• You can transfer only work items that are in a New, ACD - Wait Agent, or Held state. You cannot 
transfer a completed work item or a work item you are viewing or revising (In Progress state). 

Work Item Transfer Dialog Box 

Transferring a Work Item uses the same Transfer dialog as transferring an interaction, with some minor 
differences. 

• The Options drop-down list limits your search for a transfer recipient to either users or 
workgroups or both. You cannot transfer a work item to a phone, station, station group or 
attendant profile, so these search criteria do not appear. 

• The Override Call Forwarding check box does not appear as it applies only to transferred calls, 
not work items. 

• The Park and Voice Mail are disabled as they apply only to transferred calls, not work items. 

Transfer a work item 

1. Select a work item that is in a New, ACD - Wait Agent, or Held state. 
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2. Click the Transfer button or right-click the work item and choose Transfer from the context 
menu. The Transfer dialog box appears. 

3. In the Transfer To: text box, type all of part of the recipient's name. A drop-down list of choices 
appears. If the drop-down list does not contain the recipient you expected, check the search 
criteria selected in the Options drop-down list and adjust them if necessary. You can search by 
user or workgroup name or both. 

4. From the drop-down list, select the appropriate recipient. Status information appears for the 
selected user or workgroup, including whether a selected user is logged into a CIC client and is 
available to accept the transferred work item. If the selected recipient is a workgroup, it shows 
how many interactions are in the workgroup queue, how many agents are logged in and how 
many agents are available. 

5. Click the Transfer button. The work item is removed from your My Work Items page or other 
queue where you selected it and is routed to the selected agent or workgroup. If you are 
transferring a work item from another user's queue or workgroup queue, you may see this 
warning: "You do not own this interaction, are you sure you want to perform this action?" Click 
Yes to continue the Transfer. 

Important: Certain work item settings are no longer in effect after a transfer. For example, 
work items can have a timeout setting that controls how much time an CIC user has to pick up 
an alerting work item before it is routed to another user. This pickup time limit no longer 
applies to the transferred work item because the transfer signals the work item is "being 
handled" or "under an agent's control." 

  

Workgroup Directory Options dialog 

 
Options on this dialog format rows for a list of members in a workgroup directory.  The directory options 
are specified per-directory-view in IC Business Manager. This option appears when a workgroup 
directory is right-clicked and the Formatting Options shortcut command is selected. 

Favor "On Phone" agents when sorting by status 

Favor "On Phone" agents when sorting by status will group all agents who are on the phone together at 
the top (or bottom) of the directory when the "Status" column is used to sort. If the directory is sorted 
by any other column, this option will have no effect. 
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Show logged-in agents in bold 

Shows the names of logged-in agents in bold text. 

Text color for agents who are on the phone 

Enables text color selection applied to names of agents who are currently handling a call. 

Text color for agents who are in an ACD available status, logged-in, activated, and off the 
phone 

Enables text color selection applied to names of agents who are currently available to take ACD calls. An 
agent is considered to be available to take ACD calls if all of the following criteria are met: 

• Agent is in a status that is "ACD Available" 

• Agent is logged in 

• Agent is activated on the workgroup 

• Agent is not "On Phone" 

Utilization is taken into account by the calculation of the Available to take ACD Interactions statistic, but 
not by the calculation used to set the color of agent rows.  For a row to be formatted, the user has to be 
activated on the queue, logged-in, not on the phone (per client services) and in an ACD available status. 

OK button 

Applies changes to the member list and dismisses the dialog. 

Cancel button 

Dismisses the dialog without applying changes to the member list. 

Apply button 

Applies changes but does not close the dialog. 

Related Topics 

Workgroup Details view 

Workgroup Statistics and Queue Statistics dialog 
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This dialog selects workgroup or queue statistics to include in a view, similar to the workgroup statistics 
dialog, but with fewer tabs shown. 

Related Topics 

Workgroup Graph view 

Workgroup Overview view 

Workgroup Statistics dialog 
This dialog has multiple tabs used to select statistics, periods, and histogram intervals for service level 
and abandonment rate. The Add and Remove buttons move a selection from one list to another. Add All 
and Remove All move all items from one list to another. OK applies changes and dismisses the dialog. 
Cancel dismisses the dialog without applying changes. 

Description Tab 
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Options on the 
Workgroup Statistics 
tab are used to select 
workgroup statistics 
to include in the view. 

Workgroup statistics 
summarize ACD 
interactions, such as 
the number of agents 
logged in, and other 
particulars that are 
common to the 
workgroup as a 
whole. 

 

Options on the 
Queue Statistics tab 
select agent statistics 
for interval periods. 

These statistics 
summarize the 
activity of call center 
agents, by reporting 
average talk time, 
longest talk time, 
average wait time, 
and other particulars 
that are common to a 
group of agents. 
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Options on the 
Service Level 
Parameters tab select 
time and histogram 
intervals for the 
service level statistic. 

The range of service 
level histogram 
intervals are 
cumulated 
downwards by 
default. 

You can include or 
exclude any of the 
ranges below for call, 
chat, email, generic, 
callback and work 
items: 

0    0-20 

1    0-30 

2    0-40 

3    0-60 

4    0-120 

5    0-240 

6    Total 
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Options on the 
Abandoned Rate 
Parameters tab select 
time and histogram 
intervals for the 
abandoned rate 
statistic. 

The range of abandon 
rate histogram 
intervals are 
cumulated 
downwards by 
default. 

You can include or 
exclude any of the 
ranges below for call, 
chat, email, generic, 
callback and work 
items: 

0    0-20 

1    0-30 

2    0-40 

3    0-60 

4    0-120 

5    0-240 

6    Total 

 

Related Topics 

Workgroup Details view 

Workgroup Statistics view 

Workgroup Statistics Selection dialog 
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Use this dialog to specify which workgroup statistics appear in a view. Workgroup statistics summarize 
ACD interactions, such as the number of agents logged in, and other particulars that are common to the 
workgroup as a whole. 
The Add and Remove buttons move a selection from one list to another. Add All and Remove All move all 
items from one list to another. Move Up and Move Down reorder selections so that they appear more 
or less prominently in the view. 

Related Topics 

Workgroup Graph view 
Workgroup Overview view 

Workgroups Selection dialog 
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This dialog selects one or more workgroups for a view. You can filter the list of workgroup names by 
typing in the Filter box above the list of available items. To display additional items, you may need to 
type part of a workgroup name in the Filter box. When more than 20 workgroups exist in the system, 
only the first 20 are shown, and an indicator ( ) informs that more are available. If you select more 
than 20 workgroups, an indicator ( ) informs that you need to remove some to continue. 

Available items list 

Items not selected for inclusion appear in this list. 

Selected items list 

Items selected for view inclusion appear in this list. 

Add 

Moves selected available items to the list of selected items. 

Add all 

Moves all items from the Available items list to the Selected items list. 

Remove 

Move a Selected Items entry to the Available items list. 
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Remove All 

Removes all items from the Selected items list. 

Move up 

Modifies the display order items in the view to make the selection more prominent. 

Move down 

Modifies the display order of items in the view to make the selection less prominent. 

Related Topics 

Workgroup Graph view 

Workgroup Overview view 

  

  

Supervisor Statistics 

Supervisor Statistics 

This section describes statistics displayed in Interaction Supervisor views. You may also view statistics 
descriptions in the software by holding the mouse pointer over a statistic until its description is 
displayed in a tool tip. 

Statistic Category Description 

Agent Statistics Agent statistics summarize the activity of call center agents. These statistics 
report average talk time, longest talk time, average wait time, non-ACD 
interactions, interactions entered, interactions answered, interactions offered, 
or interactions completed for the current shift, previous shift, current period, or 
previous period.  Averages are calculated when the interaction completes 
(disconnects). 

Client Services 
Resources 

Client Services statistics report the number of resources that CIC's Client Services 
subsystem has available at a given point.  These statistics are updated at the 
regular statistics interval. Client Services keeps track of logged-in users, their 
status, and their rights based on security configurations. 

Content Servers 
Statistics 

 The statistics in this category help determine the state of configured Remote 
Content Servers and Recorder Server. 

Email The statistics in this category summarize Email routing activity in CIC.  These 
statistics are updated at the regular statistics interval. 

Fax This category provides information about Faxing operations in the CIC 
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system.  These statistics are updated at the regular statistics interval. 

Feedback Statistics Interaction Feedback statistics inform about a named Interaction Feedback 
survey or survey group.  Feedback views display real-time statistics for the last 
hour (relative to the present time) or statistics for the current day, since 
midnight. Daily statistics reset at midnight. 

Interaction Statistics This category provides counts or durations for general object types in CIC. 

Licenses This category summarizes CIC license availability and utilization. 

IC Memory Usage IC Memory Usage statistics report the amount of memory that CIC subsystems 
are consuming (in kilobytes). These statistics are updated every 5 minutes. 

Agents Real-Time 
Adherence Details 

Interaction Optimizer Real Time Adherence (RTA) statistics inform about agents 
who are currently scheduled. RTA statistics report scheduling unit, workgroup, 
status, scheduled activity, actual activity (based on status), adherence status, 
exception type, current adherence time, cumulative shift in adherence and shift 
out of adherence duration for an agent. 

IC Performance This category provides information about performance of CIC server.  These 
statistics are updated at the regular statistics interval. 

PMQ The statistics in this category summarize activity in persistent message queues. 

Queue Statistics This category contains counts of active interactions in a queue 

Recording The statistics in this category describe activity in Interaction Recorder.  These 
statistics are updated at the regular statistics interval. 

Session Manager 
Statistics 

Statistics for each running Session Manager are given both as a total and broken 
down by device type. 

Speech Recognition The statistics in this category describe speech recognition activity in CIC. 

IC System Status The statistics in this category indicate general system status in terms of number 
of executing handlers, host and database tool errors, and available text-to-
speech sessions.  These statistics are updated at the regular statistics interval. 

Tracker Server These performance statistics indicate the overall health of Interaction Tracker 
Server in the previous ten minute interval. 

Transaction Server Transaction Server statistics indicate the overall health of Transaction Server-a 
generic transaction server for recording, logging, etc.  These performance 
statistics indicate the overall health of Transaction Server in the previous ten 
minute interval. 
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Workgroup Statistics Workgroup statistics summarize ACD interactions, number of agents logged in, 
and other particulars that are common to the workgroup as a whole.  The 
workgroup may or may not have associated queues. 

  

Agent Statistics 
Agent statistics summarize the activity of call center agents. These statistics report average talk time, 
longest talk time, average wait time, non-ACD interactions, interactions entered, interactions answered, 
interactions offered, or interactions completed for the current shift, previous shift, current period, or 
previous period.  Averages are calculated when the interaction completes (disconnects). 

Interactions received 

Total number of interactions that entered the queue. 

Interactions answered 

Number of interactions answered, calculated as the number of ACD interactions from the specified 
workgroup that went to a Connected state in the agent's queue. 

Interactions completed 

Number of interactions completed (that went from a state of ACD - Assigned to ACD - Disconnected). 

Interactions held 

Number of interactions held. 

Average wait time 

Average wait time in queue of all interactions.  In other words, the average time an interaction from the 
specified workgroup has alerted the agent in the current period.  This is the average time all interactions 
have been in the ACD - Alerting state on the agents queue for the specified workgroup. 

Average talk time 

The average time the agent has spent on interactions for the specified workgroup.  In technical terms, 
this is the average time all interactions on the agents queue for the specified workgroup have been in 
the ACD - Assigned state. 

Average hold time 

The average hold time in queue of all ACD interactions. In technical terms, this is the average time all 
ACD interactions on the agents queue for the specified workgroup have been in Hold state. 

Longest interaction waiting 

Time of the longest currently waiting interaction.  This interaction has been in the ACD - Wait Agent 
state the longest. Its duration is the amount of time that the interaction has waited to be picked up by 
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an available agent, based on time in queue only. Supervisor workflow statistics always pertain to time in 
a workgroup or user interaction. Overall time in the system (such as time in IVR) is not counted. 

Longest talk time 

The total talk time of the longest currently connected interaction. . 

Non-ACD interactions 

The number of interactions answered by an agent that were not routed to the agent by ACD.  These are 
interoffice interactions, transfers, and other person-to-person interactions. 

Average agent positive score 

Sum up agent positive score divided by the total number of calls in the current/previous period or shift 

Average agent negative score 

Sum up agent negative score divided by the total number of calls in the current/previous period or shift 

Average customer positive score 

Sum up customer positive score divided by the total number of calls in the current/previous period or 
shift 

Average customer negative score 

Sum up customer negative score divided by the total number of calls in the current/previous period or 
shift 

Time in status 

This statistic is evaluated by time-in-status alerts.  It appears in Workgroup Detail views to report the 
amount of time that an agent has been in a particular status condition. 

  

Service Level Distributions 
The interactions that connected callers to agents within a specified time interval. 

Abandon Rate Distributions 

Abandon Rate Distributions 

Feedback Statistics 
Interaction Feedback statistics inform about a named Interaction Feedback survey or survey 
group.  Feedback views display real-time statistics for the last hour (relative to the present time) or 
statistics for the current day, since midnight. Daily statistics reset at midnight. 

Total licenses 

Total licenses 
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Available licenses 

Available licenses 

Surveys offered last hour 

Number of surveys selected and offered to customers within the past hour. 

Surveys offered today 

Number of surveys selected and offered to customers since midnight. 

Active surveys 

Number of calls in a Connected state where the customer has agreed to take a survey at the end of the 
call.  This number reflects customers that have not started the survey as well as customers currently 
taking the survey who are still Connected to the CIC system. 

Surveys completed today 

Number of calls since midnight where a Survey was completed by obtaining answers to all of the 
questions. This count does not include Active Surveys or Abandoned Surveys. 

Surveys abandoned today 

Number of calls who agreed to take a survey (at one point considered an Active Survey) but did not 
complete the survey. This reflects calls where the customer disconnected before taking the survey as 
well as those that disconnected while taking the survey before completing it. Abandoned survey data is 
not used in survey reports. 

Surveys bypassed (no license) today 

Number of calls since midnight where the customer took a survey but the agent who dealt with the 
caller did not have an Interaction Feedback Access license. In this case, the customer completed the 
survey and the data was captured, but it will not be included in the survey data in Interaction Feedback 
Reports. In the case where multiple agents handled a call, if at least one of the agents has an Interaction 
Feedback Access license, the survey data will be included in the reports. 

Survey opt-outs today 

Number of calls since midnight where the customer did not agree to take the survey. This includes calls 
in the Connected state as well as previously disconnected calls. 

Surveys in error today 

Number of system errors generated by the CIC server since midnight. These errors could be any system 
error that could affect the performance of the CIC server, and which are reflected in either the CIC 
server's Windows event logs or CIC subsystem logs. 

Below minimum score 

This column is used only if a survey definition specified a value (other than 0) in the Minimum 
Acceptable Score field.  If a survey specifies a minimum value, indicating the lowest acceptable score on 
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a survey, then each survey completed since midnight that scored below that minimum value is counted 
in this column. 

Caller disconnects today 

This column is used to indicate surveys that have been opted into for which the caller has disconnected 
before the survey was presented, for today. 

Agent no answer today 

This column is used to indicate surveys that have been opted into for which no agent have answered, for 
today. 

Survey average score last hour 

This column displays the average score of selected surveys within the past hour. 

Survey average score today 

This column displays the average score selected surveys since midnight. 

Licenses 
This category summarizes CIC license availability and utilization. 

Allowed 

The total number of licenses on this system for the given license type. 

Available 

The number of licenses on this system for the given license type that are not yet used. 

In use 

The number of licenses on this system for the given license type that are in use. 

Available in percent 

The percentage of licenses on this system for the given license type that are not yet used. 

Used in percent 

The percentage of licenses on this system for the given license type that are in use. 

Agents Real-Time Adherence Details 
Interaction Optimizer Real Time Adherence (RTA) statistics inform about agents who are currently 
scheduled. RTA statistics report scheduling unit, workgroup, status, scheduled activity, actual activity 
(based on status), adherence status, exception type, current adherence time, cumulative shift in 
adherence and shift out of adherence duration for an agent. 

Agent 
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Display name of scheduled agent. 

Status 

Current logged in status of agent 

Adherence status 

Agent adherence status indicating In Adherence or Out of Adherence with the schedule. 

Scheduled activity 

The activity scheduled by Interaction Optimizer for this agent at this point in time. 

Actual activity 

Current actual activity of agent based on logged in status. 

Current adherence duration 

Duration for which agent is in the current adherence state after last adherence status change. 

Shift time in adherence 

The cumulative amount of time that an agent has been in adherence, accumulated for the entire shift. 

Shift time out of adherence 

The cumulative amount of time that an agent has been out of adherence, accumulated for the entire 
shift.  

Number of agents in adherence 

The count of users in adherence with the current schedule. 

Number of agents out of adherence 

The count of users not in adherence with the current schedule. 

Percent of agents in adherence 

The percentage of users in adherence with the current schedule. 

Percent of agents out of adherence 

The percentage of users not in adherence with the current schedule. 

Queue Statistics 
This category contains counts of active interactions in a queue 

Interaction received 

Total number of interactions that entered the queue. 
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Interaction answered 

Number of interactions answered, calculated as the number of ACD interactions from the specified 
workgroup that went to a Connected state in the agent’s queue. 

Interaction completed 

Number of interactions completed (that went from a state of ACD -Assigned to ACD – Disconnected). 

Interaction abandoned 

Number of interactions that were externally disconnected by the remote party before they could be 
client connected (picked up by an agent). Tip: the CIC data dictionary provides supplemental information 
about abandoned calls. 

Interactions held 

Number of interactions held. 

Total wait time 

The total time that different ACD interactions waited in the Workgroup Queue before they were ACD 
assigned. 

Total hold time 

Total amount of hold time that on different ACD interactions. 

Total talk time 

Total amount of time that All Agents spent on different ACD interactions. 

Average wait time 

The total time that different ACD interactions waited in the Workgroup Queue before they were ACD 
assigned, divided by number of ACD interactions for the period reported. 

Average hold time 

Total amount of hold time that on different ACD interactions, divided by number of ACD interactions 
handled by All Agents. 

Average talk time 

Total amount of time that All Agents spent on different ACD interactions, divided by number of ACD 
interactions handled by All Agents. 

Interactions flowed-out 

Number of interactions flowed-out. 

Service level Target 
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The number of calls answered that within the service level target configuration (inclusive) for the given 
workgroup queue, interaction type and interval (current period, shift, etc). The number of answered 
calls for each bucket is divided by the number of calls answered for the workgroup queue to represent 
this value in percentage. 

Service Level Missed target 

The number of calls answered that did not make the service level target. The number of those calls is 
divided by the number of calls answered for the workgroup queue to represent this value in percentage. 

Abandon Rate Target 

This statistic represents abandoned calls that happened within the service level target configuration. In 
addition, the number of those calls is divided by the number of calls that entered into the workgroup 
queue to represent this value in percentage. 

Abandon Rate Missed Target 

The number of calls that are abandoned outside of the service level target. It divides that number with 
the number of calls that entered into the workgroup queue to get this value in percentage. 

Average agent positive score 

Sum up agent positive score divided by the total number of calls in the current/previous period or shift. 

Average agent negative score 

Sum up agent negative score divided by the total number of calls in the current/previous period or shift. 

Average customer positive score 

Sum up customer positive score divided by the total number of calls in the current/previous period or 
shift. 

Average customer negative score 

Sum up customer negative score divided by the total number of calls in the current/previous period or 
shift. 

  

Session Manager Statistics 
Statistics for each running Session Manager are given both as a total and broken down by device type. 

Session count 

The number of active sessions that are currently running on the given Session Manager. 

Current Period 

Period ends every [%1%] seconds 
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Current shift 

Shift starts at [%1%] 

Previous Period 

Period ends every [%1%] seconds 

Previous Shift 

Shift starts at [%1%] 

Call 

Call 

Chat 

Chat 

Email 

Email 

Callback 

Callback 

Generic 

Generic 

All objects 

All objects 

%1% 

[%1%] => Call: %2%%3% Chat: %4%%5% Email: %6%%7% Generic: %8%%9% Callback: %10%%11% Work 
Item: %12%%13% 

%1%%2% 

On Phone 

On Phone 

LicenseType 

Client Services Resources 
Client Services statistics report the number of resources that CIC's Client Services subsystem has 
available at a given point.  These statistics are updated at the regular statistics interval. Client Services 
keeps track of logged-in users, their status, and their rights based on security configurations. 
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Status of the aggregator connection 

This Boolean indicator (Yes or No) indicates whether a connection with Interaction Aggregator server is 
active. 

Content Servers Statistics 
Content Servers statistics include statistics that help determine the state of configured Remote Content 
Servers and Recorder Server. 

Available HTTP Client Connections 

HTTP client threads available for accepting recordings. 

Available local disk space 

Free disk space for recordings on the local machine in gigabytes. 

Available log disk space 

Free disk space for logs in gigabytes. 

Available share disk space 

Free disk space for recordings on network shares in gigabytes. 

Configured for Amazon S3 

Indicates whether or not Recorder Server is connected to Amazon’s Simple Storage Service. 

Failed transfers last hour 

Number of recordings failed to transfer last hour.   

Memory usage 

The amount of paged physical memory (working set) that a content server is using, expressed in 
kilobytes. 

Recordings played back last hour 

Recordings played back in the last hour. 

Recordings successfully processed last hour 

Number of recordings successfully processed last hour. 

Total CPU usage 

The value is the sum of CPU utilization reported by Windows across all cores present in the machine. A 
value of 100% on a four core machine would indicate that all cores are complete used. 
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Email 
The statistics in this category summarize Email routing activity in CIC.  These statistics are updated at the 
regular statistics interval. 

Emails waiting to be delivered 

Number of Email messages that have been left, which CIC has not started processing. 

Emails in pre-delivery processing. 

Number of Email messages that CIC is in process of delivering. 

Emails that cannot be delivered 

Number of Email messages that could not be delivered, either because the number of retry attempts on 
the message has been exceeded, or because something about the message makes it undeliverable (e.g. 
there are no recipients, a voicemail that is missing an audio file, etc.) 

Emails scheduled to be retried 

Number of Email messages that have had at least one failed attempt at delivery, but because that failed 
attempt might have been due to a momentary problem (e.g. network outage, unavailable server, etc.), 
at least one more delivery attempt will be made. 

Fax 
This category provides information about Faxing operations in the CIC system.  These statistics are 
updated at the regular statistics interval. 

Faxes sent successfully 

The total number of Faxes sent successfully today, this value is reset to zero every day at midnight. 

Faxes send connection failures 

The total number of Faxes that failed due to invalid Fax numbers or connection problems (no available 
lines, or other telephony failure) since the server was restarted. 

Fax sends aborted 

The number of Faxes sends that failed due to a faxing protocol error (too much line noise, too many 
errors, failure to negotiate baud rate, etc.) 

Faxes received successfully 

The total number of Faxes received today, this value is reset to zero every day at midnight. 

Fax receptions failed (connection failure) 

Total number of Faxes received which failed due to no Fax resources available.  This error indicates that 
additional hardware Fax resources are required. 
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Fax receptions failed (aborted) 

Total number of Faxes received which failed due to line noise or faxing protocol error. 

Total fax licenses 

Total number of fax licenses. 

Fax licenses available 

Number of active Fax stations that are currently available to send or receive Faxes.  A low number 
indicates that additional active Fax resources should be added or configured.  The display indicates the 
total number available out of total. 

Interaction Statistics 
This category provides counts or durations for general object types in CIC. 

Longest call 

Duration of the longest call currently in the system. 

Longest chat 

Duration of the longest chat currently in the system. 

Longest email 

Duration of the longest Email currently in the system. 

Longest workflow 

Duration of the longest workflow currently in the system. 

Longest social conversation 

Duration of the longest social conversation currently in the system. 

Longest generic object 

Duration of the longest generic object currently in the system. 

Active calls 

Total number of active call objects in the system, including SIP calls.  See SIP Station Calls for a count of 
active SIP calls only. 

Active social conversations 

Number of active social conversations in the system. 

Active chats 

Number of active chat objects in the system. 
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Active emails 

Number of active Email objects in the system. 

Active workflows 

Number of active workflows in the system. 

Active generic objects 

Number of active generic objects in the system.  A generic object is an integration object that can be 
placed on a queue, and routed throughout CIC.  Each generic object represents a third-party software 
construct of some sort, such as an external ticketing system, video conference, or other software that 
was defined by a third party. 

SIP Station Calls 

The number of active calls that are SIP station calls.  For example, if Active Calls equals 10, and there are 
5 SIP station calls at the same time, then the total call count is 10, with 5 of those calls being SIP Station 
Calls. 

IC Memory Usage 
IC Memory Usage statistics report the amount of memory that CIC subsystems are consuming (in 
kilobytes). These statistics are updated every 5 minutes. 

Acc Server 

The amount of paged physical memory (working set) that Accumulator (Acc) server is using, expressed in 
kilobytes.  Accumulators, similar to system registers, count events as they occur in the CIC's Interaction 
Processor. Instances of these events are stored in variables and are accessible in report logs or other 
handlers using the Accumulator tools in Interaction Designer. 

Acd Server 

The amount of paged physical memory (working set) that ACD Server is using, expressed in kilobytes. 
ACD Server determines which agent a call should be routed to, based upon skill and other factors. 

Admin Server 

The amount of paged physical memory (working set) that Admin Server is using, expressed in kilobytes. 
Admin Server provides ACL management and licensing on top of the data managed by Directory 
Services. It maintains a very large cache of data with a size proportional to the amount of configuration 
information 

Stat Alert Server 

The amount of paged physical memory (working set) that Alert Server is using, expressed in kilobytes. 
Alert Services allows users and supervisors to define specific circumstances (e.g., average hold time > 10 
minutes) under which they are to be alerted and the means by which the alert is to occur (e.g., e-mail, 
pager, phone call, etc.). 
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Client Services 

The amount of paged physical memory (working set) that Client Services is using, expressed in kilobytes. 
Client Services keeps track of logged-in users, their status, and their rights based on security 
configurations. 

Cluster Connector 

The amount of paged physical memory (working set) that the Cluster Connector is using, expressed in 
kilobytes. 

Compression Manager 

The amount of paged physical memory (working set) that Compression Manager is using, expressed in 
kilobytes. Compression Services compress audio recordings (such as voice mail messages) using the 
TrueSpeech compression algorithm. 

Data Manager 

The amount of paged physical memory (working set) that Data Manager is using, expressed in kilobytes. 
Data Manager  is the CIC subsystem that services Reverse White Page (RWP) lookup requests, as well as 
contact directory requests. Data Manager keeps track of data sources used to display Contact Directory 
and Speed Dial notebook pages in the CIC clients. 

DS server 

The amount of paged physical memory (working set) that Directory Services is using, expressed in 
kilobytes. Directory Services provides the interface to the proprietary data store (configuration 
repository) that CIC uses to store system configuration information. 

DS sink 

The amount of paged physical memory (working set) that DSSink is using, expressed in kilobytes. 

EMS Server 

The amount of paged physical memory (working set) that Multi-Site Client is using on a peer CIC site, 
expressed in kilobytes. 

Fax Server 

The amount of paged physical memory (working set) that Fax Services is using, expressed in kilobytes. 
The Fax subsystem allows the PureConnect Platform to send and receive faxes. 

File Monitor 

The amount of paged physical memory (working set) that File Monitor is using, expressed in 
kilobytes.  File Monitor keeps track of file usage. 

File Router 

The amount of paged physical memory (working set) that the File Router is using, expressed in kilobytes. 
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Host Server 

The amount of paged physical memory (working set) that Host Server is using, expressed in kilobytes. 
Host Services allows Interaction Center Platform to communicate with mainframes and IBM AS/400 
systems using the 3270 and 5250 terminal emulation protocols. 

IP 

The amount of paged physical memory (working set) that Interaction Processor (IP) is using, expressed 
in kilobytes. Interaction Processor (IP) is the CIC subsystem that processes low-level subsystem events in 
order to implement higher-level business logic.  For example, Interaction Processor starts an instance of 
a handler in response to an event. 

IP Server 

The amount of paged physical memory (working set) that IP Server is using, expressed in kilobytes. IP 
Server manages several helper tasks for Interaction Processor and Report Logging. Specifically it logs line 
activity, and manages part of the Message waiting light processing. 

IPDB Server 

The amount of paged physical memory (working set) that IPDB Server is using, expressed in 
kilobytes.  IPDB Server connects Interaction Processor to a specified database when Database tools are 
used. 

Mail Account Monitor 

The amount of paged physical memory (working set) that Mail Account Monitor is using, expressed in 
kilobytes. Mail Account Monitor is responsible for syncing external user attributes from Mail accounts or 
LDAP to Directory Services.  

Notifier 

The amount of paged physical memory (working set) that Notifier is using, expressed in kilobytes. 

Optimizer Server 

The amount of paged physical memory (working set) that Optimizer Server is using, expressed in 
kilobytes. 

Out Of Proc 

The amount of paged physical memory (working set) consumed by OutOfProc server, expressed in 
kilobytes. OutOfProc server is a service used to execute DLLs for Interaction Processor without risking 
the integrity of the IP process. Its size will be a function of any custom activities that might be added by 
the customer or VAR via these customization interfaces. 

Post Office Server 

The amount of paged physical memory (working set) that Post Office Server is using, expressed in 
kilobytes. Post Office Server (POS) is the CIC subsystem that provides platform independent access to 
Email services such as message store access and message delivery.  POS also provides support for Email 
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routing, and will initiate an Reverse White Page (RWP) lookup request before queuing an incoming email 
interaction. 

Reco 

The amount of paged physical memory (working set) that Speech Recognition (ASR) is using, expressed 
in kilobytes. Speech recognition services recognize spoken commands and phrases for applications such 
as speech-enabled IVR (interactive voice response). 

Recorder Server 

The amount of paged physical memory (working set) that Interaction Recorder Server is using, 
expressed in kilobytes. Interaction Recorder is an application for managing phone calls, Emails, Faxes, 
screen recordings, and Web chats recorded within the CIC platform. Interaction Recorder identifies 
interactions to record and manages the compression, archiving, and storing of the attributes for each 
type of media recording. Using Interaction Recorder, you can quickly sort and manage large numbers of 
recordings. Interaction Recorder also includes features for scoring agent interactions and quality 
monitoring. 

Session Manager 

The amount of paged physical memory (working set) that Session Manager is using, expressed in 
kilobytes. 

SMS Server 

The amount of paged physical memory (working set) that Simple Message Services Server is using, 
expressed in kilobytes.  CIC provides tools that allow SMS messages to be sent or received. 

Statistics Server 

The amount of paged physical memory (working set) that Statistics Server (StatServer) is using, 
expressed in kilobytes. Statistics Server tracks important statistical information for real-time views. 

Switchover 

The amount of paged physical memory (working set) that the CIC's automated switchover system is 
using, expressed in kilobytes. If an CIC server ever fails, in less than 30 seconds the server can switch 
control to another mirror image CIC server with minimal phone disruption. In addition, the switchover 
scheme allows administrators to manually switch the 'active' CIC server with no phone disruption. 

Tracker Server 

The amount of paged physical memory (working set) that Tracker Server is using, expressed in kilobytes. 
Interaction Tracker is composed of two server-side subsystems:  Tracker Server and Tracker Tran Server 
(also called Transaction Server). Tracker Server listens for specific events from Queue Manager and 
inserts and updates interaction records.  Tracker Tran Server processes insert and update requests from 
Tracker Server and insert, update, and query requests from Interaction Tracker Clients. 

Transaction Server 
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The amount of paged physical memory (working set) that Transaction Server is using, expressed in 
kilobytes. Transaction Server is a generic processor of database transactions related transactions for 
several different subsystems including Tracker and Recorder. 

Telephony Services 

The amount of paged physical memory (working set) that Telephony Services is using, expressed in 
kilobytes. 

VPIM receiver 

The amount of paged physical memory (working set) that Voice Profile for Internet Mail (VPIM) Receiver 
is using, expressed in kilobytes.  VPIM a mechanism for identifying body parts that a sender deems 
critical in a multi-part Internet mail message. 

Web Processor 

Amount of paged physical memory that Web Processor is using, expressed in kilobytes.  Web Processor 
is the CIC subsystem that handles all incoming web interactions and internal intercom chats.  It operates 
in conjunction with servlet process on a web server and acts as web interface into the CIC system. 

IC Performance 
This category provides information about performance of CIC server.  These statistics are updated at the 
regular statistics interval. 

System latency 

Measures round trip time of a message through the Notifier subsystem.  This indicates the general 
latency of the PureConnect platform.  A high latency value indicates that the server is busy and may 
require additional hardware resources.  On a system that is not under load, this value is typically 
zero.  On a moderately tasked system, a typical value might be 50-100 ms.  A system under heavy load 
might be higher.  Values over 300 milliseconds may cause noticeable delays and could indicate that a 
hardware upgrade or handler optimization is needed. 

Average latency 

The average Notifier/Queue Manager latency in milliseconds. This statistic is computed by sending no-
op requests from Remoco to Queue Manager and then measuring the latency in the response from 
Queue Manager. 

Page faults 

Page faults are the number of times that the operating system has to use the hard disk as a memory 
resource.  A consistently large number of page faults may indicate that more main memory may be 
required.  

Free disk space recordings 

The free disk space recordings currently consume on this system in gigabytes. 

Free disk space logs 
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The free disk space logs currently consume on this system in gigabytes. 

Free disk space system 

The free disk space of this system in gigabytes. 

Free disk space work 

The free disk space work in gigabytes. 

Total disk space system 

The value indicates the amount of free space that is available on the drive where the operating system 
resides. 

Total disk space work 

The value indicates the amount of free space that is available on the drive that contains the CIC work 
directory. 

Total disk space recordings 

The value indicates the amount of free space that is available on the drive where recordings are saved. 

Total disk space logs 

The value indicates the amount of free space that is available on the drive where logs are saved. 

Total CPU usage 

The value is the sum of CPU utilization reported by Windows across all cores present in the machine. A 
value of 100% on a four core machine would indicate that all cores are completely used. 

Available CPU 

Available CPU in percent. 

Notifier CPU usage 

The value is the percentage of total CPU used by the Notifier subsystem across all cores present in the 
machine. 

IP CPU usage 

The value is the percentage of total CPU used by the Interaction Processor subsystem across all cores 
present in the machine. 

TTS CPU usage 

The value is the percentage of total CPU used by the text to speech subsystem across all cores present in 
the machine. 

TS CPU usage 
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The value is the percentage of total CPU used by the Telephony Services subsystem across all cores 
present in the machine. 

PMQ 
The statistics in this category summarize activity in persistent message queues. 

Note: Starting with CIC 2017 R1, the "PMQ is persisted to disk" and the "oldest message on disk" 
statistics now report the actual number of PMQ files present in the filesystem. These statistics are 
updated every 60 seconds. 

IP is connected to DB 

Indicates whether or not Interaction Processor's PMQ object currently has a connection to the 
database.  Not having a connection only indicates an error if items are also being persisted to disk. 

IP Server is connected to DB 

Indicates whether or not IP Server's PMQ object currently has a connection to the database.  Not having 
a connection only indicates an error if items are also being persisted to disk. 

Admin Server is connected to DB 

Indicates whether or not Admin Server's PMQ object currently has a connection to the database.  Not 
having a connection only indicates an error if items are also being persisted to disk. 

Stat Server is connected to DB 

Indicates whether or not Stat Server's PMQ object currently has a connection to the database.  Not 
having a connection only indicates an error if items are also being persisted to disk. 

Recorder server is connected to DB 

Indicates whether or not Recorder Server's PMQ object currently has a connection to the database. Not 
having a connection only indicates an error if items are also being persisted to disk. 

IP's PMQ is persisted to disk 

Indicates that PMQ is currently buffering Interaction Processor messages to disk.  This is a common 
occurrence for Stat Server since it periodically sends large amounts of data to the database.  If the 
subsystem is connected to the database, and it has messages persisting to disk then you should examine 
the 'oldest message on disk' statistic to find out whether messages are flowing smoothly or are backed 
up. 

IP Server's PMQ is persisted to disk 

Indicates that PMQ is currently buffering IP Server messages to disk.  This is a common occurrence for 
Stat Server since it periodically sends large amounts of data to the database.  If the subsystem is 
connected to the database, and it has messages persisting to disk then you should examine the 'oldest 
message on disk' statistic to find out whether messages are flowing smoothly or are backed up. 

Admin Server's PMQ is persisted to disk 
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Indicates that PMQ is currently buffering Admin Server messages to disk.  This is a common occurrence 
for Stat Server since it periodically sends large amounts of data to the database.  If the subsystem is 
connected to the database, and it has messages persisting to disk then you should examine the 'oldest 
message on disk' statistic to find out whether messages are flowing smoothly or are backed up. 

Stat Server's PMQ is persisted to disk 

Number of Stat Server PMQ objects that are currently persisted to disk. 

Recorder Server's PMQ is persisted to disk 

Number of Recorder Server PMQ objects that are currently persisted to disk. 

IP's oldest message on disk 

This statistic indicates the age of the oldest message that PMQ is currently storing to disk for Interaction 
Processor server.  This operation is common for Interaction Processor server, and should be a concern 
only if the time lag is larger than the default reporting period (30 minutes). 

IP Server's oldest message on disk 

Age of the oldest message that PMQ is currently storing to disk for Interaction Processor server.  This 
operation is common for Interaction Processor server, and should be a concern only if the time lag is 
larger than the default reporting period (30 minutes). 

Admin Server's oldest message on disk 

Age of the oldest message that PMQ is currently storing to disk for Admin Server.  This operation is 
common for Admin Server, and should be a concern only if the time lag is larger than the default 
reporting period (30 minutes). 

Stat Server's oldest message on disk 

Age of the oldest message that PMQ is currently storing to disk for Stat Server.  This operation is 
common for Stat Server, and should be a concern only if the time lag is larger than the default reporting 
period (30 minutes). 

Recorder Server's oldest message on disk 

Age of oldest message that PMQ is currently storing to disk for Recorder Server. This operation is 
common for Recorder Server, and should be a concern only if the time lag is larger than the default 
reporting period (30 minutes). 

Recorder Server errors persisted to disk 

Number of Recorder Server error objects that are currently persisted to disk. 

Recorder Server's oldest error on disk 

Age of the oldest error that Record Server is currently storing to disk. 
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Recording 
The statistics in this category describe activity in Interaction Recorder.  These statistics are updated at 
the regular statistics interval. 

Recorder is processing recordings 

Indicates whether the Interaction Recorder system is currently processing recordings. 

Note: If you see the status False, it probably means that the system is idle. It does not necessarily 
mean there is a problem. 

Recorder database is available 

Indicates whether the Interaction Recorder system can connect to its database. 

Recordings in progress 

Number of recordings that Interaction Recorder is conducting. 

Successful recordings (last hour) 

Number of successful recordings that occurred in the last sixty minutes. 

Successful recordings (today) 

Number of successful recordings that occurred since midnight. 

Recording lag time 

The oldest recording currently in the Recorder cache. 

Encumbered recordings (today) 

Number of recordings since midnight where one or more of the internal participants does not have an 
Interaction Recorder workstation license. 

Encumbered recordings (last hour) 

Number of recordings in the previous 60-minute interval where one or more of the internal participants 
does not have an Interaction Recorder workstation license.   

Unsuccessful recordings (last hour) 

The number of failed recordings that occurred in the last sixty minutes. 

Unsuccessful recordings (today) 

The number of unsuccessful recordings that occurred since midnight. 

Recording storage locations low on space 

The number of recording storage locations that have 5 GB or less free space. 
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Recording storage locations 

The number of recording storage locations. 

Speech Recognition 
The statistics in this category describe speech recognition activity in CIC. 

Current speech recognition sessions 

Number of speech recognition sessions currently occurring in the system. 

Peak number of recognition sessions 

The peak number of concurrent speech recognition sessions since the system was started.  

IC System Status 
The statistics in this category indicate general system status in terms of number of executing handlers, 
host and database tool errors, and available text-to-speech sessions.  These statistics are updated at the 
regular statistics interval. 

Maximum executing handlers 

Maximum number of handlers that can be executed in the system at any time. 

Currently executing handlers 

The value indicates the total number of handlers that are currently executing in the system.  If this 
number continually trends up, this could indicate that handlers are not completing execution due to 
design flaws, or tool defects. 

Queued handler threads 

Number of handlers that are queued in the system right now. 

Current handlers in the thread pool 

Number of handlers in the thread pool. 

IP is running 

Indicates whether Interaction Processor is running. 

Available remote licenses 

The number of available remote licenses, updated every 10 minutes. 

Host tool connection errors 

Total errors for the 'Host Connect' Host Interface tool for the last ten minutes.  These are failed attempts 
to connect to the host system.  Errors of this type typically indicate host/communications problems or 
an incorrectly configured host profile.  
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Host tool other errors 

Total errors for the other Host Interface tool for the last ten minutes.  Typically these are minor errors, 
caused by timeouts, unrecognized screens, and handler programming errors. 

Total TTS sessions 

Maximum number of concurrent TTS sessions allowed. 

Available TTS sessions 

This value indicates the total number of text-to-speech sessions that are currently available.  If the 
available number is approaching zero, you may need to purchase additional TTS sessions. 

Ts ping time 

The amount of time in milliseconds to ping the CIC's Telephony Services subsystem. 

Switchover UDP heartbeat interval 

Heartbeats are a series of signals emitted at regular intervals, by CIC servers on the network. This stat 
indicates the transmission rate for UDP heartbeats on the Switchover server, expressed in milliseconds. 

Backup Server ready 

Indicates the health of the backup (Switchover) server.  Displays Yes if the backup server is ready, or No 
if the backup server is known to be in a bad state or is no longer processing properly. 

Backup Server name 

The Notifier name of the backup server, or N/A if no backup server is configured. 

Time since last switchover 

The amount of time that has passed since the last known switchover occurred, or 'N/A' if no backup 
server is configured. 

Indicates if a switchover was performed 

Indicates if a switchover was performed. 

Tracker Server 
These performance statistics indicate the overall health of Interaction Tracker Server in the previous ten 
minute interval. 

Interaction segment notifications 

Number of update notifications sent by Queue Manager to Interaction Tracker.  This indicates how busy 
the server is, after having processed state changes of objects in the system (e.g. hold to voice mail, etc.). 

Posted tracker transactions 

Number of transactions sent to Tracker Transaction Server for processing in the last ten minute period. 
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Failed tracker transactions 

Number of transactions sent to Tracker Transaction Server in the last ten minute period that failed.  A 
high value indicates that Tracker Transaction Server may be down. 

Transaction Server 
Transaction Server statistics indicate the overall health of Transaction Server-a generic transaction 
server for recording, logging, etc.  These performance statistics indicate the overall health of Transaction 
Server in the previous ten minute interval. 

Executed transactions 

Number of transactions that Transaction Server successfully executed in the previous ten minute 
interval. 

Failed transactions 

Number of transactions that Transaction Server failed to execute in the previous ten minute interval.  A 
high value could indicate that database errors are occurring. 

Average successful transaction time 

Average amount of time that Transaction Server needed to process a transaction in the previous ten 
minute interval. 

Workgroup Statistics 
Workgroup statistics summarize ACD interactions, number of agents logged in, and other particulars 
that are common to the workgroup as a whole.  The workgroup may or may not have associated 
queues. 

Total agents 

Total number of agents in the specified workgroups.  This is typically the number of users that are 
members of the specified workgroup on the current server.  This statistic does not take into account 
members of the same workgroup on peer servers. 

Logged on 

The number of agents logged on for the specified workgroup.  This is also the number of agents who are 
logged on the current server.  This count does not include agents who are logged on peer servers for the 
same workgroup. 

Available for ACD interactions 

The number of agents available to take ACD interactions.  An agent is considered to be available to take 
ACD interactions if all of the following apply: a) the agent is not on another interaction, b) the agent has 
an available status, c) the agent is logged on, d) the agent is activated on the specified workgroup. 

Not available for ACD interactions 
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Number of agents not available to take ACD interactions. The number of logged in and active agents 
minus the agents available for any interaction. 

Percent available 

Percent of logged in agents that are available for ACD interactions. ((available to take ACD interactions / 
logged in) * 100) 

Longest available 

Longest period of time an agent is available.  In other words, the duration of the longest available agent 
to take an ACD interaction for the specified workgroups.  See Available to take ACD interactions. 

On inbound ACD interactions 

Number of agents on inbound ACD interactions. 

On inbound ACW 

Number of agents performing after call wrap-up work after receiving an ACD interaction. 

Longest inbound ACD interaction 

Duration of the longest of the currently active inbound ACD interactions, or 0 if there is no inbound ACD 
interaction active. The duration does not include wait time or answer time. It is the time it takes for an 
interaction to be handled by an agent in a queue (excluding wrap time), from first connect to queue 
removal/disconnect. 

On outbound ACD interactions 

Number of agents on outbound ACD interactions. 

On outbound ACW 

Number of agents performing after call wrap-up work to conclude an outbound ACD interaction. 

Longest outbound ACD interaction 

Duration of the longest active outbound ACD interaction, or 0 if there is no active outbound ACD 
interaction. 

On non-ACD interactions 

Number of agents on non-ACD interactions. 

Longest non-ACD interaction 

Duration of the longest of the currently active non-ACD interactions, or 0 if there is not an active non-
ACD interaction. 

Interactions waiting 
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Number of interactions waiting to be connected to an agent. These interactions are currently in the ACD 
-  Wait Agent state. 

Interactions On Hold 

Number of interactions currently on hold. 

Interactions answered 

Number of interactions answered, calculated as the number of ACD interactions from the specified 
workgroup that went to a Connected state in the agent's queue. 

Longest interaction waiting 

Time of the longest currently waiting interaction.  This interaction has been in the ACD - Wait Agent 
state the longest. Its duration is the amount of time that the interaction has waited to be picked up by 
an available agent, based on time in queue only. Supervisor workflow statistics always pertain to time in 
a workgroup or user interaction. Overall time in the system (such as time in IVR) is not counted. 

Longest talk time 

The total talk time of the longest currently connected interaction. 

Longest hold time 

Time of the longest currently on hold interaction. This interaction has been in a Hold state the longest. 

Logged on agents in this workgroup 

Number of agents logged in on this workgroup. 

Logged on + Activated 

The number of activated agents logged on for the specified workgroup. 

Agents available 

The percent of logged in agents that are available for ACD interactions.  See definitions for Logged In and 
Available to take ACD interactions.  This is calculated as:  (Available to take ACD interactions / Logged in) 
* 100 

Lowest active agent negative score 

Lowest agent negative score for active calls. 

Lowest active customer negative score 

Lowest customer negative score for active calls. 

  

Dialer Statistics 
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Dialer Statistics 

Dialer agent statistics Summarize the activity of a specific Dialer agent. 

Dialer campaign statistics Totals that pertain to a campaign or site. 

Dialer overall statistics Summarize Dialer's performance as a whole. 

Dialer phone number detail statistics Summarize the details of a specific phone number. 

Dialer skill statistics Summarize the details of a specific skill. 

Dialer stage statistics Summarize the activity for a specific Dialer stage. 

Dialer wrap up statistics Summarize the dispositions of Dialer calls 

  

Dialer agent statistics 
These statistics summarize the activity of a specific Dialer agent. 

Abandon Rate (by calls) 

The percentage of total Dialer calls handled by this agent which were classified as abandons. 

Abandon Rate (by contacts) 

The percentage of total Dialer calls handled by this agent which were contacts and were classified as 
abandons. 

Abandon Rate (by detections) 

The percentage of Dialer calls handled by this agent which reached a live party and were classified as 
abandons. 

Average Break Time 

The average amount of time this agent spends on break. 

Average Dialer Talk Time 

The average amount of time this agent spends on each Dialer call. 

Average Idle Time 

The average amount of time this agent spends idle. 

Average Non-Dialer Talk Time 

The average amount of time this agent has spends on each non-Dialer call. 
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Average Talk Time 

The average amount of time this agent has spent on each call. 

Contact Rate 

The percentage of total Dialer calls handled by this agent which were classified as contacts. 

Contacts Per Hour 

The number of Dialer calls resulting in a contact which this agent handles per hour. 

Dialer Calls 

The number of Dialer calls this agent has completed. 

Idle Periods 

The number of times this agent has been idle. 

Logged In Time 

How long the agent has been logged into the campaign. 

Non-Dialer Calls 

The number of non-Dialer calls this agent has completed. 

Percent Break Time 

The percentage of this agent's time which has been spent on break. 

Percent Dialer Talk Time 

The percentage of this agent's time which has been spent on Dialer calls. 

Percent Idle Time 

The percentage of this agent's time which has been spent idle. 

Percent non-Dialer Talk Time 

The percentage of this agent's time which has been spent on non-Dialer calls. 

Stage 

The stage the agent is currently in. 

Station 

The station this agent is logged into. 

Status 
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The agent's current status. 

Successes Per Hour 

The number of successful Dialer calls this agent handles per hour. 

Successes Rate (by calls) 

The percentage of total Dialer calls handled by this agent which were classified as successes. 

Successes Rate (by contacts) 

The percentage of Dialer calls handled by this agent which were contacts and were classified as 
successes. 

Time in Stage 

How long the agent has been in the current stage. 

Time in Status 

How long the agent has been in the current status. 

Total Abandons 

The number of calls this agent has completed that were classified as abandons. 

Total Break Time 

The total amount of time this agent has spent on break. 

Total Breaks 

The number of times this agent has been on break. 

Total Contacts 

The number of calls this agent has completed that were classified as contacts. 

Total Detections 

The number of calls this agent has completed that were detected as a live speaker. 

Total Dialer Talk Time 

The total amount of time this agent has spent on connected Dialer calls. 

Total Idle Time 

The total amount of time this agent has spent idle. 

Total Non-Dialer Talk Time 
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The total amount of time this agent has spent on connected non-Dialer calls. 

Total Successes 

The number of calls this agent has completed that were classified as successes. 

Total Talk Time 

The total amount of time this agent has spent on Dialer and non-Dialer calls. 

Dialer campaign statistics 
Campaign statistics pertain to a campaign or site.  These statistics are sometimes special values which 
represent "roll up" statistics across all entries of a type.  When a campaign is reset, Dialer campaign 
statistics are reset to 0. Afterwards, its statistics reflect data collected in the duration of time since that 
reset occurred. 

Abandon Rate 

The current abandon rate for this campaign. This is the ratio of system-identified abandons to system-
detected live persons, as was determined by call analysis, for the period.  The formula is (system-
calculated abandons / system-detected live people) * 100. For more information, see How Call Analysis 
detections affect Abandon Rate. 

Active Agents 

The number of agents currently active in this campaign. This number corresponds to the number of 
agents that are logged in and not on break. 

Active Calls 

The number of calls active within Dialer. This includes pending calls, outstanding calls, and connected 
calls. 

Adjusted Calls Per Agent 

The number of calls Dialer needs to place on average, at this moment, to get a connection, adjusted by 
the pace. 

Agents on Break 

The number of agents logged into this campaign that are currently on break. 

Cached Contacts 

The number of contacts currently in Dialer's cache. 

Calls Per Agent 

The number of calls Dialer needs to place on average, at this moment, to get a connection. 

Calls Per Hour 
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The number of calls this campaign will place in an hour. 

Connected Calls 

The number of calls currently connected in this campaign. This statistic includes calls that are connected 
and calls that are disconnected but are awaiting completion information to be sent by agents who are 
currently in a follow-up state. 

Current Pace 

This value reports the current pace of a campaign.  The aggression level (pace) determines the speed 
with which the predictive algorithm tells the server to place outbound calls.  The faster the pace, the 
more rapidly the Outbound Dialer server places calls.  For example, if the pace level is high, the 
predictive algorithm tells the server to place calls very quickly. 

This value may have been adjusted in response to "Max Abandon Rate" settings, and other criteria, such 
as Contact List quality.  Pace ranges from -100 (not aggressive) to +100 (very aggressive).  When the 
pace setting is 0, the pace is entirely determined by the predictive algorithm's statistical averaging.  The 
Outbound Dialer server may change this pace setting at any time, if a maximum abandon rate is not set. 

Effective Idle Agents 

The portion of the idle agents that are dedicated to this campaign. 

Estimated Completion 

The estimated length of time left it will take this campaign to complete the current recycle. 

Filter 

The SQL Filter configured for a campaign, specifying which Contact List records should be dialed.  

Filter Size 

The number of callable contacts in the contact list for this campaign. Specifically, the number of records 
in the Contact List that are callable after application of a Filter, but ignoring the Zone Set settings.  This is 
used to diagnose the effect the Filter has on the number of callable records.  This statistic is also used to 
determine how effectively the list has been penetrated (regardless of recycle) left in the list.  Once this 
number becomes small, the list has been sufficiently penetrated and a new filter should be applied, or a 
different campaign should be started. 

Idle Agents 

The number of agents logged into this campaign that are currently idle. 

Last Error 

The most recent error associated with this campaign. 

Last Warning 

The most recent warning associated with this campaign.  
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Non-Dialer Agents 

The number of agents in this campaign that are currently on non-Dialer calls. 

Priority 

The configured priority of this campaign. 

Proceeding Calls 

The number of calls currently proceeding in this campaign. These are calls that are currently being dialed 
or in the process of call analysis.  Once a live speaker has been found (based on whether call analysis 
and answering machine detection has been enabled) the call will be routed to an agent via ACD.  A 
Proceeding call will be considered Connected once an agent is physically connected to the call.  

Recycle Blocked 

The number of contacts that will not be dialed because they are currently zone blocked. This can be 
used to diagnose the effect the Zone Set is having on the number of callable records.  Once a time zone 
becomes active (calls can be placed to this zone) the count of records in this zone will be subtracted 
from this value and added to the Recycle Size (no recycle is required in order for the newly active 
records to be picked up). 

Recycle Size 

The number of contacts left in the current recycle for this campaign. This value indicates the number of 
records in the Contact List that must be processed before the list is recycled.  In other words, this is the 
number of phone calls that must be placed before the next recycle of the Contact List can occur.  This 
number will decrease as the numbers of calls placed for the current recycle increases.  This includes only 
records that are callable when considering both the active Filter and the Zone Set associated with the 
campaign. 

Recycles Remaining 

The number of recycles that need to be executed in order for the campaign to complete.  The maximum 
number of recycles is configured for each campaign and dictates how many times the dialer will go 
through the list before completing or moving on to the next campaign.  If a campaign is configured to 
recycle indefinitely then the remaining recycles statistic is not used; the dialer will continually reprocess 
contacts from the list and will not complete or transition to the next campaign.  A transition may occur 
in this circumstance if the a transition rule has been configured for use with the campaign. 

Sort 

The sort order used by a campaign. Specifically, the SQL sort criteria configured for a campaign that 
specifies the sort order in which Contact List records should be dialed.  Sort Criteria contains comma-
separated values that indicate the current sort order of the Contact List and works exactly like the 
ORDER BY clause of an SQL selection statement.  An example might be: 'PhoneNumber, Name DESC'.  

Status 

The running status of a campaign. 
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Total Agents 

The number of agents currently logged into this campaign. 

Workgroup 

The workgroup used by this campaign. 

Dialer overall statistics 
These high-level statistics summarize Dialer's performance as a whole. 

Active Agents 

The number of agents currently active in Dialer, across all campaigns. 

Calls Per Agent 

The number of calls Dialer needs to place on average, at this moment, to get a connect. 

Calls Per Hour 

The number of calls Dialer will place in an hour. 

Connected Calls 

The number of calls currently connected in Dialer, across all campaigns. 

Non-Dialer Calls 

The number of non-Dialer calls currently connected to Dialer agents, across all campaigns. 

Proceeding Calls 

The number of calls currently proceeding in Dialer, across all campaigns. 

Total Agents 

The number of agents currently logged into Dialer, across all campaigns. 

Dialer phone number detail statistics 
Statistics summarizing the details of a specific phone number. 

Attempts 

The total number of times this phone number type has been attempted. 

Attempts Abandoned 

The total number of attempts to this phone number type which have been classified as abandons. 

Attempts Answering Machine 
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The total number of attempts to this phone number type which have been classified as answering 
machines. 

Attempts Busy 

The total number of attempts to this phone number type which have been classified as busy. 

Attempts Fax 

The total number of attempts to this phone number type which have been classified as fax. 

Attempts No Answer 

The total number of attempts to this phone number type which have been classified as no answer. 

Attempts Remote Hangup 

The total number of attempts to this phone number type which have been classified as remote hangups. 

Attempts Rescheduled 

The total number of attempts to this phone number type which have been rescheduled. 

Attempts System Hangup 

The total number of attempts to this phone number type which have been classified as system hangups. 

Contact Rate 

The contact rate for this phone number type.  The rate is calculated using the number of contacts and 
the total number of attempts. 

Contacts 

The total number of contacts that have been made to this phone number type. 

Dialer skill statistics 
These statistics summarize the details of a specific skill. Skill statistics help supervisors manage skills-
based dialing in predictive, power, and preview modes.    

Finishing Agents 

The number of finishing agents active in the campaign with this skill combination. 

Cached Contacts 

The number of contacts requiring this skill combination which are currently in Dialer's cache. This is an 
assortment of records that were pulled from the schedule table or standard campaign calls that have 
been pulled to dial. 

Callable Contacts 
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The number of contacts requiring this skill combination which are callable. These records in the call list 
have a "C" (callable) or blank Status column.  

Idle Agents 

The number of idle agents active in the campaign with this skill combination. 

Total Agents 

The number of agents active in the campaign with this skill combination. 

Outstanding Contacts 

The number of contacts requiring this skill combination which are currently being called. These calls are 
proceeding (i.e. dialing). 

Scheduled Contacts 

The number of contacts requiring this skill combination which are scheduled. These calls will be placed 
according to call schedule times.  The status for these records is "S", "O", "R", or "T". 

Total Contacts 

The total number of contacts requiring this skill combination. This is a sum of callable, scheduled, and 
cached records. 

Dialer stage statistics 
Statistics summarizing the activity for a specific Dialer stage. 

Average Time 

The average time a call spends in this stage. 

Completed Calls 

The number of calls that were completed while in this stage. 

Percent Completed 

The percentage of the calls that enter this stage that are completed in this stage. 

Total Calls 

The number of calls that entered this stage. 

Total Time 

The total time calls have spent in this stage. 

Dialer wrap up statistics 
Statistics summarizing the dispositions of Dialer calls. 
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Average Time 

The average amount of time this agent spends on Dialer calls with this wrap-up category and code. 

Percent Calls 

The percentage of the total calls this agent has completed which they completed with this wrap-up 
category and code. 

Percent Time 

The percentage of the time this agent has spent on calls for this wrap-up category and code to the total 
time the agent has spend on calls. 

Total Calls 

The number of calls this agent has completed with a specific wrap-up category and code. 

Total Time 

The total time this agent has spent on Dialer calls with a specific wrap-up category and code. 

Supervisor-related server parameters 
The following server parameters can be set on the CIC server to affect the behavior of Supervisor in IC 
Business Manager. 

Server Parameter Values Description 

MaximumAgentsInAgentOverviewView maximum as 
integer 

Maximum number of agents that the 
Agent Overview can show. Defaults to 
20. 

MaximumAgentsInAgentGraphView maximum as 
integer 

Maximum number of agents that the 
Agent Graph can show. Defaults to 20. 

MaximumWorkgroupsInWorkgroupOverviewView maximum as 
integer 

Maximum number of workgroups that 
the Workgroup Overview can show. 
Defaults to 20. 

MaximumStatisticsInWorkgroupOverviewView maximum as 
integer 

Limits the overall number of statistics 
that can be shown in the Workgroup 
Overview. Defaults to 180. 

MaximumWorkgroupsInWorkgroupGraphView maximum as 
integer 

Maximum number of workgroups that 
the Workgroup Graph can show. 
Defaults to 20. 

MaximumStatisticsInSystemGraphView maximum as Maximum number of statistics that 
can be shown in the system status 
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integer graph. Defaults to 40. 

MaximumStatisticsInAgentGraph maximum as 
integer 

Maximum number of statistics that 
can be shown in the Agent's graph. 
Defaults to 40. 

MaximumStatisticsInWorkgroupGraph maximum as 
integer 

Maximum number of statistics that 
can be shown in the workgroups 
graph. Defaults to 40. 

  

Licenses, Security and Access Control Rights 

Licenses, Security and Access Control Rights 

This section discusses licenses and rights that affect Interaction Supervisor users. When a user logs in to 
IC Business Manager, it enables all views for which that user has access.  Access is governed by server 
license allocation and by the assignment of security and access control rights in Interaction 
Administrator.  The total number of licenses available is enforced by CIC. If a needed view is unavailable 
after you log on, contact your CIC System Administrator for assistance. 

Administrative Rights manage who can grant access—what objects are shown and can be changed in 
Interaction Administrator. Your CIC Administrator has administrative rights. Most CIC users do not have 
administrative rights, so those are not discussed here. See Interaction Administrator Help for details. 

Please note that: 

• Licenses determine whether or not a view category appears when adding a Supervisor view. 

• Security Rights manage access to client application features (listen, record, etc.) 

• Access Control Rights (ACLs) restrict access to objects (queues, users, etc.) and determine 
whether the Supervisor user can view or modify those objects. 

Rights must sometimes be assigned in pairs to control whether or not an option is visible or 
disabled.  Interaction Command Rights restrict the visibility of buttons in client applications.  For 
example, if the Interaction Command Right for Pick-Up is not assigned, the user won't see a Pick Up 
button in the toolbar.  This works with corresponding “My Interaction Rights” that control whether or 
not users can execute the button action. 

You may be wondering why it is possible to display a button but not enable its action. The reasoning 
behind this is that different customers want their clients to behave in different ways.  Some customers 
want to hide the buttons and others do not.   Therefore rights are granular so that customers can 
configure the system in the manner that they want. 

Module Management Feature 

Supervisor provides a command that displays application modules installed, and whether each license is 
enabled or acquired. Pull down the Tools menu and select Module Management. For more details, see 
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Module Management dialog.  Additional information about licensing is available online at 
http://license.inin.com. 

Supervisor Related Licenses 
Licenses determine whether or not a view category appears when adding a Supervisor view.  If a view 
category is not visible, an administrator can assign licenses as follows: 

View Category License assigned on User Configuration - Licensing tab 

Agents and Workgroups Workgroup Supervisor Plug-in 

I3_ACCESS_WORKGROUP_SUPERVISOR_PLUGIN 

Interaction Feedback Status Views in the Interaction Feedback Status category are 
automatically enabled if the Feedback feature license is 
present on the server. This feature license is not allocated to 
users on the licensing tab of a user configuration. 

I3_FEATURE_BASE_FEEDBACK 

Interaction Optimizer Optimizer Supervisor Plug-in: Interaction Optimizer view 
category is not visible unless this license is assigned to a 
user. 

I3_ACCESS_OPTIMIZER_RTA 

Display Optimizer Real-Time Adherence Statistics: assign to 
agents to allow Supervisor to monitor their adherence. 

I3_OPTIMIZER_SHOWRTA 

System Status System Status Supervisor Plug-in 

I3_ACCESS_SYSTEM_STATUS_SUPERVISOR_PLUGIN 

Interaction Tracker Access to Interaction Tracker module. This license is not 
required by the Interaction Details Supervisor view. 

I3_ACCESS_TRACKER 

Optional Interaction Analyzer 
columns in Queue Controls 

Two feature licenses control whether or not Interaction 
Analyzer columns appear in queue controls. 

I3_FEATURE_ANALYZER 
I3_FEATURE_RECORDER_ADVANCED 

Interaction Conference 

This feature license is not used by 
Supervisor views. 

Interaction Conference requires a feature license on the 
main Interaction Center license. The required license key is 

I3_FEATURE_INTERACTION_CONFERENCE. 

If the feature license is not present, Interaction Conference 
is fully functional, but all PIN numbers will be rejected when 

http://license.inin.com/
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invitees attempt to call into a conference. When the license 
is not present, all callers are told "Your PIN is invalid. 
Goodbye." 

Interaction Supervisor uses the licensing model introduced in CIC. A license is assigned to a user, or it 
may be concurrent. A user can be configured in Interaction Administrator to have an assignable or 
concurrent license, but not both. 

• An assignable license is one allocated to a specific user or station. 

• A concurrent license supports a number of simultaneous users accessing an application or 
feature. It allows users to acquire available licenses dynamically, or as needed, via a network 
connection. A centralized service maintains a list of users and licenses available and in use, much 
like a library loans limited copies of resources to authorized patrons. 

To assign a feature license in Interaction Administrator, your CIC Administrator must: 

1. Select the Users container in Interaction Administrator. 

2. Double-click a user name in the right pane. The User Configuration dialog is displayed. 

3. Select the Licensing tab page. 
 

 

4. Select a license allocation method to use (assignable or concurrent). 

5. In the Additional Licenses list, check boxes for licenses that the user needs (see table above). For 
more information on configuring the Licensing page, press F1 to open the Interaction 
Administrator Help. 

IC Security Rights 
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Security rights manage the functionality offered by client applications, such as buttons for recording, 
listening, and coaching. 

1. In Interaction Administrator, security rights are assigned from the Security tab of a configuration 
record, after clicking the Security Rights button. 
 

 
2. The Security Rights dialog appears. Security rights can be viewed by two categories: Application 

and User. Categories are subdivided into groups of related settings. 
 
By default, <All> categories is selected to display security rights in both categories. You can 
optionally locate rights by typing in the Search box. 
 

 
3. After referring to the table below, check the box for each security right you wish to assign. 

Rights that apply to Interaction Supervisor users are marked with a star ( ). 

Application category 
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Group Name Description 

Interaction 
Conference 
Policy 

Create and Modify All 
Conferences 

Permits the user to create conferences and modify all conferences. 

I3_ATTR_RIGHT_INTERACTION_CONFERENCE_ALL 

Create and Modify 
Conferences 

Permit the user to create conferences, and modify conferences he or she 
has created. 

I3_ATTR_RIGHT_INTERACTION_CONFERENCE_OWNED 

Optimizer Allow Agent Preferences Governs whether agents can set their schedule  preferences in Interaction 
Desktop. See "Working with Schedule Preferences" in the help for that 
application.  

I3_ATTR_RIGHT_OPTIMIZER_AGENT_PREFERENCES 

Recorder Policy Create/Delete 
Questionnaire 
Directories and Modify 
Rankings 

Grant this right to users who administer Interaction Recorder 
Questionnaires. It allows the user to create or delete questionnaire 
directories and also to create, change, or delete rankings. 

I3_ATTR_IR_CAN_CREATE_QDIRECTORIES 

Interaction Recorder 
Policy Editor 

Allow the user to use the Interaction Recorder Policy Editor in the 
Interaction Recorder Client. 

I3_ATTR_IR_CAN_USE_IRSELECTOR 

Override Finished 
Scorecards 

This right allows the user to modify finished scorecards for questionnaires in 
questionnaire directories that the user has at least the View right for. 

Once the scoring user clicks "Finish" on the scoring dialog, a scorecard is 
considered to be finished.  Once a scorecard is finished, it cannot normally 
be changed, since that could affect reports that use the scorecard.  

This right provides the capability to change a Finished scorecard, potentially 
affecting reports.  

I3_ATTR_IR_CAN_OVERRIDE_FINISHED_QFORM 

Tracker Policy Add Individuals User rights to add individuals in the Tracker Client. 

I3_ATTR_INTX_ADD_INDIVIDUALS 

Add Organizations User rights to add organizations in the Tracker Client. 

I3_ATTR_INTX_ADD_ORGANIZATIONS 

Delete Individuals User rights to delete individuals in the Tracker Client. 

I3_ATTR_INTX_DELETE_INDIVIDUALS 

Delete Organizations User rights to delete Organizations in the Tracker Client. 
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I3_ATTR_INTX_DELETE_ORGANIZATIONS 

Execute long-running 
queries 

User rights to execute long-running queries in the Tracker Client. 

I3_ATTR_INTX_EXECUTE_LONG_RUNNING_QUERIES 

Have Private Contacts User rights to create private contacts in the Tracker Client. 

I3_ATTR_INTX_ADD_PRIVATE_INDIVIDUALS 

Modify Individuals User rights to modify individuals in the Tracker Client. 

I3_ATTR_INTX_MODIFY_INDIVIDUALS 

Modify Organizations User rights to modify organizations in the Tracker Client. 

I3_ATTR_INTX_MODIFY_ORGANIZATIONS 

Related Interactions 
Page 

User access to "Related Interactions" in the Interaction Tracker Client. 

I3_ATTR_INTX_ALLOW_RELATED_INTERACTIONS_PAGE 

Tracker Administrator User administrator rights in the Tracker Client. 

I3_ATTR_INTX_TRACKER_ADMIN 

View Other People's 
Private Interactions  

User rights to view other people's private interactions in the Tracker Client. 

I3_ATTR_INTX_VIEW_PRIVATE_INTERACTIONS 

User category 

Group Name Description 

Alerting Rights E-mail Alerts  When this right and the Alert Programming user right are assigned, the user 
can set up an e-mail action in response to the alert.  

Users who have the Alert Programming right but no Alerting rights can 
display a special font or set colored LED alerts. If an Alerting right is revoked 
after the user has defined an alert, all currently existing alerts will not be 
modified by the system. 

I3_ATTR_RIGHT_ALERT_EMAIL 

Handler Alerts  When this right and the Alert Programming user right are assigned, the user 
can invoke a handler in response to the alert.  

Users who have the Alert Programming right but no Alerting rights can 
display a special font or set colored LED alerts. If an Alerting right is revoked 
after the user has defined an alert, all currently existing alerts will not be 
modified by the system. 

I3_ATTR_RIGHT_ALERT_HANDLERS 
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Memo Alerts  When this right and the Alert Programming user right are assigned, the user 
can send a client memo in response to the alert.  

Users who have the Alert Programming right but no Alerting rights can 
display a special font or set colored LED alerts. If an Alerting right is revoked 
after the user has defined an alert, all currently existing alerts will not be 
modified by the system. 

I3_ATTR_RIGHT_ALERT_MEMO 

Client Rights Account Code 
Verification  

Allows user access to account codes and assign them to incoming and 
outgoing calls. 

I3_ATTR_ACCT_CODE_REQUIRED 

Conference Calls Allows user to create a conference call. 

I3_ATTR_RIGHT_CONFERNCE_CALLS 

Customize Client Allow users to customize the settings in their CIC clients. 

I3_ATTR_RIGHT_CUSTOMIZE_CLIENT 

Force User Logout  Allows a user to log off another user. From the Workgroup Details view or 
the Workgroup Directory view in IC Business Manager/Interaction 
Supervisor, a user with this security right can  log off another user from all 
CIC applications except for Interaction Administrator, Interaction Recorder 
Screen Capture Client, and Interaction Recorder Policy Editor. For example, 
if a user left for the day and forgot to log off, a supervisor with this security 
right can log off another user to release the licenses the user was 
consuming. 

Monitor Columns  Allows a user to view the "Lstns" column, and the "Recs" column. 

I3_ATTR_OPTION_SHOW_MONITOR_COLS 

Multiple Calls This right determines whether or not handlers will present a new call to a 
user who is already on a call. This behavior only occurs on calls into lines 
that are marked "Allow Deferred Answer". The right applies to any call to a 
user in the following situation: 

If a user is already on a call, the user does not have call coverage set to 
forward calls when busy, and the right "Allow Multiple Calls" is not set, the 
call will not alert the user and the call will roll to voicemail. 

This setting does not actually prevent multiple calls from being on the user's 
queue at the same time.  It merely controls if the call alerts the user or not 
in the above situation.  Also, it applies to call on the user queue only, not 
calls to a logged-in station or default workstation. 

I3_ATTR_RIGHT_ALLOW_MULTIPLE_CALLS 
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Orbit Queue Allows a user to place objects in Orbit Queue. This places the call on hold 
and removes it from the user's station. Depending on the hold behavior the 
CIC administrator configures, callers "in orbit" hear a combination of music 
and messages. To a caller, there is no difference between being on hold or 
in orbit. 

I3_ATTR_RIGHT_ORBIT_QUEUE 

Persistent Connections Gives a user the right to start a remote CIC client with the persistent option. 

I3_ATTR_RIGHT_PERSISTENT_CONNECTION 

Personal Rules Allows access to Personal Rules from the CIC clients. 

I3_ATTR_RIGHT_AGENT_RULES 

Receive Voicemail  Allows callers to record voicemail messages for this user. 

If you have this right, callers are sent to voicemail when you are in a DND 
status (Gone Home, Out of the Office, or some other "not available" status) 
or when you do not answer your phone.  

If you do not have this right, callers are returned to the Interaction 
Attendant main menu. 

I3_ATTR_RIGHT_ALLOW_CALLER_VOICE_MAIL_RECORDING 

Response Management 
 

Permits use of the Response Management feature in the client applications, 
allowing the user to respond to chats, e-mails, and callbacks using stored 
responses instead of having to type the same information repeatedly. 

  Note:  Both Interaction Connect and Interaction Desktop support 
Response Management. 

I3_ATTR_RIGHT_RESPONSE_MANAGEMENT 

Speed Dials Allows user to create a Speed Dial page in the CIC clients. 

I3_ATTR_RIGHT_SPEED_DIALS 

Status Notes  Allows user to set Status Notes (supplemental information on a user's 
status). 

If a Supervisor user does not have this right, the "Status Notes" text box is 
hidden in the Change User Status dialog. 

I3_ATTR_RIGHT_STATUS_NOTES 

User-defined Telephone 
Number on Remote 
Login 

Allow the remote user to enter a new number in the logon dialog box. 

I3_ATTR_RIGHT_ALLOW_TN_CHANGE_AT_LOGIN 

Workgroup Queue Allow access to the Workgroup Statistics view in Interaction Connect and 
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Statistics Interaction Desktop. 

I3_ATTR_RIGHT_VIEW_WORKGROUP_QUEUE_STATISTICS 

Workgroups/Profiles 
Tab 

Allows user access to Workgroup and Profile tab in the CIC clients, from 
which interactions can be transferred to workgroups or Interaction 
Attendant inbound profiles. 

I3_ATTR_RIGHT_WORKGROUP_PROFILES_TAB 

Handler Rights Debug Allow users to debug handlers published to the CIC Server. 

I3_ATTR_RIGHT_DEBUG_HANDLERS 

Manage Allow users to add or remove handlers published to the CIC Server. 

I3_ATTR_RIGHT_MANAGE_HANDLERS 

Publish Allow users to publish new or updated handlers on the CIC Server. 

I3_ATTR_RIGHT_PUBLISH_HANDLERS 

Interaction 
Command 
Rights 

(Restricts 
which 
commands are 
visible in the 
Client) 

Assistance  Determines if Assistance action is visible. 

I3_ATTR_SHOW_ACD_HELP_BUTTON 

Coach  Determines if Coach action is visible. 

I3_ATTR_SHOW_COACH_BUTTON 

Disconnect  Determines if Disconnect action is visible. 

I3_ATTR_SHOW_DISCONNECT_BUTTON 

Hold  Determines if Hold action is visible. 

I3_ATTR_SHOW_HOLD_BUTTON 

Join  Determines if Join action is visible. 

I3_ATTR_SHOW_JOIN_BUTTON 

Listen  Determines if Listen action is visible. 

I3_ATTR_SHOW_LISTEN_BUTTON 

Mute  Determines if Mute action is visible. 

I3_ATTR_SHOW_MUTE_BUTTON 

Park  Determines if Park action is visible. 

I3_ATTR_RIGHT_SHOW_PARK_BUTTON 

Pause  Determines if Pause action is visible. 
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I3_ATTR_SHOW_PAUSE_BUTTON 

Pickup  Determines if Pickup action is visible. 

I3_ATTR_SHOW_PICKUP_BUTTON 

Private  Determines if Private action is visible. 

I3_ATTR_SHOW_PRIVATE_BUTTON 

Record  Determines if Record action is visible. 

I3_ATTR_SHOW_RECORD_BUTTON 

Secure Recording 
Pause   

Determines if the Secure Record action is visible. With this security right, a 
user can use Secure Pause to avoid recording sensitive information, such as 
a Social Security number or credit card number, when connected to a call 
interaction. 

I3_ATTR_SHOW_SECURE_RECORDING_BUTTON 

Transfer  Determines if Transfer action is visible. 

I3_ATTR_SHOW_TRANSFER_BUTTON 

Voice Mail   Determines if Voicemail action is visible. 

I3_ATTR_SHOW_VOICE_MAIL_BUTTON 

My Interaction 
Rights 

Coach Interactions   Allows user to monitor interactions and coach someone by adding 
themselves to another agent's call on any user or station queue they have 
permission to monitor. 

I3_ATTR_RIGHT_COACH_INTERACTIONS 

Disconnect Interactions 
 

Allows user to disconnect the current call. 

I3_ATTR_RIGHT_DISCONNECT_INTERACTIONS 

Join Interactions  Allows users who are Supervisors to join in on an interaction between other 
agents. 

I3_ATTR_RIGHT_JOIN_INTERACTIONS 

Listen in on Interactions 
 

Allows users to listen to a caller leaving a message in their voicemail 
account, or to a conversation between two parties. 

I3_ATTR_RIGHT_LISTEN_IN 

Mute Interactions  Allows users to disable the mouthpiece on their telephones so that the 
other party or parties cannot hear what is being said. 

I3_ATTR_RIGHT_MUTE_INTERACTIONS 
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Park Interactions  Allows user to park an interaction on another queue. 

I3_ATTR_RIGHT_PARK_INTERACTIONS 

Pause Interactions  Allows users to control a recording session by stopping the session. 

I3_ATTR_RIGHT_PAUSE_INTERACTIONS 

Pickup Interactions  Allows user to pick up interactions on a user queue. The user can answer 
the current call, or take the current call off hold. 

I3_ATTR_RIGHT_PICKUP_INTERACTIONS 

Private Interactions  Access to have private interactions. 

I3_ATTR_RIGHT_PRIVATE 

Put Interactions on Hold 
 

Allows users to place the selected call on hold. 

I3_ATTR_RIGHT_HOLD_INTERACTIONS 

Record Interactions  Allows user to record the currently selected call. 

I3_ATTR_RIGHT_RECORD 

Request Assistance from 
Supervisors  

Allows Users who are members of a Distribution Queue to request 
assistance from a supervisor. 

I3_ATTR_RIGHT_ACD_HELP_INTERACTIONS 

Secure Recording Pause 
Interactions  

Allows user to perform a secure recording of the currently selected call. 

I3_ATTR_RIGHT_SECURE_RECORDING_PAUSE_INTERACTIONS 

Transfer Interactions  Allows users to open the Transfer window where they can select a transfer 
recipient and the type of transfer operation they want to perform. 

I3_ATTR_RIGHT_TRANSFER_INTERACTIONS 

Transfer Interactions to 
Voice Mail  

Allows users to transfer a call to their voicemail account. 

I3_ATTR_RIGHT_VOICEMAIL_INTERACTIONS 

Remote Access 
Rights 

E-mail access via TUI Allow the user to participate in e-mail interactions through the Telephone 
User Interface (TUI). 

I3_ATTR_ALLOW_EMAIL_MSGTYPE 

Fax access via TUI Allow the user to participate in fax interactions through the Telephone User 
Interface (TUI). 

I3_ATTR_ALLOW_FAX_MSGTYPE 

Mobile Office User Allow the user access to the Mobile Office feature. 
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I3_ATTR_USER_MOBILE_OFFICE 

Outlook TUI User 
(Requires Mobile Office 
User) 

User access to Microsoft Outlook through the Telephone User Interface 
(TUI). 

I3_ATTR_USER_OUTLOOK_TUI 

Voice Mail access via TUI Allow the user to participate in voicemail interactions through the 
Telephone User Interface (TUI). 

I3_ATTR_ALLOW_VM_MSGTYPE 

User Rights Alert programming  This right controls whether or not the user can add, edit and remove 
alerts.  When this right is assigned, context menus over statistic-based 
values in Supervisor provide the ability to add, edit and remove alerts. 
Without this right, the user can only view alerts.  

I3_ATTR_RIGHT_ALLOW_ALERT_PROGRAMMING 

Directory Administrator 
 

Rights to edit public directories that were created by another user. 

I3_ATTR_RIGHT_DIRECTORY_ADMIN 

Follow Me  Allow users to call-forward multiple numbers, long distance numbers, and 
international numbers. 

I3_ATTR_RIGHT_FOLLOW_ME 

Intercom Chat  Allow the user to have intercom chats between other users on the same CIC 
server. 

I3_ATTR_RIGHT_ALLOW_INTERCOM_CHAT 

IP Phone Provisioning 
Administrator 

Rights to provision IP phones in the Managed IP Phones container. 

I3_ATTR_RIGHT_IP_PHONE_PROVISIONING_ADMIN 

Remote Control Allow the user to remotely run applications and utilities that are Notifier 
clients, for example, CIC System Manager and Switchover Control Panel. 

I3_ATTR_RIGHT_REMOTE_CONTROL 

Require Forced 
Authorization Code 

Select this option so the station phone that the user is logged into will not 
allow toll numbers to be dialed without an authorization code. 

I3_ATTR_REQUIRE_FORCED_AUTHORIZATION_CODE 

TIFF faxes Right to use TIFF (Tag Image File Format) for faxes. 

I3_ATTR_OPTION_FAX_USE_TIFF 

Trace Configuration Allow the user to configure tracing using CIC System Manager or CIC Trace 
utility. 
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I3_ATTR_RIGHT_TRACE_CONFIG 

Video Reserved for future use. 

I3_ATTR_RIGHT_ALLOW_VIDEO 

View Interaction Details 
 

Grants right to use the Interaction Details view in the Interaction Tracker 
category. This view allows an Interaction Supervisor user to search for an 
interaction and examine its details. 

I3_ATTR_RIGHT_VIEW_INTERACTION_DETAILS 

4. Click Close to dismiss the Security Rights dialog. 

5. Click Apply to save changes to the configuration. 

6. Click OK to dismiss the configuration dialog. 

IC Access Control Rights 

CIC Access Control Rights 

Access Control Rights (ACLs) manage access to objects (queues, users, etc.) and determine whether the 
user can view or modify those objects. 

Rights that apply to Interaction Supervisor users are marked with a star ( ). 

1. In Interaction Administrator, ACL rights are assigned from the Security tab of a configuration 
record, after clicking the Access Control button. 
 

 
2. The Access Control dialog appears. ACL rights can be viewed across the following categories: 

Application People System 

Attendant Profiles Queues User 

Interaction Conference Server   
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Interaction Process Automation Station Logon   

3. Categories are subdivided into groups of related settings. By default, <All> categories is selected 
to display access control rights in all categories. You can optionally locate rights by typing in the 
Search box. 
 

 
4. After referring to the table below, check each access control right you wish to assign. Rights that 

can be assigned to Interaction Supervisor users are marked with a star ( ). 

Application 

Group Name Description 

Feedback 
Surveys 

View 
column   

View only access to Feedback Surveys. 

I3_ATTR_RIGHT_VIEW_CSSURVEY_LIST 

Modify 
column  

Modify access to Feedback Surveys. 

I3_ATTR_RIGHT_MODIFY_CSSURVEY_LIST 

Optimizer 
Scheduling Units 

View 
column  

View only access to Interaction Optimizer Scheduling Units. Required to allow selection 
of scheduling units when Real Time Adherence view is added. 

I3_ATTR_RIGHT_VIEW_SCHEDULING_UNIT_LIST 

Recorder 
Questionnaires 

View 
column  

This right grants view-only access to Interaction Recorder Questionnaires. In 
Interaction Recorder, questionnaires are gathered under “Questionnaire Directories”, 
and rights are associated with Questionnaire Directories.  A user can see any 
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questionnaire and score any published questionnaire in Questionnaire Directories that 
the user has the View right for. With this right the user can modify unpublished 
questionnaires and delete un-scored questionnaires in the Questionnaire Directories 
they have the Modify right for (see Modify right below). 

I3_ATTR_RIGHT_VIEW_IR_QUESTIONNAIRES_LIST 

Modify 
column 

Allows user to modify recorder questionnaires, as well as delete them.  If a 
questionnaire has been published, however, it cannot be modified, only deleted; and if 
there are scorecards against a published questionnaire, it can’t be deleted either. 

I3_ATTR_ADMIN_RIGHT_IR_QUESTIONNAIRES_LIST 

View/Modify 
Interaction 
Optimizer 

View 
column 

This right affects all Interaction Optimizer functionality in IC Business Manager, by 
toggling edit access on or off. It should be assigned to administrators who generate 
Optimizer schedules. 

In order for users to have access to Interaction Optimizer module functionality in IC 
Business Manager, the new "View/Modify Interaction Optimizer: [*All] access control 
category must be assigned in Interaction Administrator. 

This right is not required to use the Real Time Adherence view. 

I3_ATTR_RIGHT_OPTIMIZER_VIEW_MODIFY_ALL 

Attendant Profiles 

Group Name Description 

Applicable to All 
Attendant 
Profile Types 

View 
column  

View only access to Attendant Configurations. 

I3_ATTR_RIGHT_IAT_VIEW_CFG 

Modify 
column 

Modify access to Attendant Configurations. 

I3_ATTR_RIGHT_IAT_MODIFY_CFG 

E-mail Profiles Search 
column  

Determines which Interaction Attendant e-mail profiles the user can see in Transfer 
dialog's "Transfer To" search. 

I3_ATTR_RIGHT_VIEW_ATTENDANT_EMAIL_PROFILES_IN_SEARCH 

Inbound Profiles Search 
column  

Determines which Interaction Attendant inbound profiles the user can see in Transfer 
dialog's "Transfer To" search. 

I3_ATTR_RIGHT_VIEW_ATTENDANT_IN_PROFILES_IN_SEARCH 

Operator 
Profiles 

Search 
column  

  

Determines which Interaction Attendant operator profiles the user can see in Transfer 
dialog's "Transfer To" search. 

I3_ATTR_RIGHT_VIEW_ATTENDANT_OPERATOR_PROFILES_IN_SEARCH 
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Outbound 
Profiles 

Search 
column  

Determines which Interaction Attendant outbound profiles the user can see in Transfer 
dialog's "Transfer To" search. 

I3_ATTR_RIGHT_VIEW_ATTENDANT_OUT_PROFILES_IN_SEARCH 

Interaction Conference 

Group Name Description 

Conference 
Rooms 

Restrict 
column 

Conference rooms (defined telephone phone numbers/stations for use in Interaction 
Conference) can be restricted.  By default, everyone who has access to Interaction 
Conference can use every room defined in the system.  

This right allows an administrator to prevent certain users from using certain rooms for 
creating conferences. Restricted users can still call into the room if they have a pin but 
they can’t make conferences that use it. 

I3_ATTR_RIGHT_INTERACTION_CONFERENCE_RESTRICT_ROOMS 

Interaction Process Automation 

Group Name Description 

Processes View 
column  

Search for and view any IPA process. 

I3_ATTR_RIGHT_IPA_VIEW_PROCESS_LIST 

  Manage 
column  

Search for, manage, cancel, and retry IPA processes. 

I3_ATTR_RIGHT_IPA_MANAGE_PROCESS_LIST 

  Launch 
column  

Search for and launch user's own IPA processes. 

I3_ATTR_RIGHT_IPA_LAUNCHABLE_PROCESS_LIST 

People 

Group Name Description 

Account Codes View 
column  

View only access to individual Account Codes. 

I3_ATTR_RIGHT_ACCT_CODES_LIST 

Client Buttons Client 
buttons 

View column View only access to Client Button. 

I3_ATTR_RIGHT_CLIENT_BUTTONS_LIST 

Copy Logs View column This is a custom button that shows up 
in the Client Buttons list for which you 
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can grant view access to. 

Set Client 
Side Trace 
Level 

View column This is a custom button that shows up 
in the Client Buttons list for which you 
can grant view access to. 

Directory Status 
Columns 

View 
column  

Allow user to view selected Status Columns (Activated, Forward Number, Logged In, 
Notes, On Phone, Status, Status Summary, Time in Status, Until, etc.) 

I3_ATTR_RIGHT_VIEW_STATUS_COLUMNS 

Queue Columns View 
column   

Queue Columns are columns that appear in views that display information about lines 
or queues. Checking the name of a queue column grants the right for the selected 
column to appear in views. These are all of the default queue columns that are 
available on a new install.   

I3_ATTR_RIGHT_VIEW_QUEUE_CONTROL_COLUMNS 

Skills View 
column  

Grants the user, workgroup, or role the ability to search for skills. 

I3_ATTR_RIGHT_VIEW_SKILL_LIST 

Workgroups View 
column  

Check View box at intersection with workgroup name to allow selection of the 
workgroup when a view is added. 

I3_ATTR_USER_WORKGROUPS 

Statistics 
column  

Check Statistics box at intersection with workgroup name to allow statistic selection 
when a view is added. 

I3_ATTR_RIGHT_VIEW_INDIVIDUAL_STATS 

Queue 

Note: When a line, station, user, or workgroup queue is selected, the Advanced Access Details button is enabled, 
allowing you to set the user's queue monitoring and modification rights. 

Group Name Description 

Line Queues Modify 
column   

Assigns a grouping of advanced access details. 

By checking the intersection of the Modify column and a line queue, Pickup, Transfer, 
and Disconnect rights are assigned, as if you had individually assigned these rights 
using the Access Control Dialog, using the procedure in Set queue access rights using 
the Access Control Details dialog.  This checkbox grants all three at once. 

I3_ATTR_RIGHT_PICKUP_LINE_QUEUE 

I3_ATTR_RIGHT_TRANSFER_LINE_QUEUE 



IC Security Rights 

288 

I3_ATTR_RIGHT_DISCONNECT_LINE_QUEUE 

Monitor 
column  

Assigns a grouping of advanced access details. 

By checking the intersection of the Monitor column and a line queue, Coach, Join, 
Listen, and Record rights are assigned, as if you had individually assigned these rights 
using the Access Control Dialog, using the procedure in Set queue access rights using 
the Access Control Details dialog.  The Monitor checkbox grants all four at once. 

I3_ATTR_RIGHT_RECORD_LINE_QUEUE 

I3_ATTR_RIGHT_LISTEN_LINE_QUEUE 

I3_ATTR_RIGHT_JOIN_LINE_QUEUE 

I3_ATTR_RIGHT_COACH_LINE_QUEUE 

View 
column  

View access to line queue. 

I3_ATTR_RIGHT_VIEW_LINE_QUEUE_LIST 

Station Queues Modify 
column  

Assigns a grouping of advanced access details. 

By checking the intersection of the Modify column and a station queue, Pickup, 
Transfer, and Disconnect rights are assigned, as if you had individually assigned these 
rights using the Access Control Dialog, using the procedure in Set queue access rights 
using the Access Control Details dialog. This checkbox grants three all at once. 

I3_ATTR_RIGHT_PICKUP_STATION_QUEUE 

I3_ATTR_RIGHT_TRANSFER_STATION_QUEUE 

I3_ATTR_RIGHT_DISCONNECT_STATION_QUEUE 

Monitor 
column  

Assigns a grouping of advanced access details. 

By checking the intersection of the Monitor column and a station queue, Coach, Join, 
Listen, and Record rights are assigned, as if you had individually assigned these rights 
using the Access Control Dialog, using the procedure in Set queue access rights using 
the Access Control Details dialog.  The Monitor checkbox grants all four at once. 

I3_ATTR_RIGHT_RECORD_STATION_QUEUE 

I3_ATTR_RIGHT_LISTEN_STATION_QUEUE 

I3_ATTR_RIGHT_JOIN_STATION_QUEUE 

I3_ATTR_RIGHT_COACH_STATION_QUEUE 

View 
column  

Which station queues a Supervisor user can view. 

I3_ATTR_RIGHT_VIEW_STATION_QUEUE_LIST 

User Queues Modify Assigns a grouping of advanced access details. 
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column  By checking the intersection of the Modify column and a user queue, Pickup, Transfer, 
Disconnect, Mute, and Hold rights are assigned, as if you had individually assigned 
these rights using the Access Control Dialog, using the procedure in Set queue access 
rights using the Access Control Details dialog. This checkbox grants all five rights at 
once. 

I3_ATTR_RIGHT_PICKUP_USER_QUEUE 

I3_ATTR_RIGHT_TRANSFER_USER_QUEUE 

I3_ATTR_RIGHT_DISCONNECT_USER_QUEUE 

I3_ATTR_RIGHT_MUTE_USER_QUEUE 

I3_ATTR_RIGHT_HOLD_USER_QUEUE 

Monitor 
column  

Assigns a grouping of advanced access details. 

By checking the intersection of the Monitor column and a user queue, Coach, Join, 
Listen, and Record rights are assigned, as if you had individually assigned these rights 
using the Access Control Dialog, using the procedure in Set queue access rights using 
the Access Control Details dialog.  The Monitor checkbox grants all four at once. 

I3_ATTR_RIGHT_COACH_USER_QUEUE 

I3_ATTR_RIGHT_JOIN_USER_QUEUE 

I3_ATTR_RIGHT_LISTEN_USER_QUEUE 

I3_ATTR_RIGHT_RECORD_USER_QUEUE 

View 
column  

Which user queues a Supervisor user can view. 

I3_ATTR_RIGHT_VIEW_USER_QUEUE_LIST 

Statistics 
column  

View access to user queue statistics. 

I3_ATTR_RIGHT_VIEW_INDIVIDUAL_STATS 

Workgroup 
Queues 

Modify 
column  

Assigns a grouping of advanced access details. 

By checking the intersection of the Modify column and a workgroup queue, Pickup, 
Transfer, and Disconnect, Activate Self, and Active Others rights are assigned, as if you 
had individually assigned these rights using the Access Control Dialog, using the 
procedure in Set queue access rights using the Access Control Details dialog. This 
checkbox grants three five at once. 

I3_ATTR_RIGHT_PICKUP_WORKGROUP_QUEUE 

I3_ATTR_RIGHT_TRANSFER_WORKGROUP_QUEUE 

I3_ATTR_RIGHT_DISCONNECT_WORKGROUP_QUEUE 

I3_ATTR_RIGHT_ACTIVATE_SELF 
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I3_ATTR_RIGHT_ACTIVATE_OTHERS 

Monitor 
column  

Assigns a grouping of advanced access details. 

By checking the intersection of the Monitor column and a workgroup queue, Coach, 
Join, Listen, and Record rights are assigned, as if you had individually assigned these 
rights using the Access Control Dialog, using the procedure in Set queue access rights 
using the Access Control Details dialog.  The Monitor checkbox grants all four at once. 

I3_ATTR_RIGHT_RECORD_WORKGROUP_QUEUE 

I3_ATTR_RIGHT_LISTEN_WORKGROUP_QUEUE 

I3_ATTR_RIGHT_JOIN_WORKGROUP_QUEUE 

I3_ATTR_RIGHT_COACH_WORKGROUP_QUEUE 

View 
column  

View access to Workgroup queue. 

I3_ATTR_RIGHT_VIEW_WORKGROUP_QUEUE_LIST 

Search 
column  

Access to view a Workgroup Queue in a search. 

I3_ATTR_RIGHT_VIEW_IN_SEARCH_WORKGROUP_QUEUE 

Server 

Group Name Description 

Station Groups View 
column  

View only access to Station Groups. 

I3_ATTR_RIGHT_VIEW_STATION_GROUPS 

Search 
column  

Access to which stations a user can see in Transfer dialog's "Transfer To" search. 

I3_ATTR_RIGHT_VIEW_IN_SEARCH_STATION_QUEUE 

Station Logon 

Group Name Description 

Stations View 
column 

Access to which stations a user can logon to. 

I3_ATTR_RIGHT_LOGIN_STATION 

System 

Group Name Description 

Chat Files View View only access to Interaction Files. 
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column  I3_ATTR_OPTION_CHAT_FILES 

Chat Messages View 
column  

View only access to Interaction Messages. 

I3_ATTR_OPTION_CHAT_MESSAGES 

Chat URL's View 
column  

View only access to Interaction URLs. 

I3_ATTR_OPTION_CHAT_URLS 

General 
Directories 

View 
column 

View only access to General Directories (I3TextRwp, I3Tracker Private Reverse 
Whitepaper, I3Tracker Public Reverse Whitepaper, CIC Private Contacts, CIC Public 
Contacts, etc.) 

I3_ATTR_RIGHT_VIEW_GENERAL_DIRECTORIES 

Interaction 
Reporter 
Reports 

View 
column  

View only access to Interaction Reporter Reports (Fax Detail, Fax summary, Line Detail, 
Line Group Detail, etc.) To print using the Interaction Details dialog, the "Interaction 
Detail" box much be checked. 

I3_ATTR_RIGHT_VIEW_HISTORICAL_REPORTS 

Layouts View 
Column  

View only access to list of layouts. 

Misc Items Proxy 
Logins  

Checking the Proxy Logins right allows a user to log in on behalf of other CIC users. 

 I3_ATTR_RIGHT_MISC 

Phone Number - 
Classifications 

View 
column 

View only access to Phone Number-Classifications. 

I3_ATTR_RIGHT_CLASSIFICATION_LIST 

Plugins List of 
Plugins 

View only access to Plugins chosen for this ACL. 

I3_ATTR_RIGHT_PLUGINS_LIST 

Response 
Management 

View 
column 

View only access to Response Management. 

I3_ATTR_RIGHT_RESPONSE_MANAGEMENT_LIST 

Status Messages View 
column  

View only access to Status Messages. 

I3_ATTR_RIGHT_STATUS_MESSAGE_LIST 

e-FAQ's View 
column 

View only access to e-FAQ's. 

I3_ATTR_RIGHT_EFAQS_LIST 

User 
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Group Name Description 

Users View 
History 
column 

View access to user interaction history. 

I3_ATTR_RIGHT_VIEW_USER_INTERACTION_HISTORY 

Change 
Status 
column  

Access to change a user's status. 

I3_ATTR_RIGHT_CHANGE_USER_STATUS 

4. Click Close to dismiss the Access Control dialog. 

5. Click Apply to save changes to the configuration. 

6. Click OK to dismiss the configuration dialog. 

Related Topics 

Set queue access rights using the Access Control Details dialog 

Set queue access rights using the Access Control Details dialog 
This topic explains how to assign granular access control rights to queues. When a line, station, user, or 
workgroup queue is selected, the Advanced Access Details button is enabled. Click it to open the 
Advanced Access Details dialog to set the user's queue monitoring and queue modification rights. These 
rights differ depending upon the type of queue selected. 

 

Any Queue Access right listed in this topic can be assigned to an Interaction Supervisor user. 

To set monitoring and modification rights for a queue: 

1. In Interaction Administrator, ACL rights are assigned from the Security tab of a configuration 
record, after clicking the Access Control button. 

2. Select Queue Access Rights from the Category drop list. 

3. Select a queue by name, or select *[All] to affect all queues of the type (user, station, 
workgroup, or line). 

4. Click Advanced Access Details. The Access Control Details dialog appears. The options on this 
dialog differ depending upon the type of queue selected.  The table below summarizes options 
for each type of queue. 
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Queue 
Type Queue Modification Rights Queue Monitoring Rights 

User 
Queue 

Disconnect—permits user to disconnect calls on user 
queue. 

I3_ATTR_RIGHT_DISCONNECT_USER_QUEUE 

Hold—grants access to hold interactions on a user 
queue. 

I3_ATTR_RIGHT_HOLD_USER_QUEUE 

Mute—grants access to mute interactions on a user 
queue. 

I3_ATTR_RIGHT_MUTE_USER_QUEUE 

Pickup—grants access to pickup interactions on a 
user queue. 

I3_ATTR_RIGHT_PICKUP_USER_QUEUE 

Transfer—permits user to transfer to a user queue. 

I3_ATTR_RIGHT_TRANSFER_USER_QUEUE 

Coach—access to coach on a user queue. 

I3_ATTR_RIGHT_COACH_USER_QUEUE 

Join—access to join on a user queue. 

I3_ATTR_RIGHT_JOIN_USER_QUEUE 

Listen—access to listen on a user queue. 

I3_ATTR_RIGHT_LISTEN_USER_QUEUE 

Record—permits recording of interactions on a 
user queue. 

I3_ATTR_RIGHT_RECORD_USER_QUEUE 

Station 
Queue 

Disconnect—permits user to disconnect calls on 
station queue. 

I3_ATTR_RIGHT_DISCONNECT_STATION_QUEUE 

Hold—grants access to hold interactions on a station 
queue. 

I3_ATTR_HOLD_STATION_QUEUE 

Mute—grants access to mute interactions on a user 
queue. 

I3_ATTR_RIGHT_MUTE_USER_QUEUE 

Coach—access to coach on a Station queue. 

I3_ATTR_RIGHT_COACH_STATION_QUEUE 

Join—access to join on a Station queue. 

I3_ATTR_RIGHT_JOIN_STATION_QUEUE 

Listen—access to listen on a Station queue. 

I3_ATTR_RIGHT_LISTEN_STATION_QUEUE 

Record—access to record on a Station queue. 

I3_ATTR_RIGHT_RECORD_STATION_QUEUE 
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Pickup—access to pickup interactions on a Station 
queue. 

I3_ATTR_RIGHT_PICKUP_STATION_QUEUE 

Transfer—access to transfer to a Station queue. 

I3_ATTR_RIGHT_TRANSFER_STATION_QUEUE 

Workgroup 
Queue 

Activate Others—Access to activate a user on any 
Distribution Queue that they are a member of. 

I3_ATTR_RIGHT_ACTIVATE_USER 

Activate Self—Access to activate self on a workgroup 
queue. 

I3_ATTR_RIGHT_ACTIVATE_SELF 

Disconnect—Access to disconnect on a Workgroup 
queue. 

I3_ATTR_RIGHT_DISCONNECT_WORKGROUP_QUEUE 

Pickup—Access to pickup on a Workgroup queue. 

I3_ATTR_RIGHT_PICKUP_WORKGROUP_QUEUE 

Transfer—Access to transfer to a Workgroup queue. 

I3_ATTR_RIGHT_TRANSFER_WORKGROUP_QUEUE 

Coach—Access to coach on a Workgroup queue. 

I3_ATTR_RIGHT_COACH_WORKGROUP_QUEUE 

Join—Access to join on a Workgroup queue. 

I3_ATTR_RIGHT_JOIN_WORKGROUP_QUEUE 

Listen—Access to listen on a Workgroup queue. 

I3_ATTR_RIGHT_LISTEN_WORKGROUP_QUEUE 

Record—Access to record on a Workgroup 
queue. 

I3_ATTR_RIGHT_RECORD_WORKGROUP_QUEUE 

Line Queue Disconnect—access to disconnect on a line queue. 

I3_ATTR_RIGHT_DISCONNECT_LINE_QUEUE 

Pickup—access to pickup on a line queue. 

I3_ATTR_RIGHT_PICKUP_LINE_QUEUE 

Transfer—access to transfer to a line queue. 

I3_ATTR_RIGHT_TRANSFER_LINE_QUEUE 

Coach—access to coach on a line queue. 

I3_ATTR_RIGHT_COACH_LINE_QUEUE 

Join—access to join on a line queue. 

I3_ATTR_RIGHT_JOIN_LINE_QUEUE 

Listen—access to listen on a line queue. 

I3_ATTR_RIGHT_LISTEN_LINE_QUEUE 

Record—access to record on a line queue. 

I3_ATTR_RIGHT_RECORD_LINE_QUEUE 

5. Check boxes for rights you wish to assign. Then click Close. 

Related Topics 

CIC Access Control Rights 

Copyright and Trademark Information 

Interactive Intelligence, Interactive Intelligence Customer Interaction Center, Interaction Administrator, Interaction 
Attendant, Interaction Client, Interaction Designer, Interaction Tracker, Interaction Recorder, Interaction Mobile 
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Office, Interaction Center Platform, Interaction Monitor, Interaction Optimizer, and the “Spirograph” logo design 
are registered trademarks of Genesys Telecommunications Laboratories, Inc.Customer Interaction Center, EIC, 
Interaction Fax Viewer, Interaction Server, ION, Interaction Voicemail Player, Interactive Update, Interaction 
Supervisor, Interaction Migrator, and Interaction Screen Recorder are trademarks of Genesys Telecommunications 
Laboratories, Inc. The foregoing products are ©1997-2018 Genesys Telecommunications Laboratories, Inc. All 
rights reserved. 
 
Interaction Dialer and Interaction Scripter are registered trademarks of Genesys Telecommunications Laboratories, 
Inc. The foregoing products are ©2000-2018 Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Messaging Interaction Center and MIC are trademarks of Genesys Telecommunications Laboratories, Inc. The 
foregoing products are ©2001-2018 Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Interaction Director is a registered trademark of Genesys Telecommunications Laboratories, Inc. e-FAQ Knowledge 
Manager and Interaction Marquee are trademarks of Genesys Telecommunications Laboratories, Inc. The foregoing 
products are ©2002-2018 Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Interaction Conference is a trademark of Genesys Telecommunications Laboratories, Inc. The foregoing products 
are ©2004-2018 Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Interaction SIP Proxy and Interaction EasyScripter are trademarks of Genesys Telecommunications Laboratories, 
Inc. The foregoing products are ©2005-2018 Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Interaction Gateway is a registered trademark of Genesys Telecommunications Laboratories, Inc. Interaction Media 
Server is a trademark of Genesys Telecommunications Laboratories, Inc. The foregoing products are ©2006-2018 
Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Interaction Desktop is a trademark of Genesys Telecommunications Laboratories, Inc. The foregoing products are 
©2007-2018 Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Interaction Process Automation, Deliberately Innovative, Interaction Feedback, and Interaction SIP Station are 
registered trademarks of Genesys Telecommunications Laboratories, Inc. The foregoing products are ©2009-2018 
Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Interaction Analyzer is a registered trademark of Genesys Telecommunications Laboratories, Inc. Interaction Web 
Portal and IPA are trademarks of Genesys Telecommunications Laboratories, Inc. The foregoing products are 
©2010-2018 Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Spotability is a trademark of Genesys Telecommunications Laboratories, Inc. ©2011-2018. All rights reserved. 
 
Interaction Edge, CaaS Quick Spin, Interactive Intelligence Marketplace, Interaction SIP Bridge, and Interaction 
Mobilizer are registered trademarks of Genesys Telecommunications Laboratories, Inc. Interactive Intelligence 
Communications as a ServiceSM and Interactive Intelligence CaaSSM are trademarks or service marks of Genesys 
Telecommunications Laboratories, Inc. The foregoing products are ©2012-2018 Genesys Telecommunications 
Laboratories, Inc. All rights reserved. 
 
Interaction Speech Recognition and Interaction Quality Manager are registered trademarks of Genesys 
Telecommunications Laboratories, Inc. Bay Bridge Decisions and Interaction Script Builder are trademarks of 
Genesys Telecommunications Laboratories, Inc. The foregoing products are ©2013-2018 Genesys 
Telecommunications Laboratories, Inc. All rights reserved. 
 
Interaction Collector is a registered trademark of Genesys Telecommunications Laboratories, Inc. Interaction 
Decisions is a trademark of Genesys Telecommunications Laboratories, Inc. The foregoing products are ©2013-
2018 Genesys Telecommunications Laboratories, Inc. All rights reserved. 
 
Interactive Intelligence Bridge Server and Interaction Connect are trademarks of Genesys Telecommunications 
Laboratories, Inc. The foregoing products are ©2014-2018 Genesys Telecommunications Laboratories, Inc. All 
rights reserved. 
 
The veryPDF product is ©2000-2018 veryPDF, Inc. All rights reserved. 
 
This product includes software licensed under the Common Development and Distribution License (6/24/2009). We 
hereby agree to indemnify the Initial Developer and every Contributor of the software licensed under the Common 
Development and Distribution License (6/24/2009) for any liability incurred by the Initial Developer or such 
Contributor as a result of any such terms we offer. The source code for the included software may be found 
at http://wpflocalization.codeplex.com. 

http://wpflocalization.codeplex.com/
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A database is incorporated in this software which is derived from a database licensed from Hexasoft Development 
Sdn. Bhd. ("HDSB"). All software and technologies used by HDSB are the properties of HDSB or its software 
suppliers and are protected by Malaysian and international copyright laws. No warranty is provided that the 
Databases are free of defects, or fit for a particular purpose. HDSB shall not be liable for any damages suffered by 
the Licensee or any third party resulting from use of the Databases. 
 
Other brand and/or product names referenced in this document are the trademarks or registered trademarks of 
their respective companies. 

DISCLAIMER 
GENESYS TELECOMMUNICATIONS LABORATORIES (GENESYS) HAS NO RESPONSIBILITY 

UNDER WARRANTY, INDEMNIFICATION OR OTHERWISE, FOR MODIFICATION OR 
CUSTOMIZATION OF ANY GENESYS SOFTWARE BY GENESYS, CUSTOMER OR ANY THIRD 

PARTY EVEN IF SUCH CUSTOMIZATION AND/OR MODIFICATION IS DONE USING GENESYS 
TOOLS, TRAINING OR METHODS DOCUMENTED BY GENESYS. 

Genesys Telecommunications Laboratories, Inc. 
2001 Junipero Serra Boulevard 
Daly City, CA 94014 
Telephone/Fax (844) 274-5992 
www.genesys.com  

Change Log 
This topic summarizes revisions, documentation updates, and new features in Interaction Supervisor. 

CIC 2018 R4 

Updated Interaction Details view to include Social Conversation as a Media Type. Updated Interaction 
Details dialog to include Social conversation icon. Updated Interaction Statistics to include Longest social 
conversation and Active social conversation statistics. 

CIC 2018 R2 

Updated Execute a custom handler on alert dialog topic. 

CIC 2018 R1 

Rebranding content of Supervisor help. 

Added note to Force User Logouts topic to clarify the feature is available in 2017 R3 and later. 

CIC 2017 R4 

Updated Workgroup Statistics and Queue statistics topics. 

Removed references to Interaction Client .NET Edition and Interaction Client Web Edition. 

CIC 2017 R3 

Added Force User Logouts subtopic under Workgroup Details view. Added Force User logout security 
right. 

CIC 2017 R2 

http://www.genesys.com/
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Updated descriptions for Longest Talk Time and Longest Inbound ACD Interaction statistics. 

CIC 2017 R1 

Added Content Servers view, Interaction Recorder category, Content Servers Statistics, and added new 
statistics to PMQ statistics. 

Updated descriptions of cumulative and partial sum in Workgroup Details view and Workgroup Statistics 
view. 

Updated PMQ statistics topic. 

CIC 2016 R4 

Renamed Unlicensed recordings (today) statistic to Encumbered recordings (today) and renamed 
Unlicensed recording (last hour) statistic to Encumbered recordings (last hour). 

CIC 2016 R3 

Added the ability to create snippet recordings from Supervisor views. 

CIC 2016 R2 

Added the ability to Manage Workgroup Membership from IC Business Manager. 

You can now restrict the number of records that appear in the IC Business Manager Statistics view by 
configuring server parameters in Interaction Administrator. For more information, see the Interaction 
Administrator help. 

CIC 2015 R1 

Updated documentation to reflect changes required in the transition from version 4.0 SU# to CIC 2015 
R1, such as updates to product version numbers, system requirements, installation procedures, 
references to Interactive Intelligence Product Information site URLs, and copyright and trademark 
information. 

Interaction Center 4.0 SU5 

1. A change was made to modify the way intercom calls are logged in Tracker Server. Previously 
Tracker server duplicated the segment data it received on initiator Call ID on to respondent Call 
ID. This created challenges in collecting segment data specific to either the initiator or the 
respondent party's Call ID. 
 
Tracker server was modified to track segment data for both Call ID's independently of one 
another. This improved the segment data collection for intercom call scenarios such as simple 
two party calls, blind transfer and consult transfers. 

2. In addition, a new feature was added for blind transfer scenarios. Customers need a way to tell 
which party did the transfer, what was the Call ID, which party and Call ID was transferred and 
similar details. 
 
Tracker server now includes these transfer details in the pre-Transfer segment in Detail Viewer 
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under the Advanced->Details key. Information is be stored in the Interaction segment details 
table so that customers can query these details if needed. 

3. Similarly, external to external blind transfer now has this information in a pre-transfer segment 
and also has an extra 'external transfer segment' that displays details like 'the other Interaction 
ID'; the new Call ID created when inbound external call is transferred to another external party' 
and 'Remote Number transferred to'. This information is stored in Interaction Segment details 
table and can be queried from there as well. 

4. Interaction Supervisor now displays a tooltip if it is unable to receive a statistic update, such as 
when a server is too busy. The tooltip summarizes the error condition. The possible error 
conditions include: 
 
The statistic key is malformed. 
 
The statistic key could not be recognized. 
 
The statistic provider is currently too busy to process the request. 
 
An unknown error occurred. 

5. Revised the Manage Workgroup Activations and Manage User Activations topics. The 
commands for opening these dialogs were removed from the Tools menu and are now available 
from context menus. Manage User Activation is available from a context menu when right 
clicking on a user in a directory.  Manage Workgroup Activation is available via the right click 
menu on a user in a directory and is also under the Workgroup Directory and Workgroup Details 
menus. 

6. A new topic, Copying Tracker information to the Clipboard explains how to copy Tracker 
information from an Interaction Details view to the clipboard, for pasting into other 
applications. 

7. Labels on the Play a sound on Alert dialog were revised for clarity. "Plays a sound when the 
statistic value changes within the condition" was changed to "Play a sound while alert condition 
is within range. 

8. Corrected a problem that caused Interaction Detail Viewer to display a transfer icon adjacent to 
the Interaction Id doing the transfer instead of next to the Interaction Id being transferred. This 
issue affected call scenarios that involved an intercom party doing the transfer, such as an 
intercom call transferred to external party or an intercom call transferred to another intercom 
party (or IC user). 

9. Previously, for some languages, the IC Business Manager Chart options dialog, Title tab, font 
drop down box did not list fonts installed on the system. The font selection combo box now 
displays the entire list of fonts available in the system. 

10. Previously, when changing the Queue columns ACL on the server, the list of available columns in 
the queue view was not updated until the queue view was closed and reopened. ACL access to 
queue columns is now updated while the queue view is open. It is no longer necessary to close 
and reopen the view. 
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11. A new "Skills" column is available in views that contain a directory control, such as the 
Workgroup Directory view. The Skills column displays skills associated with each agent. Multiple 
skills are delimited by commas. Skills belonging to the user's workgroups appear first, followed 
by the skills of the user.  If sorting by skills, standard alphabetical order on the entire content of 
the skill field is used. 

 

A right click context menu item (Display Skill Set) 
displays the entire list of skills, their proficiency and 
the desire to use them. If a user has the same skill in 
two different workgroups with different proficiency 
and desire to use, they will both appear in the user 
skills dialog box. 

Filter capability is provided. If you type a filter string at 
the top of the column, only the agents with the filtered 
skill will appear.  The filter is case independent.  When 
the directory is paged, the filtering is done by the 
server, otherwise it is done locally. 

Skills display is dynamic in the contact directory list and 
static in the user list skills dialog box.  

12. Updated the topic titled Manage Alerts dialog. The Show all alerts in the system check box is 
now only available when the user is configured as a master administrator in Interaction 
Administrator. 

13. As a best practice, the recommended size of user photos is 128 x 128 pixels. Starting with CIC 4.0 
SU5, larger user photos will be scaled to 128 x 128. User location images will be scaled to fit 
within the bounds of the active monitor's working space. 

14. In the License Statistics view, the Concurrent License column was renamed to License. This 
reduced overhead by alleviating the need to rename the column heading dynamically when the 
License type field is used to display assigned or concurrent licenses. 

15. A menu option named "Second sort column" was added to the statistic drill down menu in 
Session Manager views, to allow the user to select a secondary sort column and a secondary 
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sort direction. 

 
16. The Workgroup Selection dialog was eliminated from Interaction Supervisor. This wizard for 

selecting a workgroup is no longer needed since views now default to the first workgroup listed. 
Users can optionally change the workgroup by selecting or filtering a workgroup. 

17. Interaction Supervisor grays out statistics that do not apply to a real time skills filter. Statistics 
that are unaffected by the skill filter are still shown but the label text is grayed out, the value 
border is inactive and all other controls are hidden. 

18. Noted in Workgroup Details and Workgroup Statistics topics that skills filtering may be hidden in 
order for Supervisor to remain backwardly compatible with older versions of IC.   

19. Filter text boxes now appear above workgroup columns in some views. A limited number of 
workgroup rows are displayed by default. To list specific workgroup entries, users should type in 
the filter box all or part of workgroup names they wish to match. 

20. Interaction Supervisor is now available in Interaction Desktop, in addition to IC Business 
Manager. 

Interaction Center 4.0 SU4 

1. Updated the topic titled Interaction Analyzer Columns in Queue Controls to note that Supervisor 
differentiates between unanalyzed interactions and analyzed interactions with zero score, for 
Analyzer keyword score aggregate statistics. "No score" indicates that the interaction is not 
being analyzed and a score of "0" indicates that the interaction is being analyzed but has not 
accumulated a score at this time. 

2. Updated Workgroup Directory Options dialog to describe the difference between how the 
Available to take ACD Interactions statistic is calculated compared to the calculation which 
colorizes agents' rows. The former takes utilization into account while the latter does not. 

3. Fixed a problem that incorrectly displayed a value of zero for calls that went to a workgroup 
queue and abandoned. The CallDetail.Call Duration Seconds statistic now works as intended. 
The duration for the interaction is computed using Interaction initiatedtime and Disconnected 
(terminated) time. The duration is the time difference between the interaction's initiation time 
and terminated time. 
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4. Supervisor now indicates which channels have keyword spotting. Previously users had no way to 
distinguish between a call that has no keyword spotting and a call that has keyword spotting 
which hasn't spotted any keywords. 
 
Since keyword spotting may not be enabled for all calls in a particular queue, Supervisor queues 
now display a column which indicates whether keyword spotting is enabled on the customer 
channel, agent channel, or both channels. 

5. Corrected a bug which caused Supervisor to display conference call parties incorrectly. 
Previously, when one party of a conference disconnected, the Station Queues Call Activity View 
removed the entire conference from the list of interactions. Since other parties are still in an 
active call, they are now displayed as intended. 

6. In the Workgroup Detail View, the user queue column has been changed to display nothing 
when an interaction has not been assigned to an agent. The "Name" column no longer displays 
"To:" or "From:" for interactions that are part of a conference. 

7. The Manage Alert dialog now loads alert sets faster. 

8. Fixed an issue which could cause the Workgroup Details view to appear blank when reopening 
IC Business Manager if the selected workgroup is not in the first unfiltered 20 workgroups 
returned by the server. 

9. Modified several views to correct a display problem that could occur when columns are resized. 
Previously, it was possible to make columns so narrow that statistic values disappeared. The 
views now enforce minimum column widths. 

10. Filtering of skills in a Workgroup Directory view now works differently. Filtering previously 
performed a substring search starting at the beginning of the target text. For example, "ac" 
would find "acceptance" but not "inner peace". Filtering now selects substrings anywhere within 
the target text. As a result, "ac" will now find "inner peace". 

11. Supervisor no longer displays Agent/Customer score columns to users who have insufficient 
access rights. Specifically, the Keyword Analyzer dialog, accessible from the 'Agent Score' and 
'Customer Score' columns in queue views, now shows Agent and/or Customer information 
based on the user rights. This is also discussed in the Interaction Analyzer Technical Reference. 
 See the topics titled "View Interaction Analyzer current workgroup queue" and "Enable display 
of Interaction Analyzer columns for a user".  

Interaction Center 4.0 SU 3 

1. Added statistics for interactions held in workgroup queues. The new statistics are: 
 
Longest Hold Time 
Interactions Held 
Interactions On Hold 
Average Hold Time 
Total Hold Time 

2. Added a workgroup statistic titled "Logged in + Activated" to show logged in agents, excluding 
deactivated users. 
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3. Added topics for Interaction Dialer views. Interaction Dialer is a client/server extension that 
adds automated dialing and campaign management features to CIC servers.  Interaction Dialer 
conducts campaigns by contacting a list of people according to a prescribed list of rules. 
Interaction Dialer places outbound telephone calls for campaigns, plays .wav files to answering 
machines, sends faxes to fax machines, and routes calls answered by a live person to an 
Interaction Attendant profile or directly to Dialer agents. For information about Dialer views, see 
Interaction Dialer category and Dialer Statistics. 

4. In previous releases, when an alert was configured to "play a sound when the statistic value 
changes within the condition", the sound played once instead of playing continuously while the 
value was in range. This now works correctly for all statistics. Time interval statistics that "tick" 
(duration, future duration, finite duration, and time duration) play the alert sound every second. 
Statistics that do not "tick" play the alert sound every time the statistic value changes. 

5. The "Queues" and "Agent or Workgroup Queue" views now display the user's display name 
instead of the user name. This makes it easier to identify the person because user names often 
do not correspond with a person's actual name. 

6. In a Workgroup Details view, the "Display Keyword Analyzer information" context menu option 
is disabled until Interaction Analyzer keywords have actually been recognized. In previous 
releases this option was always enabled. 

7. Double right-clicking a view or dialog can no longer invoke any action other than a shortcut 
menu. Previously, some dialogs and views captured the double click of any mouse button 
instead of the left button exclusively. 

8. The Real Time Adherence view will automatically close if access to an Interaction Optimizer 
scheduling unit is removed. See Required ACL Right in the topic titled Interaction Optimizer 
category. 

9. ACL changes that affect the list of available queue columns in the Queue Columns Selection 
dialog are now applied dynamically to the list. It is no longer necessary to close and reopen 
views that use queue controls to pick up ACL changes that affect column selection.  

10. Corrected a defect that made it accidentally possible to clear the contents of a Workgroup filter 
field, merely by moving the mouse away from the drop down list. Workgroup filtering is 
available in Workgroup Details, Workgroup Directory, and Workgroup Statistics views. It is no 
longer possible to accidentally clear the field. 

11. Interaction Supervisor no longer terminates with an unhandled exception if a user who does not 
have a "System Status" license attempts to edit an alert. An error message is displayed instead. 
The alert message reads: "The statistic definition for [statistic name] is blank. The appropriate 
license to view this content might be unavailable". The application framework hosting 
Supervisor no longer crashes when this situation occurs. 

12. The StatServer sub-system (StatServerU.exe) was split into two binaries: 
StatServerAgent[U|UD].exe handles agent related statistics. StatServerWorkgroup[U|UD].exe 
handles workgroup related statistics. The split enhances processing power and allows for 
statistics gathering in larger environments with higher call rates. This enhancement did not 
affect Supervisor in terms of usability or user interface. 

13. Documented the control used to display information about workgroup members in a new topic 
titled Workgroup Directory control. 
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14. Supervisors can now view the skills associated with each workgroup member in a new Skills 
column. The Skills column displays skills owned by each user and his or her workgroup skills. The 
Skills column makes it easy to identify persons who have a specific skill. Supervisors can use this 
feature to identify the most capable agent to handle a waiting interaction.  In the event that an 
interaction is waiting in queue because of a lack of available skills, the supervisor monitoring a 
workgroup queue can: 
 
Find any agent with Skill X, activate, or contact them to handle an interaction waiting in queue 
 
Find any agent with Skill X and identify what their proficiency and desire to use are.  This will 
help determine why interactions are not being routed to them and/or if they are a good fit for 
the waiting interaction. 
 
The term "skills" refers to all skills that an agent has assigned to him. These skills can be 
inherited or be assigned directly to him.  See Workgroup Directory control for details. 

15. It is now possible to display a workgroup member's skills, desire to use, and proficiency. See 
Skills List dialog. 

16. Added a Call Activity view to the System Status category of views. The purpose of the Call 
Activity view is to provide an aggregate view of all calls going through IC. This view displays 
activity in all line or station queues that the user has ACL rights to see. 

17. Added two views for Interaction Director, the CIC application that allows multi-site contact 
centers to become a single virtual operation. Interaction Director communicates with registered 
CIC server in real-time, to gather data that is relevant to queues, users, workgroups, skills, and 
so on. Director uses this data to make routing decisions. It balances loads by intelligently routing 
multimedia interactions between CIC servers. See Interaction Director category for more 
information. 

18. The "Master Administrator" role was previously required in order for a Supervisor user to 
manage user activations.  Starting with CIC 4.0 SU3, users who have the "Activate Others" and 
"Activate Self" permissions can manage user activations. In Interaction Administrator, these 
permissions are located at Access Control > Workgroup Queue > Advanced Access Details. 

19. The Formatting Options command, which opens the dialog used to format rows for a list of 
members in a workgroup directory, is now available from a pull-down menu. Previously, this 
command could only be invoked by right-clicking a row in the Workgroup Directory view. 

20. To better describe the Advanced expander on Tracker's Interaction Details dialog, information 
from the IC Data Dictionary was reproduced in this document for convenience. See 
InteractionSummary table. 

Interaction Center 4.0 SU 2 

1. Resolved an issue that could cause IC Business Manager to crash if a user had a Workgroup 
Details, System Queue or a Workgroup/Agent view opened in Supervisor, then closed IC 
Business Manager and removed all rights to the Supervisor account, IC Business Manager could 
crash while reloading and trying to restart the watch on those workgroups (IC-98919). 
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2. Users can now disconnect multiple calls at once. To use this feature, select calls in a workgroup 
queue. Right-click to display a context menu. Then select the Disconnect command.  In previous 
releases only the first selected call was disconnected (IC-85306). 

3. Fixed a bug that prevented generic object interactions from appearing in Interaction Detail 
Viewer (IC-93717). 

4. Fixed a bug that prevented the Queue and Alert segments from appearing in the Interaction 
Details dialog, when the details of a Generic object interaction were viewed (IC-83821). 

5. Views in IC Business Manager and IC Server Manager can be pulled into separate floating 
windows. Clicking a view in Interaction Center Business Manager or Interaction Center Server 
Manager and dragging it out of the main window will create a new floating window that 
contains that view. Other views can be docked within the floating windows in the same manner 
as in the main window. Views can be positioned anywhere on the screen and are not 
constrained to the application window. You can click and drag any tab off of the application so 
that it becomes its own separate window and remains on top of the main window. If you close 
or minimize IC Business Manager or IC Server Manager, the floating window will automatically 
close or minimize (IC-95619). 

6. Updated the topic titled "Supervisor Related Licenses" to note a license name change. The name 
of the license required to use Report Assistant changed from "Interaction Report Assistant 
Supervisor Plug-In" to "Interaction Supervisor Plug-In: Reporting Assistant" (IC-96065). 

7. In previous releases, some statistic lists could not be sorted by clicking on column headings. For 
example, users could not sort the Session Managers view or an Agent Overview by clicking on 
column headings. These views now have sorting capability. Sorting occurs when a column 
header is clicked. The sort order is not updated when statistic values change, to avoid jumping 
of rows (IC-68593). 

8. In the Workgroup Statistics view, a tooltip is now displayed on the header of every row in the 
histograms. In earlier releases, users had to request help in the histogram sub view to see the 
values of the different time intervals per interaction type (IC-92889). 

9. New menu options offer commands associated with the active view. For example, a "Workgroup 
Details" menu is available on the Supervisor Workgroup Directory view and the Supervisor 
Workgroup Details view. This menu contains a "Directory formatting options" option that opens 
the Workgroup Directory Options dialog (IC-84549, IC-77247, and IC-77249). 
 
Two options on the Workgroup Directory Options dialog were renamed: 
 
"Show agents who are available to take ACD calls in" was renamed to "Text color for agents who 
are in an ACD available status, logged-in, activated, and off the phone". 
"Show On Phone agents in" was renamed to "Text color for agents who are on the phone". 

10. Several Supervisor views can look up an employee's photo and office location.  The graphic 
displayed for Office Location can be anything your IC administrator draws to indicate a locale. In 
most cases an office floor plan is displayed.  See Look up an employee photo and office location 
for details (IC-91991). 
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11. Fixed an exception in IC Business Manager caused by leaving an Interaction Detail report view 

open and exiting IC Business Manager. Please note that any reports that are left open when IC 
Business Manager is closed will not be restored. Reports can take significant time to execute, so 
they are not automatically restored when a ICBM is started (IC-91464). 

12. Users can now drill down into longest interactions statistics in System Status views to view the 
interactions responsible for the longest interaction statistic (IC-85591). To support this feature a 
tab was added to the Interaction Properties dialog that shows all attributes to which the user 
has rights (IC-87900). The drill down feature not only works for the 'Longest' statistics, but for all 
statistics that have one or more interactions as drill down information. 
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13. The License Statistics view now offers a selection control that displays only concurrent or 

assigned licenses. By displaying one license type at a time, the number of statistic watches can 
be reduced by approximately fifty percent, which decreases overhead significantly. In previously 
releases it was possible to view concurrently licenses only (IC-78286).  

14. A new Listen to Queue feature provides the means to continuously listen to a line, station, user 
or workgroup queue. When you begin listening, Supervisor initiates a queue watch that 
automatically picks up the next longest call in the queue. See Using the Listen to Queue feature 
(IC-75213, IC-76709). 
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15. Additional queue columns were added to support Interaction Process Automation (IC-76709). 

The following columns are now available in Supervisor queue views: 
 
Process ID 
Work Item Created On 
Work Item Error 
Associated Process 

16.  Another queue column, Time in Workgroup Queue was added to display the amount of time an 
interaction has been in a workgroup queue (IC-77312). 

17. IC Business Manager now honors licensing restrictions immediately when changed. If a user's 
license is revoked, all associated views close automatically. In previous releases an IC Business 
Manager restart was required to accommodate license changes (IC-84837). 

Interaction Center 4.0 SU1 

1. A "Details" column was added to queue views to display context-specific information based on 
the interaction type.  For example, a call interaction might display "To: Interactive Intelligence". 
This column displays context-specific information based on the interaction type. For calls, it 
shows the Remote Address (phone number). For callbacks, it shows the subject of the callback. 
For e-mails it shows the e-mail subject. For chats, it shows the name of the user who last typed, 
and the text they entered.  (IC-69807, IC-70036, IC-83793). 

2. Added two email columns to Supervisor queue views: "Importance" and "Attachments". The 
importance column shows an icon indicating whether an email is high or low importance, and is 
blank for "normal" importance. The Attachments column shows an icon indicating that an 
attachment exists on an email interaction, or blank if no attachments exist (IC-83800). 
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3. Added a Chat Response Time column to queue views. This column shows a counter that shows 
how much time has elapsed since the last time the chat had text entered into it by anybody 
involved in the chat.  See Queue Columns (IC-83796). 

Interaction Center 4.0 GA 

The Win32 edition of Interaction Supervisor has reached the end of its product lifecycle, and is no longer 
supported in IC 4.0.  It is replaced by a new Interaction Supervisor that was completely rewritten to run 
inside IC Business Manager.  In a nutshell, the major changes are: 

Interaction Supervisor takes advantage of multiple workspaces in IC Business Manager, to mix 
Supervisor views in one application with Interaction Recorder, Interaction Feedback, Interaction 
Optimizer, and other modules. 

Interaction Supervisor's user interface was modernized, and important new features were added. 

A new License Statistics view indicates how many concurrent licenses are in use, so that administrators 
can be alerted when license availability drops below user-defined thresholds.  Other views have been 
enhanced to filter by interaction type, or to drill down selected statistics. 

Assistance Response features allow Supervisor users to chat with an agent while listening to a call. 

Interaction Analyzer columns in queue controls display keywords spotted in real-time along with call 
scores for the agent and customer, so that the Supervisor user better knows when to listen, coach, or 
record questionable calls. 

APIs were added for statistics, alerts, and other supervisory features, making it easier for IC subsystems 
to provide real-time statistics and alert notifications. Alerts can be shared among multiple users. 

Support for Session Manager was added, so that supervisor users can view session counts for IC 
applications. 

Supervisor uses less bandwidth than before. It is more scalable, since it makes effective use of IceLib and 
Session Manager. For example, there is no increased load when multiple users subscribe to the same 
alert. 

Interaction Supervisor was completely rewritten in .NET. 

The IC Business Manager framework offers many advantages to Supervisor users.  Users can, for 
example, create a custom workspace that displays Supervisor views alongside data from other IC 
Business Manager applications. Interaction Supervisor inherits all features of the framework, including 
its consistent user interface, advanced window docking, and common controls. 

The notion of mixing Supervisor views is so inherent and useful; Interaction Supervisor doesn't have its 
own application icon in IC Business Manager. User's don't "switch" to Supervisor. They simply add 
Supervisor views to the workspace they are in, mixing views any way they like. Views are added by 
choosing New > View from the File menu—see Manage Views for details. 

The availability of views is controlled by IC server license and assignment of user rights. When a user 
logs in to IC Business Manager, it loads all views for which that user has rights. Users see only those 
views that they are authorized to use. Within views, other restrictions can apply. A user can be 
permitted to view a subset of workgroups, for example. 
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The visual controls that display information in Interaction Supervisor were enhanced to put more 
information in each view, and to ease configuration of alerts. For example, a new statistic control 
displays metrics and alerts together. Alert icons appear next to statistic values, even in graph 
views.  Statistics are grouped in expandable panels (called expanders) that allow sections of a view to be 
hidden or displayed at will. Queue controls were rewritten to make selection of parameters easier. The 
result is an overall user interface that is more powerful, more elegant, and consistent in all respects. 

In this edition of Interaction Supervisor, interaction counts for Queue Statistics always include all 
interaction types, regardless of the filter selection. Counts apply to all connected interactions, except 
alerting interactions, disconnected interactions, and SIP Connection calls. 

Interaction Supervisor's online help was rewritten to document all views in a single help file. The 
organization of help topics mirrors the categorization of views in Interaction Supervisor. This makes the 
help more intuitive to use than before. 

You can look up the description of each statistic directly in Supervisor, and display it in a pop-up, by 
holding the mouse pointer over a statistic. It is no longer necessary to open help files to view this 
information.  Help text is built-in for every metric. Additionally, descriptions are summarized in the 
online help and printable PDF version of the help, for persons who want to read a categorized 
explanation of statistics without interacting with the application. 

A Help menu in IC Business Manager offers user assistance for every application module, including help 
for Interaction Supervisor. You can open help for any application that runs in IC Business Manager, such 
as Interaction Optimizer, Interaction Feedback, Interaction Recorder, Process Monitor, and Interaction 
Reporter, for example. New help selections will appear in this menu as future applications are added to 
IC Business Manager. 

Interaction Supervisor in IC 4.0 is a careful, deliberate redesign of the original Win32 application. 
Supervisor retains its former functionality, recast with new features that optimize performance, 
scalability, and ease of use. The enhancements are too extensive to list individually in this topic, but they 
are addressed throughout the online help. 

Persons familiar with the Win32 edition of Supervisor will be productive immediately with this version. 
Persons using Supervisor for the first time will master its many features with a minimal learning curve, 
particularly if they have used other IC Business Manager applications in the past. 

CIC 2015 R2 

Several improvements were made to the Interaction Details dialog. 

• New Previous/Next buttons which enable you to navigate to the previous and next interaction 
records found in the Interaction Details view search results. 

• The Recording indicator now includes a control that enables you to playback interaction 
records. 

• A Secure Input icon can appear which indicates how many time the agent transferred the 
interaction to the IVR for secured input from the caller. 

CIC 2015 R3 

Updated the Copyright and Trademark Information. 
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Updated documentation to reflect the addition of two CIC client applications, Interaction Desktop and 
Interaction Connect. 
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